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1 Welcome to The Journal

Keeping a daily journal has never been easier! The Journal always knows what day it is, and
automatically organizes your entries by day, month and year.

Get organized! With The Journal's many options for categories and entries you can be as organized
as you want to be. Keep your  personal journal separate from your work notes, or your dreams
separate from your correspondence--but only if you want to.

Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any journaling
technique or writing style you want, even none at all. It's completely up to you.

The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, news of updates and fixes, and more.

Getting Started - New Users

Getting Started with The Journal - A Step by Step Guide

Frequently Asked Questions (FAQ)

Getting Started - Upgrading from The Journal 4 or earlier

See what's new in The Journal 5!
More category and entry options!
Updated user interface with "skins"!
No more 2GB limit for Journal Volumes!
And much, much more!

Upgrading from The Journal 4 or The Journal 3
Upgrading Add-on Packages
Upgrading from The Journal 2.x
Make The Journal 5 look more like The Journal 4

http://www.davidrm.com/thejournal/newsletter/
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2 The Journal Information

Getting Started with The Journal - A Step by Step Guide

Frequently Asked Questions (FAQ)

Contact Information (email, Web page, etc.)

THE JOURNAL - PRODUCT LICENSE INFORMATION

Credits
Dedication
Special Thanks

Buy The Journal
The Journal Pricing
The Journal Order Form

Version History

See what's new in The Journal 5!

2.1 Contact Information

The Journal Home Page
http://www.davidrm.com/thejournal/

The Journal Customer Support, Bug Reports & Suggestions
support@davidrm.com

The Journal Newsletter
http://www.davidrm.com/thejournal/newsletter/

The Journal User Discussion
http://groups.yahoo.com/group/thejournal-users

DavidRM Software
http://www.davidrm.com

Mailing Address:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133
United States of America

http://www.davidrm.com/thejournal/
mailto:support@davidrm.com
http://www.davidrm.com/thejournal/newsletter/
http://groups.yahoo.com/group/thejournal-users
http://www.davidrm.com
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2.2 THE JOURNAL - PRODUCT LICENSE INFORMATION

NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT.

USE OF THE SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES
YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT INSTALL AND/OR USE THIS SOFTWARE.

1. LICENSE GRANT.

DavidRM Software grants you a license to use one copy of the version of this SOFTWARE on any one
hardware product for as many licenses as you purchase. "You" means the company, entity or individual
whose funds are used to pay the license fee. "Use" means storing, loading, installing, executing or
displaying the SOFTWARE, whether on the hardware product directly or via a network.

Individuals (not companies nor other entities) who purchase the SOFTWARE may use the SOFTWARE
on one additional hardware product, for a total of two hardware configurations.

When you first obtain a copy of the SOFTWARE, you are granted an evaluation period of not more than 
45 days or 45 uses, whichever is greater, after which time you must pay for the SOFTWARE according
to the terms and prices discussed in the SOFTWARE's documentation, or you must remove the
SOFTWARE from your computer.

You may not modify the SOFTWARE or disable any licensing or control features of the SOFTWARE
except as an intended part of the SOFTWARE's programming features.

This license is not transferable to any other company, entity, or individual.

2. OWNERSHIP.

The SOFTWARE is owned and copyrighted by DavidRM Software. Your license confers no title or
ownership in the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

3. COPYRIGHT.

The SOFTWARE is protected by United States copyright law and international treaty provisions. You
acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You further
acknowledge that title and full ownership rights to the SOFTWARE will remain the exclusive property of
DavidRM Software and you will not acquire any rights to the SOFTWARE except as expressly set forth
in this license. You agree that any copies of the SOFTWARE will contain the same proprietary notices
which appear on and in the SOFTWARE.

4. UNAUTHORIZED USE.

You may not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer,
or transfer the SOFTWARE except as provided in this agreement. Any such unauthorized use shall
result in immediate and automatic termination of this license.

5. U.S. GOVERNMENT INFORMATION.

Use, duplication, or disclosure by the U.S. Government of the computer software and documentation in
this package shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.277-7013 (Oct 1988) and FAR 52.227-19
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(Jun 1987). The Contractor is DavidRM Software, 7018 East 78th Place, Tulsa, OK, 74133.

6. LIMITED WARRANTY.

THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. DAVIDRM SOFTWARE DISCLAIMS ALL
WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. NEITHER DAVIDRM SOFTWARE NOR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE
LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE SUCH SOFTWARE, EVEN IF DAVIDRM SOFTWARE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. THE PERSON USING THE
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

SOME JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSION MAY NOT APPLY TO
YOU TO THE EXTENT THAT LIABILITY IS BY LAW INCAPABLE OF EXCLUSION OR RESTRICTION.

IN NO EVENT SHALL ANY THEORY OF LIABILITY EXCEED THE LICENSE FEE PAID TO DAVIDRM
SOFTWARE.

7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES.

IN NO EVENT SHALL DAVIDRM SOFTWARE OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY
CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT
OF THE DELIVERY, PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF DAVIDRM
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL
DAVIDRM SOFTWARE'S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY
OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

8. SEVERABILITY.

In the event of invalidity of any provision of this license, the parties agree that such invalidity shall not
affect the validity of the remaining portions of this license.

9. GOVERNING LAW.

This agreement shall be governed by the laws of the State of Oklahoma excluding the application of its
conflicts of law rules and shall inure to the benefit of DavidRM Software and any successors,
administrators, heirs and assigns. Any action or proceeding brought by either party against the other
arising out of or related to this agreement shall be brought only in a STATE or FEDERAL COURT of
competent jurisdiction located in Tulsa County, Oklahoma. The parties hereby consent to in personam
jurisdiction of said courts. This agreement will not be governed by the United Nations Convention on
Contracts for the International Sale of Goods, the application of which is expressly excluded.

10. ENTIRE AGREEMENT.

This is the entire agreement between you and DavidRM Software which supersedes any prior agreement
or understanding, whether written or oral, relating to the subject matter of this license.

11. RESERVED RIGHTS.

All rights not expressly granted here are reserved to DavidRM Software.



The Journal16

© 1996-2011 by David Michael

2.3 Credits

The Journal was designed and developed by David Michael.

The Journal was developed using Borland Delphi (http://www.borland.com/delphi).

The Journal's online help was created with Help & Manual from EC Software (http://www.helpandmanual.
com).

The Journal uses the following third-party algorithms, libraries and components:
TRichViewEdit component by Sergey Tkachenko (http://www.trichview.com).
TScaleRichView component by Ilya I. Zelensky.
ElevateDB database components by Elevate Software (http://www.elevatesoft.com).
Configurable menu and toolbars from Developer Express (http://www.devexpress.com).
BusinessSkinForm and SkinAdapter components from Almediadev (http://www.almdev.com).
Toolbar, menu and many, many Calendar Charm icons by IconShock (http://www.iconshock.com).
Spell checker and thesaurus from Addictive Software (http://www.addictivesoftware.com).
MD5 (password hashing) algorithm produced by RSA Data Security, Inc.
Twofish block cipher (entry text encryption) designed by Bruce Schneier (http://www.counterpane.com
).
Twofish encryption component programmed by Dave Barton.
MD5 hashing component programmed by Greg Carter.
LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm) programmed by South Pacific
Information Services Ltd.
Dream Scripter from Dream Company.
GraphicEx (image file handling) library by Mike Lischke (http://www.soft-gems.net).
RBCalendar from Borshack Software Solutions.
ShellBrowser from JAM Software (http://www.jam-software.com).
HyperString from EFD Systems.
ZipForge components by ComponentAce (http://www.componentace.com).
TMS Unicode components by TMS Software (http://www.tmssoftware.com).
Year/month/day planners by Shorter Path Software (http://www.shorterpath.com).

The Journal 4's original Calendar Charm icons (    ...) were created by Dan MacDonald.
Additional Calendar Charms were created by Jennifer Holstien and Mickael Pointier.

All trademarks are the property of their respective owners.

2.4 Dedication

For Susan, Davis & Serene.

2.5 Special Thanks

First, I must thank my wife, Susan, for being there, and for being here. I couldn't have finished The
Journal 5 (or any past version) without her.

The Journal 5 testers: Christina Becker, Vicki Bourg, Chuck Carruthers, Sue Cifelli, Beth Collins, Jim
Cook, Dawn Del Guercio, Emrah Diril, Robert Dunn-Miller, Mark Fassett, James Galiano, Aaron Gravvat,
Gary Ingraham, Wesley Jones, Joan Korte, Heather Kuhn, Jim McGowan, Dave McRobie, Steve
Martinez, John Mihnos, Andrew Mitcham, Leslie Moore, Rich O'Brien, Val Peever, Terry Rickman,
James Salyers, Rich See, Julie Smith, Russell Starner, Renger van Nieuwkoop, Ken Virapen, Bill
Watkins, Arthur White, Tenzin Yonten

mailto:davidrm@davidrm.com
http://www.borland.com/delphi
http://www.helpandmanual.com
http://www.helpandmanual.com
http://www.trichview.com
http://www.elevatesoft.com
http://www.devexpress.com
http://www.almdev.com
http://www.iconshock.com
http://www.addictivesoftware.com
http://www.counterpane.com
http://www.soft-gems.net
http://www.jam-software.com
http://www.componentace.com
http://www.tmssoftware.com
http://www.shorterpath.com
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Special Thanks from The Journal 4

My hat is off to Sergey Tkachenko, developer of the TRichView components. The Journal 4 owes a lot to
what Sergey has made possible.

The Journal 4 testers: Brett Allen, Rob Barrett, Patricia Campbell, Trudi Champion, Jim Cook, Kathy
Dunham, Laurie Engle, Laura Federico, Gary Filipski, Len Flier, M. Hamilton, Patricia Harris, David
Hollingworth, Peter Hollyer, Floyd Johnson, Lily Labrecque, Patrick S. Lewis, Michael Lowe, Raphael
Love, Jerry McKee, Kevin McKenzie, Gerard Montigny, John Murphy, Noelle Neuwirth, Craig Nicol,
Oskar Ortiz, Tom Plunket, Cindy Rasmussen, Kenneth S. Rhee, Lisa Smith, Brenden Stallard, Steve
Sutton, Andrew Wray, Mel Yow, Stephen Zeoli

Special Thanks from The Journal 3

I would also like to thank Alexis Balmont-Aoutine, Tony Costanzo, Gary L. Filipski, Brian Ford, Pete
Hollyer, Allen Johnson, Floyd Johnson, Sheila Perry, Tom Plunkett, and Julie W. Smith for their help
with testing the initial release of The Journal 3.

Special Thanks from The Journal 1.x and 2.x

Many thanks to Steve Kellock, Marty Brown, Andrew Williams, Sylvia Lutnes, Lance Perry, Ken
Marineau, Matej Trampus, Edmo Abreu Mendes Filho, Bernard Beam, Chris Victor, Gary L. Filipski,
John R. Hutchings, and Alexis Balmont-Aoutine.

2.6 Buy The Journal

Click Here to Buy The Journal! (only $49.95)

Benefits of Buying The Journal

Keeping a daily journal has never been easier! The Journal always knows what day it is, and
automatically organizes your entries by day, month and year.

Get organized! With The Journal's many options for categories and entries you can be as organized
as you want to be. Keep your  personal journal separate from your work notes, or your dreams
separate from your correspondence--but only if you want to.

Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any journaling
technique or writing style you want, even none at all. It's completely up to you.

The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, and more.

FREE bug-fixes and feature updates! All 5.x releases of The Journal, whether simple bug-fixes or
major updates, are FREE! *

FREE technical support via email! I've tried to make The Journal as easy to use as possible, but if
you have any problems, questions, or suggestions, don't hesitate to email DavidRM Software!

* Some releases of The Journal may include modules that must be purchased separately. However, if
these releases also include bug-fixes or other new features, these will be available free of charge.

http://www.davidrm.com/thejournal/buy/
http://www.davidrm.com/thejournal/newsletter/
mailto:support@davidrm.com
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For pricing information, including special upgrade rates, see The Journal Pricing.

How to Buy the Journal via the World Wide Web

Click Here to Buy The Journal!

Your payment will generally be processed and your Registration Keys emailed to you within 24 hours.

How to Buy the Journal via "Snail" Mail

Print The Journal Order Form, fill it out, and send it along with your payment to:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133

Please make checks and money orders payable to David Michael.

If you include your email address, you will receive the Registration Keys much quicker. Otherwise, your
Registration Keys must be mailed back to you.

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.

2.7 The Journal Pricing

The Journal (download only) $49.95
The Journal on CDROM $59.95
The Journal Complete $99.95

Amounts are in US Dollars.

Click Here to Buy The Journal!

Discounts Available

The following discounts are available:
Student (20% off)
Teacher/Educator (20% off)
US Military (active duty and veterans) (20% off)
Senior Citizen (20% off)
Hardship (20% off)

To purchase The Journal using one of these discounts, contact DavidRM Software.

NOTE: Only one discount per person (the discounts don't "stack").

Upgrade Pricing

People who have purchased any previous version of The Journal are eligible for special upgrade pricing.

http://www.davidrm.com/thejournal/buy/
http://www.davidrm.com/thejournal/buy/
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The Journal 5 Upgrade $24.95

To receive your The Journal 5 Upgrade Coupon Code, you must submit your full name, mailing address,
and date of purchase to DavidRM Software (davidrm@davidrm.com).

Your Upgrade Coupon Code will be emailed back to you within 24 hours. Enter this code when you
purchase The Journal 5 and you will receive $25 off the regular price (a 50% discount).

Quantity Pricing

Quantity Price Per
1-9 $49.95

10-49 $47.95
50-99 $44.95
100+ $41.95

To purchase The Journal using Quantity Pricing, contact DavidRM Software.

2.8 The Journal Order Form

Print this page as an order form.

The Journal Order Form

Full Name
_______________________________
Email Address
_______________________________
Mailing Address
_______________________________
_______________________________
_______________________________
_______________________________

_____ The Journal (download only) $49.95 US

_____ The Journal on CDROM (FREE Shipping) $59.95 US

_____ The Journal Complete (on CDROM; FREE Shipping)
Includes all available add-ons for The Journal 5.

$99.95 US

_____ The Journal Upgrade from any previous version
Upgrade Coupon Code: ____________________________

$24.95 US

NOTE: To receive your Upgrade Coupon Code for The Journal 5, email your full name, mailing address,
and date of purchase to: davidrm@davidrm.com

mailto:davidrm@davidrm.com
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Send payment to:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133

Make check payable to: David Michael

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.

2.9 Version History

v5.1.0.453
Released 24 January 2011

Fixed
Reminders with Cyrillic characters aren't displaying properly in View All Reminders.
If a table is the first thing in an entry (no lines or text before the table), neither Find Text nor Search
Entries is searching the table contents.
When editing a task, the task priority is incorrectly displayed on the "Task" tab, but shows correctly
on the Advanced:Status tab.
Some images copied and pasted from Web pages, when right-clicked in The Journal, cannot edit the
image properties (like layout).
Cannot change the date of an hourly entry.
Sometimes get an error when changing the date of any calendar entry.
When creating a new Journal Volume in a different path than the default, The Journal locks up.
When viewing the month or year calendar, all of the dates on the small calendar are displayed bold,
whether those dates have an entry or not.

v5.1.0.451
Released 27 December 2010

Fixed
When pasting from a Web page, the default font for the category is being ignored (always pasting as
Times New Roman).
"Find Text" should default to the selected text in the active entry (unless there is no selection).
"Insert Calendar Charm", after selecting "Clear", the next time you bring it up, it's pointing to the TJ4
charms.
When inserting a calendar charm (or other image) in a long entry, the insert point "jumps".
"Search Results" should show the entry path for loose-leaf entries.
If The Journal is using networked Journal Volumes and is left running when the PC goes into standby/
hibernate, then when Windows is restarted, The Journal locks up.
If The Journal is using networked Journal Volumes and the network connection is lost and regained,
when closing The Journal, it locks up.
In weekly categories, the small calendar isn't showing the dates included in an entry as bold.
When using Ctrl to select multiple entries in the tree, then right-clicking and choosing "Expand Entry
Tree", nothing happens.
On "Backup Settings", you should be able to set both "Prompt for backup when closing" and "Prompt
for backup every ... day(s)".
"Prompt for backup when closing" only works when exiting from the main menu or the "x", not when
closed from the tray icon popup menu.
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Pressing backspace at the beginning of a line that is right justified should make the line centered, and
should make a centered line left justified.

New Features
Added "Edit Right-to-Left" to text style paragraph options.

v5.1.0.435
Released 4 October 2010

Fixed
"Save Entry As..." menu command should be on the Export sub-menu.
Entries imported with "Batch Entry Import" aren't displaying their first line of text in the entry tree.
If the default font color is not black, setting the font color to "Default" with the Format menu (or the font
color toolbar icon) is setting the wrong color.
Setting a loose-leaf category to WYSIWYG, the active entry displays "Read Only".
On "Backup The Journal", when updating settings with "Backup Settings", changes made aren't
showing up until closing and re-opening "Backup The Journal".
When a Journal Volume is set to "Read Only", a new entry is still created in calendar categories for
the current date.
When dragging-and-dropping loose-leaf entries to re-arrange them, the view of the entry tree is reset to
the top.
On Windows 7, The Journal is prompting for a backup on closing, even during a Windows shutdown.
Fixed minor display bug when creating new recurring events.
The option to disable Ctrl+Alt hot-keys should be on the "Global" tab of User Preferences.
"Disable Ctrl+Alt hot-keys" option should also affect Toggle Timer (Ctrl+Alt+I).
"Import Entries" doesn't properly import a Unicode text (.txt) file.
"Search Entries" form is too tall for smaller displays.
"Save Entry As..." should default the file name to a loose-leaf entry's full path if that Export option is
set.
Post to Blog should remove any blank bullets/numberings at the beginning and end of the entry.
When clicking on the small calendar, the list of previous/later months doesn't show which one is about
to be selected (no highlighting).
If text is selected, Word Count (Ctrl+W) should only count words in the selected text. (This removes
the need for the command Word Count Selection, Ctrl+Shift+W hot-key.)

New Features
Added "Search entire entry" option to Find Text (on the Search menu).
Added the option to import CSV and 750words entry export files to Batch Entry Import.

v5.1.0.427
Released 10 May 2010

Fixed
Reminder display issue.
If the saved position of a form is from a different monitor in a multi-monitor setup, opening the form
causes The Journal to hang.
Sometimes lagging on close/minimize.
Sometimes getting a "closed dataset" error after backup/restore.
Displaying text with multiple topics applied should blend the topic highlight colors to create a unique
highlight color.
"RPC Server Not Available" error sometimes happening when displaying Outlook events.
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After "Insert Date" or "Insert Time", the active text style is being changed.
When the entry tree has focus, pressing Ctrl+F9 is cutting the entry and all sub-entries to the
clipboard.
In "View All Reminders", old tasks aren't showing their status.
When using "Change Entry Date/Time" on a new (previously unsaved) entry, any content in the entry
is lost.
Deleting text with a topic applied to it is leaving a "ghost topic" in the entry.
Undo/redo needs to bundle typing, instead of requiring a keystroke for every character.
Importing entries with topics from a JNX not always adding the topics to the user's list.
"Show in System Tray" not always working in Windows 7.
Turning off skinning, it should remember the last active skin.
The "Add Journal Volume..." form looks askew in Large Fonts.

New Features
New Language: Chinese (use only on Asian-language versions of Windows)

v5.1.0.417
Released 3 March 2010

Fixed
Importing calendar entries from a JNX created by an earlier version of The Journal sometimes having
problems.
Changes to a category's entry header setting aren't being saved between sessions.
Insert Media has a problem with Asian characters in the file name.
Insert Bookmark accepts a blank bookmark name.
Still some issues with re-arranging entries in long trees in loose-leaf categories.
Setting/clearing "auto-login" should automatically clear/set "lock on minimize".
Background color "lavender" misspelled.
When editing the name of loose-leaf entries directly in the entry tree, Ctrl+X, Ctrl+V, Ctrl+C, etc,
editing hot-keys don't function as expected.
"Find Text..." command doesn't move keyboard focus to the entry editor.
Hourly category entries with charms assigned aren't always showing up on the small calendar.
New calendar entries created with "Create New Entry" (hot-key: F9) should load the category's default
entry template.
Some menu commands have no flyover hints.
When editing "Outline style", "Reset to Default" isn't working.

v5.1.0.409
Released 27 January 2010

Fixed
User default and standard styles (including bullet, numbering, etc) were messed up.

v5.1.0.407
Released 25 January 2010

Fixed
Caret/scroll position in editor isn't being saved consistently.
Using "Move Entry Up/Down", the entry tree jumps back to the beginning.
Calendar charms aren't displaying in the entry tree if TJ4 icons are active.



The Journal Information 23

© 1996-2011 by David Michael

Under Russian-language Windows, the days of the week on the small calendar are gibberish.
When deactivating an installed add-on, getting an error.
When importing a JNX file, creating a new category with "Create New", having an error when first
accessing the new category.
Newly created unformatted auto-replace strings getting messed up.
In Vista, using Alt+Tab to bring up TJ5 isn't always properly setting keyboard focus.
Sub-categories in add-on packages aren't being loaded as sub-categories.
When a reminder is set to popup 24 hours beforehand, it's not popping up.
"Keep all active calendar categories on the same date" isn't working for sub-categories.
When coming back to a calendar, it's always going back to the current entry date, even if it was on a
different date before.
Auto-capitalize and quotes having an issue.
Media attachment with Asian characters in the file name causes an error on playback.
Default to no Ctrl+Alt hot-keys if Windows locale is Polish.
Journal Volume read only checking on startup isn't always working.
Backup process needs to verify the contents of the backup archive.
Insert Table and Table Properties aren't getting the user's custom colors.
In Export Entries, expanding categories with a lot of entries is taking a long time.
When importing user preferences, auto-replace strings and styles are getting messed up.

New Features
Updated to latest BusinessSkinForm.
New skins: SLMedia.
New Reformat menu command: "Detect URL's"
New Insert menu command: "Insert Entry Date" (hot-key: Ctrl+Shift+A)
New hot-keys: Ctrl+Shift+B (Backup The Journal)

The Journal 5.1

The Journal 5.1 is a feature update and bug-fix of The Journal 5. Work on The Journal 5.1 began in late
October 2009. My goal for The Journal 5.1 was to add some of the features that had been planned for the
initial release of The Journal 5 but, due to time constraints, had been put off to the future.

The Journal 5.1 fixes some bugs (see the list below), updates a few third-party components, and adds
some significant new features:

Improvements to skinning and more new skins! Many of the skins have been updated, including
The Journal's default skin (BlueBrilliant). The new skins are: BlueBrilliant_Ext, Charm_Ext, Charm2,
Office2010 (multiple skins), and SnowLeopard.
New toolbar icons for a number of commands, plus the option to use The Journal 4's icons for
toolbars, menus and the entry tree.
Localization support - As new language translations of The Journal become available, they will be
added.
Improvements for using The Journal over a network with multiple simultaneous users.
View your Outlook calendar reminders in The Journal!
Support for "Quick Blogcast" blog tool and new blog posting options.
And, finally, you can wrap text around images in your entries!

v5.1 (v5.1.0.393)
Released 15 December 2009

New Features
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Added support for "Quick Blogcast" blog API.
Added "Language" sub-menu to "View" menu.
Added icons for commands: Backup The Journal, Restore The Journal, Exit The Journal, Paste as
Text, Paste Special, Clipboard Viewer, and all reports on the Tools menu.
New blog profile export options: "Force a leading blank line in post" and "Force a trailing blank line in
post"
New install option for storing The Journal's databases on a shared or network folder.
New reminder option in User Preferences: "Display reminders/events from MS Outlook in The Journal"
Added new global option in User Preferences: "Use TJ4 icons for the toolbars, menus and entry tree"
Updated to latest BusinessSkinForm.
New skins: Charm2, Office2010, Office2010_Blue, and SnowLeopard.
New command on the Edit menu (and editor right-click menu): "Edit Image/Object Properties &
Layout"
New command in Edit Topics: "New Sub-Topic"

Fixed
After editing category properties, empty calendar entries are displayed in the entry tree.
When viewing past/future entry dates, the old-style reminder list isn't putting in the header before any
past/future reminders.
De-activating the last sub-category of a master category is deactivating the master category, even if
the master category isn't set to "folder only".
"stream read error" on startup.
8-bit JPG images in an image entry aren't displaying when selecting the entry.
Day planner times are always showing 24-hour times instead of reflecting the Windows locale setting.
Open Journal Volume form should be sizeable.
Create New Entry and Create New Sub-Entry should share the same "last entry type created".
Put "Create New Entry" and "Create New Sub-Entry" menus back on the entry tree context menu.
When dropping a batch of files, don't prompt for entry names; just default entry name to the name of
the dropped file.
Prompt for how to handle drag-and-dropped image files, even if dropping in a document entry.
Edit Symbol Replace isn't properly displaying the symbols.
Error when dragging a decade entry folder from one calendar category to another.
Default highlighter colors aren't the best choices (need some paler defaults).
Menu color commands display ugly.
Loading the "Insert Template" sub-menu is very sluggish.
Typed entry links are sometimes being auto-capitalized.
Default entry links (example: entry:Daily Journal\\*) aren't being properly handled.
In some rare cases, upgrading from The Journal 4 Journal Volume still failing.
When leaving The Journal running multiple days, future entries viewed aren't having their default
template loaded when the entry date becomes current.
If multiple table cells are selected, the font attributes (bold, italic, etc) on the toolbar aren't displaying
properly.
Cannot select and scroll in WYSIWYG editor.
Using "Save Entry As..." on a loose-leaf entry in a calendar category has an error.
When editing inside a table, using clipboard copy/cut/paste is causing an error.
Upgrading TJ4 topics with identical sub-topics (ex: "Family: Issue" and "Work: Issue") isn't working
properly.
When updating renamed topics, inserted topic name headers should be updated as well.
Default white space around the small calendar is a bit wide, and minimum white space should be
narrower.
Showing reminders for the current week not always working.
Entry header for weekly categories improperly formatted.
There is no separation between entries when printing with the entry header turned off.
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When printing calendar entries, sometimes getting year and month headers that shouldn't be there.
Auto-capitalize should "submit" if the user backs up and changes it back, not keep doing it over and
over.
Auto-capitalize needs to handle quoted text better.
Flyover hints for reminders on planners are formatted oddly.
Can't set a reminder to popup 24 hours beforehand.
"Copy/Cut Entry to Clipboard" not saving the contents of the entry before performing the operation.
Category "Lock entries on edit" feature isn't always unlocking the entry when closing.
Can't use spacebar to check/un-check topics in "Apply Topic".
When exporting entries to HTML "as a Web page", exported entry links aren't working.

v5.0.0.367
Released 5 October 2009

Fixed
Setting an inserted image's description isn't marking the entry as modified.
In a category without automatic time-stamping, when creating a new entry and choosing a time, the
time isn't sticking.
On 64-bit Windows, resizing the main form isn't working properly.
When creating a new Special Day reminder, selecting "Holiday" isn't updating the default name and
charm.
The "Sort ..." commands on the Tools menu need to be active in calendar categories.
Typing in an entry still sometimes causing "Program not responding".
Clicking on an inserted media file not properly selecting it.
Resizing the main form has a lot of flicker.
Closing The Journal takes too long sometimes.
Exporting to HTML isn't including media files.
Reminder end effective dates are supposed to be inclusive.
Shouldn't save form size if the form is rolled up.
Unroll form on restore from minimized.
If timer is visible when minimizing the main form, the timer doesn't work properly after restoring from
minimized.
Exporting and importing calendar entries with loose-leaf sub-entries not working properly in all cases.
Clicking "Import New" on Import Entries form should process all categories and entries in the JNX file.
3 days is a better default for backup prompting.
Creating a new root-level loose-leaf entry in a calendar category sometimes inserts the new entry in
the wrong place in the entry tree.
Changes to the date & time styles in User Preferences aren't saving.
-v command line parameter isn't working.

New Features
Category Properties, Calendar tab, new option: "Display day of week for daily entries in tree".

v5.0.0.359
Released 21 September 2009

Fixed
Can't assign hot-keys to topics (the dropdown list is empty).
Default entry templates not loading for new entries if a calendar category has "include time" option
checked.
Entry name display over editor not displaying selected user interface font after logging out and back in
again.
"Delete entry" confirmation prompt should only mention sub-entries if the active entry has sub-entries.
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On "Journal Volume Properties" form, "Done" button is not active unless the "Apply" button is active.
When returning to a calendar category where the last date selected has no entry, the year calendar is
coming up instead of the entry editor.
Entries in some add-on packages not being properly upgraded.
Changing categories sometimes causing "Program not responding".
Typing in an entry after a period of idleness sometimes causing "Program not responding".
Display error in Style Modify when the style has no options checked.
Error exporting entries with entry links to JNX format.
When importing JNX's from previous versions of The Journal, entry links are not being properly
updated.
Applying a style to a block of text copied from the Web is wiping out the hyperlinks.
Applying a style to a block of text with bullets or numbering isn't affecting the bullets or numbering.
Timer start/pause/reset buttons not displaying if skinning is turned off.
On the "Create New Category" form, the list of categories under "Make a sub-category of" is out of
order.
When exporting (or doing a "Save Entries as...") to RTF format, the category's page setup information
isn't included.
When the first word of a sentence is in quotes, it's not being auto-capitalized.
There is a hot-key conflict between the thesaurus and edit right-to-left.

New Features
New hot-keys: Ctrl+Shift+K (Insert Link), Ctrl+Shift+H (Edit Right-to-Left)
Added "Force Bidirectional Editing" option to User Preferences, Global tab.

v5.0.0.355
Released 9 September 2009

Fixed
When you rename a calendar entry, the new name doesn't show up in the entry tree immediately.
Reminders aren't updating as often as they should be.
Untended reminder popups are sometimes preventing popup of reminders coming due.
Upgrading a Journal Volume from The Journal 4 or earlier should repair the database before starting
the upgrade process.
"Rename Journal Volume" is always reporting "Could not rename..."
The main menu needs to be forced to visible on startup.
Spell checker suggestions and flyover reminder hints are messed up for international characters.
Topics tagged to an entry aren't being automatically updated when topics are edited.
Reminders with a specific time not always properly reporting their status.
Various reminder fixes (especially for recurring, time-specific tasks).
Post to Blog is getting an "Access denied" error.
Categories set as "read only" not upgrading properly from The Journal 4.
Creating a new reminder should default to the date selected on the calendar.
When opening The Journal again on the same day, don't create a new, empty entry if an entry for the
date already exists, even with the "include time" setting.
"View All Reminders" should list today's and upcoming reminders first.
In Style Editor, when editing a standard style (e.g., "Bullet Style"), "Reset to Default" should reset the
style to its "factory" settings (not just the default font).
"Merge Categories" shouldn't allow merging into "read only" categories, and shouldn't list the reminder
category.
Found another set of data sanity checks to make (fixes the "out of memory" error).
Selecting some calendar charms resulting in a "white square" instead of the proper charm.
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v5.0.0.347
Released 31 August 2009

Fixed
After selecting an external object or image entry, selecting another entry causes an error.
"Go to Random Entry" is only going to the first date of this or the last century.
"Check for Update of The Journal" is trying to download the wrong version.
Reminders with a specific time not being properly set to "missed".
"Show Topic" command isn't showing on the toolbars after being put there when customizing the
toolbars.
Need better handling of corrupted entries and sanity checking of entry dates, especially during
upgrade from TJ4.
Image entries should skip redundant compression of compressed image formats (JPG, PNG and GIF).
Top-level category tabs are displaying on a single line when arranged at the top.
"Search Entries" isn't properly searching with a date range.
"Font color" and "Highlight color" toolbar icons not correctly displaying their current color.
"Check for Update of The Journal" needs a better Web page.

The Journal 5

v5.0 (v5.0.0.341)
Released 26 August 2009

July 2009: My plan for The Journal 5, which began development in September 2007, can be summed up
as "The Journal Even Better". I wanted to improve all the major parts of The Journal--the database, the
internal data structures, the user interface--and provide more support for international users. Plus I
wanted to offer additional category and entry options, more reports and other tools, and, finally, to offer a
selection of "skins" for the user interface.

I think I achieved most of that--even if it took a bit longer than I expected.

In short, The Journal 5 is an inside-out redesign of The Journal, preserving all the great journaling and
writing features that have accumulated over the years and adding some cool new features and
capabilities.

What's New in The Journal 5

The Journal 4.1

(March 2006 - August 2009)

March 2006: Though not a major upgrade like the one from v3 to v4, The Journal 4.1 is still a significant
step forward. Reminders & Tasks have now been added to The Journal, supplying whole new ways you
can use The Journal to organize your life and life's work. Set reminders for daily tasks, monthly
appointments, special days and anniversaries, and more! And with the new entry locking features for
shared categories, The Journal edges closer to becoming a true multi-user, maybe even a collaborative,
platform. I look forward to building on all of the 4.1 additions and changes as The Journal continues to
grow.

August 2007: The last major new feature added to The Journal 4.1 was the option to have multiple
entries on a given date. Such an obvious feature (in retrospect), and yet added so late. I'm always
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surprised by how The Journal continues to evolve.

v4.1.0.253 - Released 5 February 2008
v4.1.0.247 - Released 10 December 2007
v4.1.0.241 - Released 15 October 2007
v4.1.0.239 - Released 9 October 2007
v4.1.0.237 - Released 4 September 2007
v4.1.0.231 - Released 13 June 2007
v4.1.0.229 - Released 11 June 2007
v4.1.0.219 - Released 8 May 2007
v4.1.0.213 - Released 23 April 2007
v4.1.0.207 - Released 19 February 2007
v4.1.0.195 - Released 4 December 2006
v4.1.0.189 - Released 2 October 2006
v4.1.0.181 - Released 12 June 2006
v4.1.0.177 - Released 26 April 2006
v4.1.0.175 - Released 17 April 2006

The Journal 4

(November 2004 - March 2006)

August 2004: Though the story of The Journal 4 lacks the drama of The Journal 3's grueling development
period, it's an important upgrade nonetheless. Built on the foundation created in v3, v4 takes The Journal
to new levels of power and ease of use.

Work on The Journal 4 began in December 2003, with early efforts centered on switching from using the
Windows Rich Text Common Control to the very powerful TRichView components created by Sergey
Tkachenko. This was a huge change, both in source code and in philosophy, because The Journal was
originally built around the rich text edit, and probably would not have existed except for that feature of
Windows 95. After years spent tweaking and cajoling (and cursing) the rich text edit to get it to do things
that Microsoft probably never meant for it to do, I suffered a few withdrawals. However, this one change,
by itself, made possible a large portion of The Journal 4's new features, including background images for
entries, print preview, tables, and on and on. So I'm past the withdrawals now, and not looking back.

With the new entry editor in place, I shifted to adding numerous other features that users have asked for
over the years, such as n-depth category nesting, user-created Calendar Charms, and daily/weekly
reporting. Beyond user requests, there were other extensions that I wanted to make, such as the ability
to install and run The Journal on read-only CDROM's, that would make The Journal more stable overall
and useful in new arenas.

By late August 2004, I had implemented the last of the planned additions and on 1 September I handed
The Journal 4 over to a small group of testers. There's nothing like user testing to help smooth out a new
interface and add the necessary polish to new features--and point out the obvious features and
extensions you somehow forgot.

The Journal 4 added:

A more modern look-and-feel  
Improved editing capabilities, including:  

Background images for entries  
More powerful and more flexible text styles  
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Improved image handling (faster saving and loading, resizing, and more)  
Tables  
HTML importing and improved HTML exporting  
Paragraph borders and background colors  
Outline mode  
Improved bullets and numbering  
Improved auto-replace, supporting both formatted and unformatted text  
Assigning topics to blocks of text within an entry  

Improved printing, including print preview  
Improved searching, with:  

Google-like results presentation, with excerpts of found text and links to the found entries  
Search text highlighting in found entries  
Date range limiting for standard categories  
Searching by topic, or by image description  

Daily/weekly/etc "reporting" for standard categories, with printing  
Support for user-created Calendar Charms and entry background images  
Improved blog support, with posting of images (if the blog supports posting images)  
Web page "archiving" within entries  
Improved arranging of loose-leaf entries and categories  
Improved category "nesting", so you can have sub-categories of sub-categories of sub-categories of...
 
New category options likes "Read Only" and "Folder Only"  
The ability to install and run The Journal on self-contained, removable media, like a USB flash drive or
CDROM  
Improved database speed and security  

v4.0.0.163 - Released 6 December 2005
v4.0.0.161 - Released 24 October 2005
v4.0.0.157 - Released 26 September 2005
v4.0.0.153 - Released 29 August 2005
v4.0.0.147 - Released 20 July 2005
v4.0.0.145 - Released 13 July 2005
v4.0.0.141 - Released 11 April 2005
v4.0.0.137 - Released 2 February 2005
v4.0.0.135 - Released 24 January 2005
v4.0.0.133 - Released 29 December 2004
v4.0.0.127 - Released 8 December 2004
v4.0.0.123 - Released 2 December 2004
v4.0 - Released 29 November 2004

The Journal 3

(November 2001 -  November 2004)

(November 2001): The Journal 3 is a complete re-design and re-write of The Journal, incorporating years
of accumulated feedback and suggestions. Since The Journal was first released in 1996, users have
sent in their suggestions for features and extensions. As much as possible, these suggestions were
incorporated. But some suggestions were beyond what the original design of The Journal could tolerate.
There was only so far that The Journal's feature set could be stretched without starting over from scratch.

Begun in the summer of 1999, development on The Journal 3 proceeded slower than expected. Those
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initial delays were caused by several factors. I was (and still am) co-owner of another software company
(Samu Games, http://www.samugames.com) and other projects came up that stalled the development of
The Journal 3. Plus there was the ever-present need to support the current version of The Journal. By the
end of 1999, only The Journal 3's new database configuration was completed.

In 2000, two major projects with Samu Games prevented significant work on The Journal 3. The Journal
2.3 was released in early 2000, and The Journal 2.4 was begun in the fall of the year. Though the 2.3
release was a relatively straightforward update of The Journal 2.2. The 2.4 release incorporated some of
the features that had been designed for The Journal 3. New word processing features (like numbered
lists and multi-level undo), improved image handling, and especially the new export/import format were
all from work done for The Journal 3.

Most of the work on The Journal 3 that occurred during 2000 was on the new user interface. There was a
lot of experimentation with new layouts, new configurations, and new ways of representing the
categories and entries in the database. Some of it worked, and was kept. A lot of it, though, proved "iffy
at best" and was discarded (or turned into a "user preference", default off).

In March 2001, following the release of The Journal 2.4, I realized that I had spent too much time on
"research and development". If I expected to release The Journal 3 in this lifetime, I was going to have to
stop thinking up new features to add and experiment with. So the feature set of The Journal 3 was
"frozen", and I began working on getting The Journal 3 done.

Interestingly enough, while The Journal 3 already sported quite a few features that The Journal 2.x would
never be able to duplicate, The Journal 2.x had many more features that had not yet been implemented
in The Journal 3. So to get The Journal 3 "done" I had to get all of the existing 2.x features working in the
new version. Everything from simple options like "minimize to system tray" to more complex features
like entry templates had yet to be added to The Journal 3.

This turned out to be the single largest effort in the development of The Journal 3. The Journal had
accumulated quite a few features in its 5+ years, and re-doing them for The Journal 3 proved to take
more time than I estimated. In August 2001, 6 months later, the last of the 2.x feature set was finally
added to The Journal 3.

In September 2001, The Journal 3 was handed over to a small number of volunteers to see how it would
stand up. With their help, most of the bugs and issues were found and either fixed or resolved. The last
bit of testing and polishing occurred when The Journal 3 "pre-release version" was made available in mid-
November.

The Journal has already grown beyond my original vision for the project. I'm excited to see what new
directions the product will head in the future.

2004 Afternote: The Journal grew significantly after the initial release of v3. Here's a list of the major
improvements and features added to The Journal 3 from November 2001 to October 2004:

Improved printing  
Improved "Search Entries..."  
Improved entry navigation  
Improved entry templates  
Improved initial defaults for new users  
Improved entry export and import  
Improved user interface, including lots of new hot-keys  
Improved entry links and internet links  
Improved database maintenance  

http://www.samugames.com
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Improved documentation  
Calendar Charms  
Add-on package support  
MemoryGrabber add-on package  
Writing Prompts 1 add-on package  
Blog support  

v3.0.0.73   -Released 19 January 2005
v3.0.0.71   -Released 22 September 2004
v3.0.0.67   -Released 13 July 2004
v3.0.0.65   -Released 13 April 2004
v3.0.0.63   -Released 6 April 2004
v3.0.0.61   -Released 10 February 2004
v3.0.0.59   -Released 29 December 2003
v3.0.0.57   -Released 15 December 2003
v3.0.0.51   -Released 6 October 2003
v3.0.0.49   -Released 15 July 2003
v3.0.0.47   -Released 9 July 2003
v3.0.0.45   -Released 10 April 2003
v3.0.0.43   -Released 24 February 2003
v3.0.0.41   -Released 9 December 2002
v3.0.0.39   -Released 26 August 2002
v3.0.0.35   -Released 2 April 2002
v3.0.0.33   -Released 18 February 2002
v3.0.0.31   -Released 12 February 2002
v3.0.0.27   -Released 6 February 2002
v3.0.0.25   -Released 4 February 2002
v3.0.0.23   -Released 7 January 2002
v3.0.0.21   -Released 17 December 2001
v3.0.0.19   -Released 3 December 2001
v3.0      -Released 28 November 2001

The Journal 2

(September 1998 - October 2001)

The Journal 2.0, released in September 1998, built on the feature set that had been finalized in the 1.51
release. More word-processing and security features were added, and database maintenance and
stability were greatly enhanced. Throughout the 2.x series of releases, The Journal continued to mature,
though not at the same pace as before. Refinement and extension replaced a headlong rush to add new
features. The 2.4 release of The Journal, coming nearly a year after the previous release, was the most
significant of the 2.x updates after 2.0.

v2.43   - Released September 28, 2001.
v2.42   - Released August 20, 2001.
v2.41   - Released April 16, 2001.
v2.40   - Released February 9, 2001.
v2.30   - Released April 7, 2000.
v2.20   - Released December 6, 1999.
v2.11   - Released June 21, 1999.
v2.10   - Released April 5, 1999.
v2.02   - Released February 1, 1999.
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v2.01   - Released November 11, 1998.
v2.00   - Released September 30, 1998.

The Journal 1

(October 1996 - August 1998)

v1.30 was the first shareware release of The Journal, made available in October, 1996. This was a period
of expanding features for The Journal. Hardly a month went by without a new release coming out with
more features--and bug-fixes for previously added features. This "growth spurt" period went on for nearly
a year before finally slowing down.

With the release of The Journal 1.5 in January, 1998, The Journal became a mature software product.

v1.51   - Released February 20, 1998.
v1.50   - Released January 30, 1998.

v1.44   - Released December 12, 1997.
v1.43   - Released September 26, 1997
v1.42   - Released July 19, 1997
v1.41   - Released July 1, 1997
v1.40   - Released June 28, 1997

v1.39   - Released June 7, 1997
v1.38   - Released March 23, 1997
v1.37   - Released February 9, 1997
v1.36   - Released January 12, 1997
v1.35   - Released December 29, 1996
v1.34   - Released December 13, 1996
v1.33   - Released November 25, 1996
v1.32   - Released November 15, 1996
v1.31   - Released October 14, 1996
v1.30   - First Shareware Release October 11, 1996

The Journal 1 - The Freeware Days

(June-September 1996)

The Journal started out as a quick project, mostly as a way to learn how to use Delphi. Fittingly, most of
the original users of The Journal were other Delphi programmers who downloaded it from the various
"Made in Delphi" web pages. Feedback from these and other users prompted me to extend The Journal
significantly, and release it as shareware.

v1.21   - Released August 12, 1996
v1.20   - Released August 9, 1996
v1.1   - Released July 8, 1996
v1.0   - Initial Release. June 18, 1996



The Journal Information 33

© 1996-2011 by David Michael

2.10 What's New in The Journal 5

The Journal 5 adds lots of significant new features:

Updated user interface:
Choose your favorite "skin" from the many, many available (180+).
Quickly switch between logged in users and open Journal Volumes with their (optional) tabs.

Updated Journal Volumes:
No more 2 GB limit. Store up to 128 GB in your Journal Volumes.
Have as many Journal Volumes as you want, all open at the same time.
Be more secure with the improved backup and restore features, with options to copy your backup file
to separate locations automatically.

More category options:
You can have categories that create new entries for you every century, decade, year, month, week,
day, and hour.
See a month or a year at a time with the new month and year calendar views.
Use the day planner to see your reminders for today or the whole week.
Automatically "stamp" your entries with current date and time.
Edit your entries with WYSIWYG (what-you-see-is-what-you-get) formatting.

More entry options:
Your calendar category entries can have loose-leaf sub-entry "attachments".
Drag and drop entries between categories with ease.
Select multiple entries and copy (or cut) them to the Windows clipboard--then paste those entries into
another category of The Journal or even into a word processor like MS Word.
Insert media files (audio & video) into your entries, and play them back within The Journal.
Take advantage of the new (optional) grammar checking features to automatically change i to I and
automatically capitalize the first word of a sentence.
Use topics to mark blocks of text within an entry, or to tag an entire entry.
Be even more organized with topics that have sub-topics (that have sub-topics, that have sub-
topics...).
Easily wrap text around inserted images.

More search options:
Automatically include sub-topics when searching by topics.
Search for multiple topics with either AND (all) or OR (any) logic.
Search in reminder notes.
Limit your search to whole words.

And more:
See your MS Outlook calendar reminders in The Journal.
Export your categories and entries to HTML and get a Web-page-like list of categories and entries.
Create a wiki-like set of entries with automatically updated links.
Run a report of those entries that you've created or updated in the last week, month, year or other date
range.
Post to Blogger (Google) without getting an annoying error message (and lots of other minor fixes and
changes).
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3 How to Use The Journal

Step 1. Getting Started

The first things you have to do after installing The Journal are create your first Journal Volume and your
login name and (optional) password.

Don't worry: Most users can just click right through these and use the default settings.

Step 2. Making Entries

Once you have your login name and password, you can run The Journal and start making entries and
printing entries. And since you almost certainly want more than text in your entries, this section shows
you how to  insert images and media filesinto your entries.

Step 3. Using Categories

The Journal automatically creates a "Daily Journal" category and a "Notebook" category for you. But you
aren't limited to just those. This section describes the difference between a calendar category and a
loose-leaf category, and shows you how to create a new category.

Step 4. Creating Additional Logins

Want your spouse to have his or her own login (with password) in The Journal? This tells you how to
create a new user login.

Step 5. Creating Additional Journal Volumes

One Journal Volume is enough for most users, but if you need more than one, this section tells you how
to create a new Journal Volume.

Step 6. Maintaining The Journal

Finally, this section gives you the basics of backing up your entries.

Also check out the Frequently Asked Questions.

3.1 Getting Started

The first time you start The Journal, the New User Wizard is run automatically to help you.
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The most important parts of this process are:
Creating your first Journal Volume, and
Creating your login name.

Don't worry: Most users can just click right through these and use the default settings.

Once you've created your Journal Volume and login name, you're ready to start making entries in The
Journal.

3.1.1 Creating Your First Journal Volume

A Journal Volume is an "entry database". The Journal Volume created during this step will hold your
login name, your categories, and all of your entries.

If you are unsure about the Journal Volume, simply accept the default settings by clicking on Next.

NOTE: The  default settings are recommended for most users.
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Journal Volume Name

The default Journal Volume name is "My Journal". You can set this to be any name you want.

The Journal Volumes Folder

The Journal Volumes folder is the path where your first Journal Volume will be created as a sub-folder. If
you later create additional Journal Volumes, they will also use this same base path.

The default path for the Journal Volumes folder is:
My Documents\The Journal Volumes\5\

If you are installing The Journal on a USB/external hard drive, the default path is relative to the installed
path:
.\The Journal Volumes\5\

See Journal Volumes for more information about Journal Volumes.

3.1.2 Creating Your Login Name

Your login name and password are how you access The Journal.

User Name

Your login name defaults to your Windows user name. You can change this to be any name you want
(and you can have as many login names as you want, each with their own categories and entries; more
about that here).

Password

Type in the password you want to use for this login name.

If you do not want a password, simply check the "I don't need a password" option. This gives you a
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blank password and sets the Auto-Login option so you aren't prompted for a password when you login.

If you change your mind later, you can always give yourself a password by clicking on the User menu,
un-check the Auto-Login option and then choose Change User Password...

When you're ready, click on Next to continue. If you have chosen a password, you'll be asked to confirm
your password (type it in again exactly the same) before continuing.

3.1.3 Confirm Your Journal Volume and Login Name

The last step is confirm your Journal Volume and login name.

If everything looks good, click on Finish.

This will create your Journal Volume and login name and log you in.

3.1.4 Installing Add-on Packages

If you purchased The Journal with add-on packages (like the MemoryGrabber, Devotional Prompts 1, or
Steve Pavlinas Templates) or chose to install any optional add-on packages (like My Address Book),
you will now be prompted to install those now.
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Un-check any add-ons you don't want to install (you can always install them later by clicking on the 
Category menu and choosing Packages...) and click on Install. Or click on Skip to install no add-ons
at this time.

Now you're ready to start making entries in The Journal.

3.2 Making Entries in The Journal

Creating entries in The Journal is incredibly easy.

Making Entries in "Daily Journal"

The "Daily Journal" category that is created for you automatically is a calendar category. You'll notice
that The Journal has created a single entry for the current date. You can type in this entry just as you
would a word processor or text editor.

To create a new, blank entry for today, press F9 (or click on the Entry menu, find the Create New Entry
sub-menu and choose Create Entry: Document).

To create a past entry, simply click on a past date on the calendar. A new, empty entry will be brought
up for you. The entry is not added to the "tree" of dates below the calendar yet, because the entry is
empty. Once you begin adding text to the entry, then it will show up in the date tree.

As the days and weeks go by, your collection of entries will grow. In the tree of dates, your entries will
be organized by year and month.
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Making Entries in "Notebook"

To the right of the entry editor, there is a collection of tabs. The active tab should say "Daily Journal".
The one next to it should say "Notebook". Click on that tab now to make it active.

The "Notebook" category is a loose-leaf category. Unlike "Daily Journal", entries in "Notebook" are not
tied to a date. Instead, the entries are named.

To create a new entry, click on the Entry menu, choose Create New Entry, and then Document (or press
F9). This will create a new document entry. Enter the name you want the entry to have and hit ENTER.
You now have a new loose-leaf entry following the first one in the tree.

"Notebook Entry" is the default name of entries created in this category. To change the name of the
entry, click on the entry in the tree (or press F2). Then type in what you want to call the entry.

Press F10 ("Create New Sub-Entry") to create a new entry as a sub-entry of the current entry.

A loose-leaf entry can have as many sub-entries as you want. Loose-Leaf entries can also be organized
by dragging and dropping them in the tree.

Click on the second entry in the tree and "drag" it up to the first entry. Then release it. The second entry
is now a "sub-entry" of the first entry.

This gives you the basics of creating and using entries in The Journal.

For more information, see Entries.
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3.2.1 Printing Entries

Once you have created entries in The Journal, a common task is to print those entries.

To print a single entry, bring up that entry. Then click on the File menu and choose Print (or press
Ctrl+P).

With "Active Entry" selected, click on "Print". That will print the currently selected entry.

Want to review the entry before you print? Click on "Preview".

You can also print multiple entries, either from the same category or multiple categories. To do that,
click on "These Categories/Entries" and then select the categories and/or entries that you want to
print. Then click "Print".

For more information, see Printing.
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To learn more about headers and footers, see Printing Headers and Footers and User Preferences:
Printing.

3.2.2 Inserting Images and Media in Entries

Your entries aren't limited to just text. You can insert digital photos, clip art, and even media like audio
and video.

Inserting Images

To insert almost any kind of image in your entries:
digital photos,
clip art,
any image of type JPG, PNG, BMP or GIF.

Click on this icon on the toolbar:

 
Or click on the Insert menu, and choose "Insert Image..."

You can also drag images from Windows Explorer and drop them into your entry.

Inserting Media

You can also insert most types of audio and video files into your entries:
audio - wma, wav, mp3, mid, midi, ra, ram
video - wmv, mpg, mpeg, avi, mov, rm

Click on this icon on the toolbar:

Or click on the Insert menu, and choose "Insert Media File (Audio/Video)..."

You can also drag images from Windows Explorer and drop them into your entry.

An attached audio file shows this icon:

An attached video file shows this icon:
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NOTE: Some media files are very large. Media files larger than 10 MB will cause your entries to load and
save slower. Media files larger than 50 MB may not perform well when stored in The Journal.

Also note: The Journal relies on Windows for media file playback. If you are using Windows XP, it's
possible that not all types of media file listed above will play.

3.2.3 Other Entry-Related Topics

Besides printing and inserting images, you can also:
post your entries to a blog;
insert tables;
use images as backgrounds for your entries;
link entries together like a Wiki;
tag your entries with topics;
and more!

These topics are covered in detail in The Journal Reference section of this online help.

3.3 Using Categories

The Journal's categories provide a powerful tool for organizing your journaling, notes or other writing
projects.

The "Daily Journal" and "Notebook categories" are created for you automatically, but you are not limited
to just those. You can have as many or as few categories as you want. Every category has its own tab.

The Journal supports two kinds of category: calendar and loose-leaf.

Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades and
centuries. The "Daily Journal" category created for you automatically is a calendar category that creates
a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, as far back or as far forward as
you want to go.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

Further, calendar categories can have loose-leaf sub-entries, just like a loose-leaf category.

Loose-leaf Categories

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
calendar categories).

Entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf notebook.



The Journal44

© 1996-2011 by David Michael

Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, and so on).

3.3.1 Creating a New Category

To create a new category, click on the Category menu and choose "Create New Category..."

Enter the name of the category you would like, then choose whether you want a calendar category or a
loose-leaf category. If you choose a calendar category, you will then have to specify how often you want
the category to create new entries.

When you click "Create", the new category is added to your collection of category tabs.

3.3.2 Editing Categories

To edit a category, right-click on the category tab and choose "Category Properties..."

Or you can click on the Category menu and choose "Category Properties..."
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You can edit the name of your category, its order in the tabs, even whether its tab is visible or not and a
whole lot more.

See Category Properties for more information.

3.4 Creating Additional Logins

When you first started The Journal, you had to create your first login name.

You can have, however, as many logins as you want: one for each project (for even more separation than
categories), one for each family member, one for work and one for home, and so on. Each login can have
its own password.

Create a New User

Click on the File menu and choose "Create New User..."

Every user must have a unique User Name. Every user must also have a password, or choose to have
no password (a blank password).
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Once you click Next, and then Finish, the user will be created within the currently active Journal
Volume.

3.5 Creating Additional Journal Volumes

When you first started The Journal, you had to create your first Journal Volume.

Like entries, categories and user logins, you can have as many Journal Volumes as you want. Each
Journal Volume is completely separate from every other.

Creating a New Journal Volume

Click on the File menu, find the Journal Volume sub-menu, and choose "Create New Journal
Volume..."

Every Journal Volume must have a unique name. This name is used to create a sub-folder for that
Journal Volume.

NOTE: It is not recommended that you change the base Journal Volume folder (displayed under Create
Journal Volume in this Folder).

Once you click OK, the Journal Volume is created.

The first time you open a Journal Volume, you will be prompted to create the first login name for that
Journal Volume.

3.6 Database Maintenance

The Journal's entry database has proven very stable over the years, but it is always a good idea to make
regular backups.

The Journal automatically prompts you to make a backup once a week (every 7 days). If you would like
to backup more or less frequently, you can set this using the Backup Settings.

How do I backup The Journal?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup The Journal..."

2. Check to select the Journal Volumes you want to backup.

3. Click on "Start Backup".
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See Backup Settings for more information.

How do I copy my backup file to another location?

Your Journal backup files can be automatically copied to another folder on your hard drive, to a network
folder, to an external hard drive, or even offsite to an FTP server.

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup Settings..."

2. Under "Copy backup archive to these locations", add the folder(s) or FTP server you would like
your backup copied to.

For more information see Backup Settings.
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4 Frequently Asked Questions (FAQ)

Entries
How can I import my entries from another diary or journal program?
How do I insert images in my entries?
Can I insert digital photos in my entries?
How do I wrap text around pictures in my entries?
How can I use tables in my entries?
How do I make my tables look like those in MS Word/WordPerfect/Etc?
How do I use topics in my entries?
How do I lock my entries so they can't be edited?
How do I post my entries to a blog?
How do I use templates in my entries?
How do I have a template automatically inserted in my entries?
How can I create my own templates?
Why can't I edit my past entries?
How do I create loose-leaf entries in my calendar category?

Printing
How do I set the printer margins?

Categories
What is a "category"?
What is a "calendar category"?
What is a "loose-leaf category"?
How do I set a category's default font?
How do I create a new category?
How do I delete a category?
How do I put the category tabs on top (instead of on the right)?

User Interface
I lost my password. How do I reset my password?
How can I customize the look of The Journal (change the skin)?
How do I customize the toolbars?
What is the hot-key (keyboard shortcut) for...?
How do I make The Journal 5 look like The Journal 4?
Can I use voice-recognition software with The Journal?

Journal Volumes
What is a Journal Volume?  
How do I synchronize 2 Journal Volumes?
How do I move The Journal to a new computer?
How do I install The Journal to a USB/Flash drive?
How do I use The Journal on a Network?

Export/Import
How can I import my entries from another diary or journal program?
How do I synchronize 2 installations of The Journal?

Database Maintenance
How do I backup The Journal?
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How do I copy my backup file to another location?
How do I restore from a backup?
How do I see what is in my backup file?
How do I restore just one category from a backup file?

Security
How do I set/change my password?
How do I get rid of my password?
What is Extended Security?
What kind of encryption does The Journal use?

Upgrading
Will The Journal 5 upgrade my categories and entries from The Journal 4 (or earlier)?
I am a registered user of The Journal 4 (or earlier). What is the upgrade price for The Journal 5?
How do I make The Journal 5 look like The Journal 4?

Glossary

Your question not here? Feel free to ask! Click here to email DavidRM Software.

4.1 FAQ: Entries

How can I import my entries from another diary or journal program?
How do I insert images in my entries?
Can I insert digital photos in my entries?
How do I wrap text around pictures in my entries?
How can I use tables in my entries?
How do I make my tables look like those in MS Word/WordPerfect/Etc?
How do I use topics in my entries?
How do I lock my entries so they can't be edited?
How do I post my entries to a blog?
How do I use templates in my entries?
How do I have a template automatically inserted in my entries?
How can I create my own templates?
Why can't I edit my past entries?
How do I create loose-leaf entries in my calendar category?

How do I insert images in my entries?

Click on this icon on the toolbar:

 
Or click on the Insert menu, and choose "Insert Image..."

You can also drag-and-drop images into your entry using Windows Explorer.

Also see: Using Images in Entries

Can I insert digital photos in my entries?

mailto:support@davidrm.com
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Yes. You can insert just about any kind of image into The Journal, including digital photos (which are
most often compressed JPEG images: *.JPG).

Keep in mind, however, that digital photos larger than 3-4 megapixels (MP) may take a noticeable
amount of time to save and load. The more photos in the entry, the longer it will take to load. So you
may want to crop and/or reduce digital photos of 6+ MP before inserting them. Feel free to experiment
and see what works best for you.

The Journal's Automatic Image Resizing feature can help with inserting digital photos into entries.

How do I wrap text around pictures in my entries?

1. First, you insert the image, picture or digital photo as described above.

2. Click on the image to select it.

3. Right-click the image and choose "Edit Image/Object Properties & Layout".

4. Bring up the "Layout" tab.

5. Under "Vertical Alignment", choose the "Align" you want:
left side  <-- the image will be on the left side, the text wrapping on the right
right side <-- the image will be on the right side, the text wrapping on the left

6. Under "Spacing", you can put a little "white space" around the image, so the text doesn't run right up
to it. I like: 5

7. Click on OK.

How can I use tables in my entries?

To insert a table, click on this icon on the toolbar:

Or click on the Insert and choose "Insert Table..."

See Using Tables.

How do I make my tables look like those in MS Word/WordPerfect/Etc?

You can give your tables the single-black-line border used in most word processors by adjusting the cell
spacing and turning off the table's border.

1. Select the table.
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2. Click on the Table menu and choose "Table Properties..."

3. Click on More... (next to Cell Spacing).

4. Un-check Equal Values.

5. Change the Horizontal and Vertical values for Between Cells to: -1

6. Change the Horizontal and Vertical values for From Table Border to Cells to: 0

7. Click on OK.

8. Click on Table Border...

9. Under Border Type click on None.

10. Click on OK.

11. Click on OK.

How do I use topics in my entries?

See Using Topics.

How do I lock my entries so they can't be edited?

You can make any entry "read only", to prevent changes to that entry.

1. Select the entry you want to lock.

2. Click on the Entry menu and un-check "Edit Entry (toggle Read Only)" (hot-key: F4).

You will see "Read Only" displayed on the status bar below the entry.

You can edit the entry again by repeating that procedure. F4 toggles locked/read only status.

You can make all past entries in a calendar category “read only” automatically by checking the option in
the Calendar tab of the Category Properties.

How do I post my entries to a blog?

See Using a Blog.

How do I use templates in my entries?

To insert a template in an entry:

1. Click on the Insert menu, and bring up the "Insert Template" sub-menu.
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2. Choose the template to insert, and the text from that template will be inserted in your entry.

How do I have a template automatically inserted in my entries?

1. Right-click on the category tab and choose Category Properties...

2. Bring up the Entry tab.

3. Select the Default Entry Template from the available drop down list of templates.

The selected template will be inserted into new entries. For calendar categories, this template will be
inserted into new entries for the current day. For loose-leaf categories, the template will be inserted into
all newly created entries.

How can I create my own templates?

See Creating Simple Templates and Creating Enhanced Templates.

Why can't I edit my past entries?

In your category, past entries may be set to be "read only". You can override this by clicking on the 
Entry menu and choosing "Edit Entry (toggle Read Only)" (or pressing the hot-key: F4).

You can also change the category setting so that all past entries edit-able:

1. Click on the Category menu and choose "Category Properties..."

2. Bring up the Calendar tab.

3. Un-check the option: "Mark past entries Read Only"

How do I create loose-leaf entries in my calendar category?

To create a sub-entry of a calendar entry (or a loose-leaf entry): Press F10

To create a new, root-level loose-leaf entry: Press Shift+F9

4.2 FAQ: Printing

How do I set the printer margins?

To set the printing margins:

1. On the User menu, click on "User Preferences..."

2. Bring up the Printing tab.
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3. Click on "Edit Default Page Setup".

4. There you can set the margins to how you want them, and click "OK" when you're done.

Those settings will be used every time you print, unless you override them at the category level.

4.3 FAQ: Categories

What is a "category"?
What is a "calendar category"?
What is a "loose-leaf category"?
How do I set a category's default font?
How do I create a new category?
How do I delete a category?
How do I put the category tabs on top (instead of on the right)?

What is a "category"?

Categories are a powerful way to organize your entries in The Journal. The Journal creates three
categories for you automatically: "Daily Journal", "Notebook", and "Templates". Each category has its
own tab, making it easy to switch back and forth. You can create as many categories as you want.

"Daily Journal" is a calendar category which creates a new entry for you every day, and organizes
those entries into months and years for you.

"Notebook" is a loose-leaf category. Entries in a loose-leaf category are not tied to a specific date.
Instead, they are like named documents that you can arrange any way you want.

For more information, check out Calendar Categories and Loose-leaf Categories.

What is a "calendar category"?

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades and
centuries. The "Daily Journal" category created for you automatically is a calendar category that creates
a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, as far back or as far forward as
you want to go.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

What is a "loose-leaf" category?

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
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calendar categories). Instead, entries in a loose-leaf category are named documents, arranged by you,
just like a loose-leaf notebook.

Loose-leaf category entries can be arranged in any order (just click-and-drag), and entries can have sub-
entries (which can have sub-entries, which can have sub-entries, ...).

How do I set a category's default font?

You can use any Windows font (TrueType or Type-1) for your entries.

To set the default font used by a category:

1. Click on the Format menu and choose "Change Default Font for [category name]".

If you want to change the default font for all categories, you need to change your user default font:

1. Click on the User menu and choose "Change User Default Font".

How do I create a new category?

1. Click on the "Category" menu and choose "Create New Category..."

2. Choose a name for your category (example: "Dreams").

3. Pick a category type, Calendar or Loose-leaf.

4. If you are creating a calendar category, you will need to choose how often you want a new entry:
Every 1-12 hours,
Every day,
Every week (on a particular weekday),
Every month (on a particular day), or
Every year, decade, or century (if you're writing a history)

5. If you would like the new category to be a sub-category, choose the category that the new category
will be under.

When you click on "Create", your new category will be created and you will be able to click on its tab
and start making entries immediately.

Learn more about The Journal's categories here: Categories

How do I delete a category?

1. Right-click on the category tab, and choose "Category Properties..."

2. Select the category to delete from the list of categories.

3. Click on "Delete Category".



The Journal56

© 1996-2011 by David Michael

NOTE: Deleting a category also deletes all of the entries in that category, as well as any sub-categories
(and their entries). Deleting a category cannot be undone. You would need to restore from a backup to
recover a deleted category.

How do I put the category tabs on top (instead of on the right)?

1. Click on the User menu and choose "User Preferences..."

2. On the "General" tab, un-check the option: "Arrange category tabs on right"

4.4 FAQ: User Interface

I lost my password. How do I reset my password?
How can I customize the look of The Journal (change the skin)?
How do I customize the toolbars?
What is the hot-key (keyboard shortcut) for...?
How do I make The Journal 5 look like The Journal 4?
Can I use voice-recognition software with The Journal?

I lost my password. How do I reset my password?

Most lost user passwords and category passwords can be reset.

Email DavidRM Software and request a password reset code.

You will be sent a password reset code and instructions for how to use it.

NOTE: Users who have activated Extended Security cannot have their passwords reset. That's one of
the features of Extended Security.

How can I customize the look of The Journal (change the skin)?

There are 170+ skins for you to choose from, which you can easily change as your mood or style takes
you.

Click on the View menu and choose "Change Skin/Theme..."

You can also change the skin--or turn off skinning--of The Journal in User Preferences (on the User
menu), on the "Global" tab. Note that if you turn skinning off (or back on), that you will need to close
and restart The Journal.

How do I customize the toolbars?

Right-click on the menu or toolbar that you want to customize, and choose Customize. This will open
up a form which contains all available menu and toolbar commands.

mailto:support@davidrm?subject=I need a Password Reset Code for The Journal
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Bring up the Commands tab.

Click on the commands you want and drag-and-drop them on the menu or toolbar where you want them
to appear.

In addition, all toolbars, as well as the main menu, can be undocked and be floating at any position on
your screen. Mouse over the far left of each toolbar until the four directional cursor appears, then left-
click and drag the toolbar to the position you’d prefer.

What is the hot-key (keyboard shortcut) for...?

All hot-keys are listed here: Keyboard Shortcuts

Can I use voice-recognition software with The Journal?

Yes, The Journal can be used with most voice-recognition software (VRS).

When you use VRS with The Journal, it's recommended that you turn off a couple of features:
"Check spelling as you type"
"Correct spelling errors as you type"

Both of these features can be turned off on "Spell Checker" tab of "User Preferences" (on the User
menu).

4.5 FAQ: Journal Volumes

What is a Journal Volume?  
How do I synchronize 2 Journal Volumes?
How do I move The Journal to a new computer?
How do I install The Journal to a USB/Flash drive?
How do I use The Journal on a Network?

What is a Journal Volume?

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Journal Volumes can be placed on any available hard drive, internal or external or network attached, or
even removable thumb drives. Each Journal Volume must have a unique name.

Most users of The Journal will only need a single Journal Volume.

See Journal Volumes for more information.

How do I synchronize 2 Journal Volumes?

It is possible to keep entries across multiple Journal Volumes "in sync" using the export and import
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features of The Journal.

See the Export/Import Overview and Synchronizing Journal Volumes for more information.

How do I move The Journal to a new computer?

1. Create a backup of your Journal Volumes (File menu, Maintenance sub-menu, Backup The
Journal...).

2. Download and install The Journal on your new computer.

3. Copy the backup file you created in #1 to your new computer.

4. Run The Journal on your new computer. In the New User Wizard, check the option "I need to
Restore from a Backup of The Journal" and click on "Next".

5. Browse to select the backup file.

6. Click on "Restore". You will be prompted to create the Journal Volumes you need.

How do I install The Journal on a USB/Flash Drive?

The Journal can be installed and run on USB/flash drives and external hard drives. This provides a simple
way for you to have The Journal available to you on just about any computer with Windows and a USB
connector. 

Here's how: 

1. Install The Journal to the USB drive. You will need to override the default installation path. Type in the
path or browse to the folder on the USB drive that you want to use.



Frequently Asked Questions (FAQ) 59

© 1996-2011 by David Michael

2. During the install, after you've typed in the path to the USB drive, you will next need to check the
option:

"I am installing The Journal on a USB/Flash drive."

And *UN*-check these options:
"Create Start Menu icons" 
"Create a desktop icon" 
"Create a Quick Launch icon" 
"Have The Journal start with Windows."

3. After the install completes, double-click on Journal5.exe on the USB drive to run The Journal.

4. The first time you run The Journal on the USB drive, in the New User Wizard, check these options:

"I have just installed (or re-installed) The Journal." 
"I am running The Journal on a USB/Flash drive." (This option will probably be disabled, as it's
already been set during the install.)
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5. The default path is ".\The Journal Volumes\5". You can change the default path, but make sure that
the path you enter uses the relative path format. If you're not sure what that means...just accept the
defaults. =)

And that's it.

If you want to transfer an existing Journal Volume onto the USB drive, use The Journal's backup and
restore feature. Do the backup from the install of The Journal that you had before (the one on your
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computer's main hard drive), and then do the restore from The Journal on the USB drive.

How do I use The Journal on a Network?

The Journal can have its Journal Volume(s) on a shared or network folder, allowing multiple users to
access those Journal Volume(s) at the same time. To do this, though, The Journal must be installed
properly.

1. When you install The Journal, on the "Select Additional Tasks" page of the install wizard, you need
to check this option: "The Journal's database will be in a shared or network folder"

2. You will be prompted to specify the shared/network folder to use.

3. You will have to do this on each of the computers or workstations that will be using The Journal over
the network.

4. If the users will be accessing or updating the same categories and entries simultaneously:Once you
have The Journal installed, you'll want to have set categories to use the "Lock Entries on Edit" option (on
the "Sharing" tab of Category Properties).

4.6 FAQ: Export/Import

How can I import my entries from another diary or journal program?
How do I synchronize 2 installations of The Journal?

How can I import my entries from another diary or journal program?

The Journal supports batch entry import, which makes it relatively simple to import entries from other
diary or journal programs.

1. Create a temporary folder on your hard drive.

2. Export your entries from the other software into individual text (.txt), rich text (.rtf), or HTML (.htm;.
html) files. Export to the temporary folder you created in #1. If the entries are for a particular day, make
sure the date is used in the name of the exported file. The best date format will use a 4-digit year, a 2-
digit month, and a 2-digit day.

Example:
1993-10-05.rtf (entry for 5 October, 1993)

3. Once you have the entries exported, start The Journal. On the File menu, Import sub-menu, choose
"Batch Entry Import..." to import the entries into The Journal.

4. Choose the category you want to import the entries into (like "Daily Journal").

5. Browse to the temporary folder where your exported entries are.

6. Set the "Specify Date Format" to match how the export named your entries.
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Example:
yyyy-mm-dd.rtf

Then do the import.

See Importing Entries from Other Journal Software and Batch Entry Import for more information.

How do I synchronize 2 installations of The Journal?

It is possible to keep entries across multiple Journal Volumes "in sync" using the export and import
features of The Journal.

See the Export/Import Overview and Synchronizing Journal Volumes for more information.

4.7 FAQ: Database Maintenance

How do I backup The Journal?
How do I copy my backup file to another location?
How do I restore from a backup?
How do I see what is in my backup file?
How do I restore just one category from a backup file?

How do I backup The Journal?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup The Journal..."

2. Check to select the Journal Volumes you want to backup.

3. Click on "Start Backup".

See User Preferences: Backup/Restore for more information.

How do I copy my backup file to another location?

Your Journal backup files can be automatically copied to another folder on your hard drive, to a network
folder, to an external hard drive, or even offsite to an FTP server.

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup Settings..."

2. Under "Copy backup archive to these locations", add the folder(s) or FTP server you would like
your backup copied to.

See User Preferences: Backup/Restore for more information.
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How do I restore from a backup?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Restore From Backup..."

2. Browse to select your backup file.

3. When the backup file is opened, the Journal Volume name will be displayed, as well as the date the
backup file was created.

4. If more than one Journal Volume is listed, select the Journal Volume to restore from the list. 

6. Click on "Restore Journal Volume".

7.a. If the Journal Volume doesn't exist in The Journal, you will be asked if you want to create the
Journal Volume.

7.b. If a Journal Volume with the same name does exist, you will be ask to confirm overwriting the
current Journal Volume.

7.c. Otherwise, select the Journal Volume to restore into. 

NOTE: Everything that is in the Journal Volume you select will be overwritten by the information in the
backup. So select the Journal Volume *very* carefully.

Once the restore is finished, you can open the Journal Volume and log in.

How do I see what is in my backup file?

1. On the File menu, find the Maintenance sub-menu, and choose "Restore from Backup...". Browse
to select your backup file.

2. When the backup file is opened, the Journal Volume name will be displayed, as well as the date the
backup file was created.

3. Click on "Create New Journal Volume" to create a new, temporary Journal Volume that you can
restore into.

4. Click on "Restore Journal Volume". This will restore the backup file into the newly create Journal
Volume.

Then you can open the new Journal Volume, log in and review what it contained.

When you need to delete the temporary Journal Volume:

5. Click on the File menu, Journal Volume sub-menu and choose "Delete Journal Volume..."

6. Select the Journal Volume you created in #3 above, and then click on "Delete".

How do I restore just one category from a backup file?
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1. Create a new Journal Volume.

2. Restore the backup file into the new Journal Volume.

3. In the new Journal Volume, click on the File menu, Export sub-menu, and choose "Export
Entries..."

4. Check the category in the list to export the entire category to a JNX (Journal Export format) file.

5. In your original Journal Volume, click on the File menu, Import sub-menu, and choose "Import
Entries..." to import the JNX file.

6. Verify the category has imported properly by reviewing its entries.

7. Delete the new Journal Volume you created in #1.

4.8 FAQ: Security

How do I set/change my password?
How do I get rid of my password?
What is Extended Security?
What kind of encryption does The Journal use?

How do I set/change my password?

Click on the User menu and select "Change User Password..."

You will need to enter your current password (unless you have a blank password) to create a new
password, and then confirm your new password.

How do I get rid of my password?

If you do not want The Journal to prompt you for your password:

1. Click on the User menu and choose "Auto-Login".

2. Enter your password at the prompt to confirm auto-login.

You can turn off automatic login by clicking on the User menu and choose "Auto-Login" again.

What is Extended Security?

Extended Security enhances The Journal's normal security by adding an additional layer of protection,
and a couple of security-related options.

The Journal's "basic" security is quite good, more than most people will ever need. Extended Security
builds on that to make The Journal as secure as possible.

See Extended Security for more information.
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What kind of encryption does The Journal use?

Encryption of entries uses the Twofish block cipher designed by Bruce Schneier.

See Security Details for more information.

4.9 FAQ: Upgrading

Will The Journal 5 upgrade my categories and entries from The Journal 4 (or earlier)?
I am a registered user of The Journal 4 (or earlier). What is the upgrade price for The Journal 5?
How do I make The Journal 5 look like The Journal 4?

Will The Journal 5 upgrade my categories and entries from The Journal 4 (or
earlier)?

Yes, The Journal 5 will upgrade your existing categories and entries from any past version of The
Journal.

Upgrading Your Journal Volumes from The Journal 4 (or earlier) (Most Users)

Upgrading Your Journal Volumes from The Journal 4 installed on a USB drive

Upgrading from a Backup File (*.jbk or *.jbu)

See Upgrading from The Journal 4 or The Journal 3 or Upgrading from The Journal 2.x for more
information.

I am a registered user of The Journal 4 (or earlier). What is the upgrade price for
The Journal 5?

If you purchased The Journal from 1 January 2009, up to the release of The Journal 5, you are eligible for
a free upgrade. Email DavidRM Software to request your Registration Keys for The Journal 5. Include
your full name, mailing address, and date of purchase.

People who have purchased any previous version of The Journal are eligible for special upgrade pricing
($24.95 US). To receive your The Journal 5 Upgrade Coupon Code, you must submit your full name,
mailing address, and date of purchase to DavidRM Software.

See The Journal Pricing for more information.

How do I make The Journal 5 look like The Journal 4?

Don't like the tabs down the right side? Or the new tabs for the Journal Volume and user? Or the new
toolbar/menu icons? Here's how to shift things around to make The Journal 5 look more like The Journal
4:

mailto:support@davidrm.com
mailto:support@davidrm.com
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1. Click on the User menu and choose "User Preferences..."

2. Un-check these options on the "General" tab:

Arrange category tabs on the right
Show Journal Volume tabs (global option)
Show User tabs (global option)

3. Check this option on the "Global" tab:

Use TJ4 icons for the toolbars, menus and entry tree

4. Click on Done.

4.9.1 Upgrading from The Journal 4 or The Journal 3

Upgrading Your Journal Volumes from The Journal 4 (or earlier) (Most Users)
Upgrading Your Journal Volumes from The Journal 4 installed on a USB drive
Upgrading from a Backup File (*.jbk or *.jbu)

Upgrading Your Journal Volumes from The Journal 4 (or earlier) (Most Users)

If you have either The Journal 4 (or The Journal 3) installed, then the first time you run The Journal 5 it
will detect your existing Journal Volumes and offer to import them into The Journal 5.

Click on Yes to start the import.

The import process copies your TJ4/TJ3 Journal Volumes to a new location before upgrading them. Your
existing Journal Volumes will not be changed or modified in any way.

The upgrade happens in 2 steps:

1. Database upgrade. This happens the first time you open an imported Journal Volume.

2. User upgrade. This happens the first time you log in with a user name.

If you have a lot of entries, the upgrade may take a few minutes.

UPGRADE NOTES:
A user's auto-login setting (no prompting for password) is not upgraded, so you will be prompted for
your password. You can set auto-login again by clicking on the User menu and choosing "Auto-
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Login".
Categories that were set to "read only" lose that setting when upgraded. You can set the category to
read only again in Category Properties, on the Security tab, check the option "Category entries
are Read Only (and no new entries)".

Upgrading Your Journal Volumes from The Journal 4 installed on a USB drive

NOTE: You will need about 20 MB of space just to install The Journal 5, and then about twice as much
free space as your TJ4 Journal Volume currently uses (it won't always need this much space; just during
the import and upgrade).

First, install The Journal 5 to your USB drive.

Run The Journal 5. It will create a new, empty Journal Volume for you.

To import your TJ4 Journal Volumes do this: Click on the File menu, Journal Volume sub-menu, and
choose "Import Journal Volume..."

Browse to your TJ4 Journal Volume folder and click on "OK".

The Journal 5 will then copy the Journal Volume into your new Journal Volumes folder and upgrade it.

Upgrading from a Backup

If you do not have The Journal 4 (or earlier) installed, but you do have a backup file (*.JBK or *.JBU) from
The Journal 4 (or earlier), you can upgrade from that.

The first time you run The Journal 5, you will be shown the "New User Wizard". On the first page of the
wizard click on "I need to Restore from a Backup of The Journal", then click on Next.
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You will then browse to select the backup file to restore from.

Once the restore has finished, The Journal 5 will ask you to confirm that you want the Journal Volume
upgraded. Follow the on-screen instructions to upgrade the Journal Volume.

The upgrade happens in 2 steps:

1. Database upgrade. This happens the first time you open an imported Journal Volume.

2. User upgrade. This happens the first time you log in with a user name.

If you have a lot of entries, the upgrade may take a few minutes.

Reverting to The Journal 4

Should you decide not to stick with The Journal 5, you will want to do this:

1. Export all new/edited entries created or changed since you installed The Journal 5.

1.a. Use Windows Explorer to create a temporary folder to export into.
1.b. Back in The Journal 5, click on the File menu, Export sub-menu, Export Entries...
1.c. Click on Options... and make sure that the "RTF/TXT/HTM File Options" is set to "Create a file
for each exported entry".
1.3. Select the entries you have created/changed in The Journal 5.
1.3. Export these entries to RTF files into the folder you created.

2. Uninstall The Journal 5 using Windows Control Panel.

3. Run The Journal 4 (re-install if necessary). The Journal 4 should see your entries from before installing
The Journal 5.

4. Import the entries exported from The Journal 5.

4.a. In The Journal 4, click on the Tools menu and choose Batch Entry Import...
4.b. Browse to the folder you created in #1 (above) with your exported entries.
4.c. Select the category to import the entries into.
4.d. Select the .RTF files to import.

4.9.2 Upgrading Add-on Packages

If you have purchased add-on packages for earlier versions of The Journal, such as MemoryGrabber and
Writing Prompts 1, you can still use them in The Journal 5.

Any packages you are already using should be upgraded. If not, the easiest way to get the packages
into The Journal 5 is to run the add-on installation again:

1. Make sure The Journal is not running.

2. Run the installation program for the package. When asked for the folder to install into, change it from:
C:\Program Files\DavidRM Software\The Journal 4\Package\
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To:
C:\Program Files\DavidRM Software\The Journal 5\Package\

If you need to download the add-on installation program, email DavidRM Software.

4.9.3 Upgrading from The Journal 2.x

The Journal 5 can upgrade users, categories, and entries created with any 2.x release.

If you already have The Journal 2.x installed, you can upgrade the entry database easily. Just point the
upgrade process to the folder on your hard drive which contains the 2.x database. The 2.x database will
be copied to a temporary location before the upgrade is processed to prevent any changes to it.

If you have a backup that was created with The Journal 2.x, you can also upgrade from that. The backup
will be restored to a temporary database, which will then be upgraded.

NOTE: The information below applies only to users, categories, and entries upgraded from The
Journal 2.x.

Upgrading Users

All user-specific settings are upgraded except for some display settings (like the size and position of
The Journal). Settings for "Single User Mode", "Minimize to System Tray", and "Always on Top" are not
upgraded.

Your password is unchanged from the upgrade. It is recommended that you change your password after
upgrading.

If you use "Single User Mode" in The Journal 2.x, it is recommended that you turn if off before you
upgrade so that you can be certain you still remember your password.

Upgrading Categories

All categories are upgraded, whether they are active or inactive.

"Daily" categories in The Journal 2.x are converted to calendar categories (daily).

"Non-Daily" categories are also converted to calendar categories (daily).

"Loose-leaf" categories in The Journal 2.x are converted to loose-leaf categories. The "tree structure" of
entries is preserved, as is the sorting of entries.

Categories with passwords are upgraded, but the password protection is removed. So any password-
protected categories will have to be given passwords again after the upgrade.

Upgrading Entries

All entries in The Journal 2.x are upgraded.

mailto:support@davidrm.com
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5 The Journal Reference

This section includes detailed descriptions of all The Journal's features, and how to use them.

Glossary

Blog Support
Categories
Database Maintenance
Entries
Export/Import
Images & Media
Journal Volumes
Links
Printing
Reminders & Tasks
Security
Styles
Tables
Templates
Topics
User Interface
User Preferences

5.1 Glossary

Auto-Login

The auto-login option automatically logs you in when you start The Journal. You can turn on auto-login
by clicking on the User menu and checking "Auto-Login". You will be prompted for your password once
more, but not again. You can turn off auto-login by clicking on the User menu and un-checking the
"Auto-Login" option.

This option can also be set on the Security tab of User Preferences.

Blog

Short for "Web log", a form of public diary usually posted on a Web site. The Journal allows you to post
your entries to most blogs (WordPress, Blogger, and so on). See Using a Blog for more information.

Bookmark

A bookmark is a point in an entry that can be linked to. To insert a bookmark, click on the Insert menu
and choose Insert Bookmark... You will be prompted for a name for the bookmark.

Calendar Charms

Calendar Charms are icons, or small graphic images, that can be assigned to entries. The entry's
Calendar Charm is then displayed on the calendar and in the category's entry tree. Calendar Charms
can also be inserted into entries, like clip art.
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Categories

Categories are a powerful way to organize your entries in The Journal. The Journal creates three
categories for you automatically: "Daily Journal", "Notebook", and "Templates". Each category has its
own tab, making it easy to switch back and forth. You can create as many categories as you want.

There are two types of category: Calendar and Loose-leaf.

Categories, Calendar

Calendar categories are also called "daily entry" categories. However, calendar categories can be
hourly, weekly, monthly even yearly as well as daily. Calendar category entries are tied to a specific
date (or range of dates) and optionally a specific time. You can make as many entries on a date and/or
time as you would like.

Categories, Loose-leaf

Loose-leaf categories are often called "notebook" categories. Entries in a loose-leaf category are not tied
to any date. Instead, they are named documents (or external objects or images). Also, unlike calendar
category entries which are always arranged by year, month, day and time, loose-leaf category entries
can be arranged in "trees" of the user's choosing.

Categories, Shared

A shared category is a category that can be accessed by each user that links to it (and provides the
optional sharing password). All entries in the shared category are available. Categories can be shared
"read only" or "full access".

Day Planner

The day planner is your reference for all your active reminders, and can be set to display in any of your
journal categories above the entry editor. You can display your reminders just for today and up to a week
in advance.

Entry (Entries)

Entries, organized by category, are the core of The Journal. Entries can be text "documents", external
objects, or images. Most categories use document entries, because they are the most flexible type of
entry, but any type can be set as the default for the category.

Entry, Document

Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any Windows font installed on your PC can be used to format the text. Document
entries can also include images, media files, and even embedded files.

Entry, External Object
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External object entries are essentially Windows data files stored in (or linked from) The Journal. Double-
clicking an external object entry will open the entry using the associated Windows application. If
possible, the application will be "hosted" inside The Journal.

Entry, Image

Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.

Entry Tree

The "entry tree" is the list of entries below the calendar. Calendar entries are arranged automatically by
year, month, day and time. Loose-leaf entries are arranged however you want them (just click and drag
to arrange loose-leaf entries).

Exporting

Use The Journal's export features to make entries available to other software or to synchronize Journal
Volumes.

Importing

Bringing files created by other applications (including other journal software) into The Journal. See 
Importing.

Journal Volume

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries. Each Journal Volume has its own folder on your hard
drive (or USB device or network drive).

Links

The Journal supports hypertext-style links in document entries.

There are two types of link: entry links and Internet links. Entry links are links to another entry in The
Journal (or to a bookmark within an entry). Internet links are links to Web pages or email addresses.

If an entry is "read only", you can activate a link just clicking on it. If the entry is not "read only",
however, you will need to hold down the Ctrl key and then click on the link.

Links, Entry

Entry links are special hyperlinks within The Journal to allow  jumping to another entry, or a bookmark
within an entry.

Links, Internet

Internet links are links web page addresses, email addresses, and so on.

Media
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Audio files and video files like .wav and .mpg are called "media files".

Style

A style is a pre-defined text format. A style can set the font, change paragraph settings, use numbers or
bullets, and more. The Journal automatically creates a small collection of styles for besides the default:
Heading 1, Heading 2, Heading 3, and HTML Passthru (for blogs).

System Database

The Journal's System Database stores the names and locations of all Journal Volumes, as well as
certain global options. The Journal recreates the system database when it needs to.

Topic

Topics are another way to organize your entries. You can set a topic (e.g., "Feelings -> Happy") to the
text of entry, either as you type it or afterward. You can set as many topics within an entry as you wish.
You can also "tag" an entry with a topic. In that case, the topic applies to the whole entry, not just to a
block of text. You can then search entries with a topic or topics and review them.

5.2 Blog Support

The Journal's "blog" (Web log) support gives you the ability to post entire entries (or just selected
portions of entries), both text and images, to public blogs--without sacrificing privacy and security. You
choose what entries and information are posted to your blog, and keep sensitive and/or private
information inside The Journal.

Blogs Supported
B2Evolution (www.b2evolution.net)  
Blog-City (www.blog-city.com)
Blogger (www.blogger.com)
CafeLog (www.cafelog.com)
LiveJournal (www.livejournal.com)
MovableType (www.movabletype.org)
MSN Spaces (spaces.msn.com)
Quick Blogcast (from GoDaddy)
TypePad (www.typepad.com)
WordPress (www.wordpress.org or www.wordpress.com)
Custom: Blogger (blogs that support the Blogger API)
Custom: LiveJournal (blogs that use the LiveJournal API/source code)
Custom: MetaWeblog (blogs that support the MetaWeblog API)
Custom: MovableType (blogs that support the MovableType API)

Support for more blogs will be added as users request them. So if you don't see your favorite, check 
Setting Up a Custom Blog or contact DavidRM Software (davidrm@davidrm.com).

Using a Blog
Blog Profile

http://www.b2evolution.net/
http://www.blog-city.com
http://www.blogger.com
http://www.cafelog.com
http://www.livejournal.com
http://www.movabletype.org
http://spaces.msn.com
http://www.typepad.com
http://www.wordpress.org
http://www.wordpress.com
mailto:davidrm@davidrm.com
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5.2.1 Using a Blog

Here are the steps to using a blog with The Journal:

1. Create your Blog Account

First, you will need a blog account to post to. Many blog hosts, like WordPress, LiveJournal and Blogger
, provide free accounts. You just have to sign up for one.

2. Create a Blog Profile in The Journal

Next, you need to create a blog profile so The Journal knows how to post to your blog.

Click on the Tools menu, and choose Blog Profiles...

On the Blog Profiles form, click on Create New Blog Profile and enter the necessary information:
Blog Tool (example: LiveJournal)
Alias/User Name (example: DavidRM)
And so on.

See Blog Profile for more information about setting up your blog profile.

In most cases, you can leave the rest of the blog profile settings as they are.

3. Make an entry in The Journal

Bring up a blank entry and type up the text you want to post to your blog, just like you were making a
normal entry in The Journal.

4. Post the entry to your Blog

Select the text you want to post to your blog and right-click on it to bring up the editor's context menu.
Open the Post to Blog sub-menu and select the blog profile to use.

You will be prompted for your password, and then the selected text will be posted to your blog.

That's all there is to it!

5.2.2 Blog Profile

Blog Tool

Identifies the type of blog (e.g.: LiveJournal). Each blog tool has its own way of posting new entries.
Once set, the blog tool for a profile cannot be changed.

Alias

This is your alias/user name on the blog tool. This is required when logging into the blog to post an

http://www.wordpress.com
http://www.livejournal.com
http://www.blogger.com
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entry.

Blog API

Host - This is the host site of your blog (e.g.: www.livejournal.com). The Journal communicates with this
site to post the entry to your blog.

Page - This is the page (e.g.: /interface/xmlrpc/) on the blog's host site which The Journal uses to post
the entry to your blog.

Port - The port number (e.g.: 80) used to communicate with the host site. This number will be 80 in
most cases.

Timeout - The timeout value specifies how many seconds to wait for the host site to respond before
cancelling.

Proxy Settings

Do not use a Proxy Server - Use a direct connection (no proxy server) to the blog's host site.

Use Internet Explorer Proxy Settings - Use Internet Explorer's proxy settings to connect to the blog's
host site.

Use These Proxy Settings - Specify your proxy server information yourself. You must enter both an
Address and a Port. If necessary, you can also enter your proxy User Name and Password.

Export Settings

No Formatting (Simple Text) - Post entries to the blog as simple text, with no formatting.

Force doublespace between paragraphs - Force doublespacing (a blank line) between paragraphs.
NOTE: This option is only available if No Formatting is selected.

HTML Formatting - Post entry to the blog, preserving text formatting with HTML. NOTE: Not all text
formatting supported in The Journal is available in HTML.

Use <BR> tag instead of <P> tag for paragraphs - By default, the HTML exported by The Journal
uses the <p> tag for paragraphs. If you would prefer that the export use the <br /> tag for paragraphs,
check this option.

Force a Leading Blank Line in Post - If checked, a single blank will be inserted at the top of the post,
followed by the content of the post. Specifically what happens is: all "white space" at the beginning of
the post, if any, is removed, and a single blank line is inserted.

Force a Trailing Blank Line in Post - If checked, a single blank will be appended to the bottom of the
post. Specifically what happens is: all "white space" at the end of the post, if any, is removed, and a
single blank line is appended.
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Additional Settings

Make blog posts private - Post the entry to the blog as private, or not visible to other bloggers. Not
supported by all blog types.

Prompt for a title when posting - Prompt for a subject/title for the blog post. Not supported by all blog
types.

Use first line of post for title - If checked, the first line of your post will be used as the title, and
removed from the body of the post. Not supported by all blog types.

Save password for this profile - Save the password for this blog profile so that you don't have to type it
in every time. Un-check this option to clear the saved password and be prompted again.

Always post to this blog - If you can post to multiple blogs with this blog profile, you have the option of
always posting to the same blog, to avoid being prompted over and over. Un-check this option to be
prompted again.

5.2.3 Setting Up a WordPress Blog

If you have a blog hosted by WordPress (blogname.wordpress.com):

1. Blog Tool: WordPress

2. Alias/User name: blogname

3. Host: blogname.wordpress.com

4. Page: /xmlrpc.php

If you are hosting your WordPress blog on your own server:

Example 1: www.blogname.com

1. Blog Tool: WordPress

2. Alias/User name: blogusername

3. Host: www.blogname.com

4. Page: /xmlrpc.php

Example 2: www.server.com/blogname

1. Blog Tool: WordPress

2. Alias/User name: blogusername

3. Host: www.server.com
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4. Page: /blogname/xmlrpc.php

Posting Entries with Images

NOTE: This only works if you are hosting WordPress on your own server.

If you want to post entries with images in them, you will need to some additional setup on the blog.

1. In the WordPress "dashboard", click on "Settings", and then bring up the "Miscellaneous Settings"
page.

2. Set the "Store uploads in this folder" option.

3. Finally, make sure that the folder specified exists.

5.2.4 Setting Up a Custom Blog

Even if the blog site you use isn't listed in the Blog Profiles form, there's is still a good chance that The
Journal will work for you.

Gather the Necessary Blog Information

Check in your blog site's Help or FAQ (Frequently Asked Questions) section to find these bits of
information:

1. API supported - Many blog sites support the Blogger API. The MetaWeblog is also popular. You
need this information so you can choose the correct "Blog Tool" in your blog profile. If you cannot find
this information, try "Custom: Blogger API".

2. Host site - The Journal communicates with the host site to post the entry to your blog. For many blog
sites, this is the same as blog's home page (e.g., www.typepad.com).

3. Page - This is the page that is posted to on the host site.

The Host site and Page may be displayed as combined. Example: www.typepad.com/t/api/

In this case, you would separate the Host and Page like this:

Host: www.typepad.com
Page: /t/api/

NOTE: The Page may require a trailing slash (/).

Create Your Blog Profile

Once you have the above information, you can create your blog profile as described in Using a Blog.
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5.3 Categories

The Journal's categories provide a powerful tool for organizing your journaling, notes or other writing
projects.

You can have as many categories as you want. Every category has its own tab.

The Journal supports two kinds of category: calendar and loose-leaf.

Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades and
centuries. The "Daily Journal" category created for you automatically is a calendar category that creates
a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, from 1 AD to 9899 AD.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

Further, calendar categories can have loose-leaf entries, just like a loose-leaf category.

Loose-leaf Categories

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
calendar categories).

Entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf notebook.
Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, and so on).

5.3.1 Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades and
centuries. The "Daily Journal" category created for you automatically is a calendar category that creates
a new entry for you every day.

Entries in a calendar category are always tied to a particular date (or date+time) or range of dates.
Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, from 1 AD to 9899 AD.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

Further, calendar categories can have loose-leaf entries, just like a loose-leaf category. Loose-leaf
entries can be sub-entries of calendar entries, and the category can have its own loose-leaf entries that
aren't sub-entries of calendar entries (just like a loose-leaf category).

See Category Properties: Calendar for more information.
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5.3.1.1 Calendar Views

Calendar categories can display your entries in monthly and yearly calendar views.

In both calendar views, dates with entries have a slightly darker background and the day number bolded
(see below). You can see the first line of the entry (or entries) on a date by moving the mouse over that
date.

Reminders for a date are displayed with their calendar charm and the time, if applicable. You can see
the full name and time of the reminder by moving the mouse over the reminder.

If you click on a date, you will see a list of all the reminders for that date and summaries of the entry or
entries on that date. Entries with photos in them will have those photos reduced to thumbnails. You can
click-and-drag to select multiple, consecutive dates.

Month Calendar

Year Calendar
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5.3.2 Loose-leaf Categories

Loose-leaf categories are often called "notebook" categories because of the default "Notebook" loose-
leaf category that is created for new users of The Journal.

Entries in a loose-leaf category are not tied to a specific date (as they are in calendar categories).
Instead,  entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf
notebook.

Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, ...). Arrange your
entries by clicking on the entry in the tree "dragging" it where you want it. You can move entries to be
"in front of" other entries (hover the mouse over the entry icon) or a "child of" other entries (hover the
mouse over the name of the entry). The mouse cursor will display differently based on the action that will
be taken.

5.3.3 Shared Categories

Categories can be "shared" between users within a Journal Volume.

A shared category can be accessed by each user that links to it (and provides the optional sharing
password). All entries in the shared category are available.

Categories can be shared as either "read only" or "full access". A read only shared category allows all
entries in the category to be read, but those entries can only be updated by the user that owns the
category. The entries in a full access shared category, on the other hand, are treated just like any other
entries. They can be read, edited, deleted, or even re-arranged (in loose-leaf categories).

To see the available shared categories, click on the Category menu and choose "Shared
Categories..."

See Category Options: Sharing for more information.
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5.3.4 Merging Categories

Click on the Category menu and choose "Merge Categories..."

This form allows you to merge two or more categories into a single category.

You can merge:
Loose-leaf categories into other loose-leaf categories.
Loose-leaf categories into calendar categories.
Calendar categories into other calendar categories.

You cannot merge a calendar category into a loose-leaf category (do it the other way).

You cannot merge into a read-only category.

NOTE: This operation cannot be undone. If you change your mind, you will have to restore the category
or categories from a previous backup.

Merge these categories

Select the category or categories you want to merge from. Hold down the CTRL key when you click on a
category so you can select more than one.

Delete categories after merging

Check this option to delete the categories once they've been merged.

Into this category

Select the category you want to merge into.

5.3.5 Packages

Packages are collections of categories that can be installed into The Journal.

E-books, articles, templates, and more can be added to The Journal with packages. Once a package is
installed, the categories in the package are available as shared categories.

Some packages may create new categories for you automatically. For example, the MemoryGrabber
package for The Journal creates a "My MemoryGrabber" category for you to fill out. The questions and
prompts for the different parts of your life are typed in, so all you have to do is type in the answers to
quickly and easily create your memoirs.

To view the packages you have installed, click on the Category menu and choose "Packages..."

Packages Available

This is the list of packages that have are available but have not yet been fully installed.
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Packages I am Using

This is the list of packages that you have fully installed.

Button: >>

Select a package under "Packages Available" and click on this button to finish installing the package.
The install process usually will create one or more new categories with the content of the package.

Button: <<

Select a package under "Packages I am Using" and click this button to stop using it. Those package
categories that can be will be removed. Some of the categories you might have to delete yourself using 
Category Properties...

Uninstall Package

This button removes the selected package from The Journal.

5.3.6 Category Properties

Categories in The Journal are highly configurable.

You can see these options by right-clicking on the category tab (or clicking on the Category menu) and
choosing "Category Properties..." Then bring up the "Calendar" tab.

General
Calendar
Entry
Entry Text Style
Security
Sharing

New Category

New calendar and loose-leaf categories can be created with this button. Options such as the category
name, the frequency with which the category will create entries (for calendar categories) and if the newly
created category should be a sub-category of an existing category can be chosen here.

Delete Category

When you click Delete, the highlighted category in the category tree will be deleted. You will be asked
to confirm this deletion before it actually takes place.

WARNING: This operation cannot be undone (if you make a mistake, you will have to restore the
category from a previous backup).
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5.3.6.1 Category Properties: General

These options are available to all category types.

Category Name (Displayed on Tab)

This is the name of the category. The name of the category can be changed at any time.

Category Active (Tab Visible)

If this option is un-checked, no tab shows up for the category because it is considered "inactive". Use
this option to "hide" categories that are no longer as active as they were. Should you need to access the
entries in the category, it's a quick and simple matter to make the tab visible again.

Category is a Folder Only

This option is only available for categories that have sub-categories. By default, a Master Category
presents itself as a sub-category of itself. By setting the category as "Folder Only", though, this doesn't
happen.

Any category with sub-categories can be designated as a "folder only" category. These categories are
used to help you organize your categories and sub-categories.

NOTE: If a folder only category has entries, those entries aren't displayed. To access those entries, you
would need to un-check this option.

Show calendar

If checked, the category's calendar is visible. For calendar categories, this option defaults to On. For
loose-leaf categories, this option defaults to Off.

Show entry tree

This option displays the category's "entry tree". This option is On by default for all category types.

Show day planner with active reminders

When this option is checked your active reminders for Tasks, Events, Appointments and Special Days
will displayed in the day planner above the entry editor.

You can choose to show reminders for the current day, the current week, or for the next 2 to 7 days.

Only show if there are active reminders

When this option is checked the day planner will only display when there are active reminders.
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Category sort order

The sort order option controls in what order the category tabs are displayed.

You can also click and drag categories in the list to re-arrange them.

5.3.6.2 Category Properties: Calendar

These options are only available to calendar categories.

Create a New Entry Every ...

A calendar category can automatically create a new entry for you every:
hour
2 hours
3 hours
4 hours
6 hours
8 hours
12 hours
day
week (on a particular weekday)
month (on a particular day: 1-31)
year
decade
century

Include time (or date) in entry

In addition, the entry can include a time stamp (for hourly, daily, and weekly calendar categories), the
day (for monthly categories), the month (for yearly categories), and the year (for decade categories). If
this option is checked, the default stamp will be the current time and/or date, but you can choose any
time and/or date.

NOTE: The Journal doesn't save blank entries.

In any type of calendar category, you can also create a new entry at any time by pressing F9 (Entry
menu, Create New Entry sub-menu, and choose Create New Entry).

Display calendar folders for ...

Each type of calendar category (hourly, daily, etc) has a default set of "calendar folders" it displays in
the entry tree. You can customize which folders are displayed with this option.

For example, if "Years" is checked, in the tree to the left of the entry editor you will see the years that
you have created entries.

Actual entries are always displayed.

Display full entry date and time in tree
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If checked (the default), in hourly, daily, weekly, and monthly categories:
If the display month folder (see above) is un-checked, the 2-digit month for the entry will be displayed
along with the 2-digit day.

Example:

If the display year folder is un-checked, the 4-digit year for the entry is displayed.

Example:

If un-checked, the above examples would look like this:

Display day of week for daily entries in tree

If checked, daily entries will display the abbreviated day of the week (Sun-Sat) in addition to the day of
the month.

Example:

Display first line of entry in entry tree

If checked (the default), the first line of your entry is displayed in the entry tree (up to 40 characters).
You can see this by hovering your mouse cursor over the entry in the tree.

Display actual date/time entry created

If checked, the actual date and time the entry was created is displayed in the entry tree and other
places (like printouts). This option defaults to Off.

Mark past entries read-only
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If checked, then past entries of the category are read-only by default.

This setting can be overridden at any time to make changes to a particular entry. Just select the entry,
and press F4 (or click on the Entry menu and choose "Edit Entry").

Even if this option is not checked, you can make particular past entries read-only.Just select the entry,
and press F4 (or click on the Entry menu and choose "Edit Entry"). "Read Only" will display in the
status bar below the entry editor to show that this entry has been locked.

5.3.6.3 Category Properties: Entry

These options are available to all category types.

Default Entry Template

The selected template will be inserted into new entries. For calendar categories, this template will be
inserted into new entries for the current day (or week or whatever). For loose-leaf categories, the
template will be inserted into all newly created entries.

Entry Type

This setting determines the default entry type of the category, and what kind of entry newly created
entries will be. In loose-leaf categories, this setting can be overridden to create an entry of any type.

Normal Document Entry

Document entries are formatted text documents, much like word processor files. Document entries can
have images, movies and other types of files inserted into them. It is recommended that calendar
categories use document entries.

See Document Entries for more information.

External Object Entry

External object entries are essentially Windows data files stored in (or linked from) The Journal.

See External Object Entries for more information.

Image Entry

Image entries are graphic files (BMP, JPG, etc).

See Image Entries for more information.

Document Entry Options

These settings control document entries within the category.

Use WYSIWYG formatting

If checked, the category's entries are displayed WYSIWYG ("what you see is what you get"). That is,
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the entries are displayed exactly as they would print to the active printer.

Edit Page Setup, Header, Footer

Use these settings to override the page setup, header, and footer created in User Preferences: Printing.

Default Page Setup, Page Header, Page Footer, and Entry Header

Use this setting to restore the page setup, page header, page footer, and entry header created in User
Preferences: Printing.

Save entry editor state between sessions

If checked, the position of the caret, including the selection of any text, and the scroll position of the
entry editor is preserved for the entry. The next time you bring up the entry--even if you've closed The
Journal and restarted--you will be exactly where you were.

For calendar categories, this option defaults to Off. For loose-leaf categories, this option defaults to On.

5.3.6.4 Category Properties: Entry Text Style

These options are available to all category types.

Entry Background Color

This is the default color used for the background of document entries.

Entry Background Image

This is the default background image used for entries in this category.

Edit Font and Text Settings

Every category can specify its own "default style" that defines the category's default font. If no default
style is given, then the default style setting from User Preferences: Styles is used.

See Styles for more information.

Default Settings

This button restores the background color and default style to those set in User Preferences: Styles.

5.3.6.5 Category Properties: Security

These options are available to all category types.

Category Entries are Read Only (and no new entries)

When checked, this category and its entries cannot be edited or deleted. Also, no new entries can be
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created.

Category Password

If you want this category to have a password, enter it here. You will need to enter the password again in
the "Confirm Password" field.

If the category already has a password, you will need to enter the existing password to change it or to
clear it.

Only Verify Password Once per Session

If checked, you will only need to enter the category's password once per journaling session. A "session"
starts any time The Journal prompts you for your user name password.

If this option is not checked, you will have to enter the password every time the category is selected.

5.3.6.6 Category Properties: Sharing

These options are available to all category types.

Lock Entries on Edit

If you are using The Journal over a network and/or sharing categories between users, and there is a
possibility that multiple users will be accessing and updating the entries of this category at the same
time, you will want to have this option checked. When a user edits an entry, that entry will be locked,
preventing other users from editing the entry at the same time.

Prompt for Lock Message

When "Prompt for Lock Message" is checked, all entries in the category are "Read Only" by default,
and you must use Entry | Edit Entry (hot-key: F4) and enter a lock message. This lock message is
displayed to any other users who attempt to edit the entry. Use this option along with "Lock Entries on
Edit" to further coordinate your editing with other users.

Category is Shared

If checked, this option allows other users within the Journal Volume to link to this category and access
its entries.

Read Only?

This option is only available if the category is shared. If checked, then other users can only read the
entries in the category. They cannot edit, delete, or re-arranged the entries in any way.

Category Share Password

If you want this category to have a share password, enter it here. You will need to enter the password
again in the "Confirm Password" field.
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If the category already has a share password, you will need to enter the existing password to change it
or to clear it.

The share password must be entered correctly by other users to link to the shared category.

Note that the share password is different from the category password described in Category Properties:
Security.

See Shared Categories for more information.

5.4 Database Maintenance

The Journal's entry database has proven very stable over the years, but it is always a good idea to make
regular backups.

The Journal automatically prompts you to make a backup about twice a week (every 3 days). If you
would like to backup more or less frequently, you can set this using the Backup Settings.

See Backup/Restore for more information.

Database Maintenance FAQ
How do I backup The Journal?
How do I restore from a backup?
How do I see what is in my backup file?

5.4.1 Backup/Restore

The various Journal Volumes and The Journal's System Database should be backed up regularly. For
more protection, it is recommended that you copy your backup file(s) to another computer or another
location.

To backup The Journal, you have to login normally.

Backups can be made to any valid drive or folder on your PC, even network drives or external hard drives
connected by a USB.

Further, once the backup is completed, The Journal can automatically copy the backup file to separate
locations--even upload the backup file to an offsite FTP server.

It is possible to restore from a backup made with any previous version of The Journal since The Journal
2. (Restoring from a backup of The Journal 1.x, though, requires special instructions. Email DavidRM
Software.)

How do I backup The Journal?
How do I restore from a backup?
How do I see what is in my backup file?

5.4.2 Backup Settings

Backup options can be set through the File menu, Maintanance sub-menu, and then selecting "
Backup Settings..." These Backup Settings are also available from the User menu by selecting "User

mailto:support@davidrm.com
mailto:support@davidrm.com
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Preferences...", and then bringing up the "Backup/Restore" tab.

See User Preferences: Backup/Restore for the available backup settings.

5.4.3 Restore

To restore from a backup, click on the File menu, Maintenance sub-menu, and choose "Restore from
Backup..."

Backup Archive

This is the name of the backup archive (*.jbackup).

You can restore from a backup made by a previous version of The Journal (*.JBU or *.001). In this case,
a Journal Volume must be created especially for the restore and upgrade.

Backup Contents

This will list the Journal Volume that have been backed up into this archive, including the date of the
backup.

Restore Journal Volume

This command will restore the selected Journal Volume. Unless you pick an earlier date, the restore will
automatically use the most recent backup of the Journal Volume.

Create Journal Volume

This command allows you to create a new Journal Volume. If you do not want to restore into an existing
Journal Volume, you will need to create a new Journal Volume before starting the restore process.

See also How do I restore from a backup?

5.4.4 Repair The Journal Databases

To repair The Journal's various Journal Volumes and/or the System Database, bring up the Journal
menu, the Maintenance sub-menu, and choose Repair The Journal Databases...

The repair process analyzes The Journal's database tables, correcting any problems that may have
appeared due to system shutdown issues or Windows crashes. The repair process also optimizes the
tables and minimizes the amount of disk space required for all database tables.

In general, The Journal's database tables are quite stable. It is unlikely you will need to use the repair
process more than once or twice per year.

Repair Journal Volumes
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This button repairs all Journal Volumes.

Repair System Database

This button repairs The Journal's System Database.

5.4.5 Clean Journal Volume folder

Click on the File menu, Maintenance sub-menu, and choose "Clean Journal Volume folder..."

This command removes all unnecessary or extraneous files from the folder of the current Journal Volume
.

The files deleted include:
*.Old - created by certain database updates.
All files left over from upgrading the Journal Volume from The Journal 4 or earlier.

5.5 Entries

Entries, organized by category, are the core of The Journal. Entries can be text "documents", external
objects, or images.

Most categories use document entries, which can include images and other types of files, though any
entry type can be set as the default for the category.

Document Entries
External Object Entries
Image Entries

Entries FAQ
How can I import my entries from another diary or journal program?
How do I insert images in my entries?
Can I insert digital photos in my entries?
How can I use tables in my entries?
How do I make my tables look like those in MS Word/WordPerfect/Etc?
How do I use topics in my entries?
How do I lock my entries so they can't be edited?
How do I post my entries to a blog?
How do I use templates in my entries?
How do I have a template automatically inserted in my entries?
How can I create my own templates?
Why can't I edit my past entries?
How do I create loose-leaf entries in my calendar category?

5.5.1 Document Entries

Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any Windows font (TrueType, Type-1, etc) installed on your PC can be used to
format the text.

Document entries can also include images (digital photos, clip art, calendar charms, etc.), media files
(audio and video), and even external objects like spreadsheets.
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How do I insert images in my entries?
Can I insert digital photos in my entries?
How can I use tables in my entries?

5.5.2 External Object Entries

External object entries are essentially Windows data files stored in (or linked from) The Journal. If
possible, The Journal will use the standard icon for the file when displaying the entry in the date or entry
tree.

Double-clicking an external object entry will open the entry using the associated Windows application. If
possible, the application will be "hosted" inside The Journal.

External object entries can be "linked" to a file. When linked, the file is not stored inside The Journal.

External objects cannot be printed by The Journal. Instead, you will need to use the default application
for that external object to print it.

Loose-leaf entries can easily be dragged and attached as a sub-entry to any other entry, even a calendar
entry.

5.5.3 Image Entries

Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.

Images can be bigger than the visible region of the screen. Clicking and dragging will scroll the image.
The image can also be scaled using the "wheel" on your mouse.

Image entries are much more space efficient than embedding images in document entries because they
store the image in its native format.

When printing image entries, the image is scaled to fit the page.

NOTE: Image entries are included for backwards compatibility with earlier versions of The Journal. For
most users, document entries provide a more flexible and powerful way to organize images in The
Journal.

5.5.4 Create New Calendar Entries

In a calendar category, click on the Entry menu, Create New Entry sub-menu, Document Entry (hot-
key: F9).

How this form works depends on the type of calendar category.

Daily

You choose the day, and (optionally) the time of the entry.

Hourly

You choose the date and the hour. You can optionally set the minutes of the entry.
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Weekly

You choose the week, and (optionally) the day of the entry.

Monthly

You choose the month, and (optionally) the day of the entry.

Yearly

You choose the year, and (optionally) the month of the entry.

Decade

You choose the decade, and (optionally) the year of the entry.

Century

You choose the century, and (optionally) the decade of the entry.

5.5.5 Saving Entries

The Journal saves your entries in your Journal Volume, which is a database.

If you want to save your entries in a format that can be accessed by other software (like a word
processor), you have a couple of options:

"Save Entry As..." (on the File menu; hot-key: F12)
"Export Entries..." (on the File menu, Export sub-menu)

Save Entry As...

The "Save Entry As..." command saves the currently active entry to your hard drive.

You can choose to save the entry in a variety of formats:
Rich Text Format (.rtf) - All the text of the entry is saved, with full formatting (font, bold, etc).
Inserted images and objects are saved into the file. Rich text files can be opened by MS Word,
WordPerfect, and almost any other Windows word processor. This is the default format.
Plain Text (.txt) - All the text of the entry is saved, but without formatting. Inserted images and
objects are not saved.
HTML (.html) - All the text of the entry is saved, with full formatting (font, bold, etc). Inserted images
and objects are saved in separate files.

Export Entries
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Use the "Export Entries" command to save one or more entries to your hard drive.

You can select any number or entries (even entire categories) and save them to the same variety of file
formats described above. You can also save the entries in one, large file, or save each entry in its own
file.

For more information, see these topics:
Export Entries
Export Options

5.5.6 Search Entries

Beyond searching for a word or phrase in a single entry, The Journal supports queries that can span all
categories and entries. Plus you can search for text (word, phrase, collection of words), and you can
search for topics.

NOTE: Searching is currently limited to document entries and reminder notes.

Once the search is begun, it continues until all entries in the selected categories have been searched.
The search can be stopped at any time, or it can be allowed to continue while you browse the entries it
has found so far.

Search Text

Enter the word, words, or phrase you want to search for here. Words in quotes "like this" are treated as
a single word.

Queries are not case-sensitive, so don't worry about uppercase and lowercase.

Text Search Options
Search for entire phrase - The search text is taken as a single phrase. The entire phrase must be
matched for the search to find anything.
Search for entries with any of the words (OR) - The search text is a collection of words (or quoted
phrases). If an entry contains any of these words, it will be listed. A "Match %" will be displayed,
indicating what percentage of the searched-for words are present in the entry.
Search for entries with all of the words (AND) - The search text is a collection of words (or quoted
phrases). An entry must contain all of the words to be listed as a match. The words don't have to be in
any particular order in the entry to match.

Where to Search
Match whole words only - A word must be matched in full (no sub matches).
Search entry text - Look for the word(s) in the text of the entry (a normal search).
Search entry names - Look for the word(s) in the names of entries.
Search image/media/object descriptions - Look for the word(s) in the descriptions of images and
objects.
Search reminder names and notes - Look for the word(s) in the names and notes of reminders.

By default, the search will look in the entry text, entry names, image/media/object descriptions, and
reminder names and notes. Turn off one or more of these to narrow the scope of the search (for example:
to search only in image descriptions).
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Search Topics

Select the topic(s) you want to search for.

The topics you have used at least once in an entry are listed first, in alphabetical order. All other topics
are listed in alphabetical order following the ones you have used.

Topic Search Options
Search for entries with any of the topics (OR) - If an entry contains any of the selected topics, it
will be listed.
Search for entries with all of the topics (AND) - Only if an entry has all of the selected topics will it
be listed.
Display only topic text in search results - In the Search Results, when viewing an entry (or all
entries), only those parts of the entry tagged with the selected topic(s) will be displayed.
Include sub-topics in search results - If an entry has a sub-topic of a selected topic, the entry will
be included in the search results.

Search Categories

You can limit the number of categories searched. By default, the search looks in all categories.

Search this date range only (for calendar categories)
Check this option to limit the search to calendar categories (like "Daily Journal"), and to further limit the
search to the specified date range.

Search recent entries first (for calendar categories)
Check this option to search from the most recent entries to the least recent entries.

Search active category only
Check this option to look only in the active category.

Search all categories
Uncheck this option to limit your search to the categories you select

5.5.7 Search Results

This form is brought up when a search is begun.

Once the search is begun, it continues until all entries in the selected categories have been searched.
The search can be stopped at any time (click "Stop Search"), or it can be allowed to continue while
you browse the entries it has found so far.

Unless you specifically "Close" the Search Results form, or "Stop Search", the search will continue.

Found entries are displayed in a manner much like that used by search engines on the Web:

Daily Journal - Wednesday, September 08, 2004
... some search text here ...  

The first line is an entry link. Clicking on the entry brings up the content of that entry, with the search
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text (or search topics) highlighted.

The next line shows one example of the search text found, with some context both before and after.

If the Search Results form is ever hidden from view, you can bring it back by choosing Search Entries
on the Search menu, or by pressing the hot-key: Shift+Ctrl+F

Stop Search

Stops the current search (if it hasn't already completed).

New Search

Stops the current search and brings up the Search Entries form again.

Results per Page

You can set the number of results shown per page, from 1 to 100.

Print/Print Preview

Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.

Insert Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.

Hide Highlight

This command toggles the highlighting of search terms. This can be useful when printing the search
results, or saving them to a file.

Save to File

Click on this command to save the search results to a file on your computer.
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Next Search Term

Click on this button (or press the hot-key F3) to move forward through the entry, highlighting each of the
search terms in turn. When you reach the end of the entry, Next Search Term will loop back to the
beginning.

5.5.8 Daily/Weekly Entry Report

Use the Daily/Weekly Entry Report to collect all of the entries made in a given date range: a day, a
week, a month, a year, or any range at all.

NOTE: This report is for calendar categories (like Daily Journal) only.

Example:
You have a project-specific calendar category called "Project Notes" where you track your daily
progress, meeting notes, and so on. On Monday, you want to print out a report of what you did the
previous week. So you:
1. Bring up the "Project Notes" category tab.
2. Click on the Tools menu, choosing Daily/Weekly Entry Report...
3. Select Last Week.
4. Click on See Report.

All of last week's entries in "Project Notes" are now compiled in proper order. You can review them and
then print the report.

Show all Entries from:

There are 6 pre-set date ranges you can use: Today, Yesterday, This Week, Last Week, This Month,
and Last Month. You can also choose to Show All Entries.

If you need a specific date range, click on This Date Range and set the From and To dates
appropriately.

Look In:

You can have the report created from the Active Category or All Calendar Categories. Or you can
choose These Categories and select the specific categories to look in.

5.5.9 New/Updated Entry Report

Use this report to see all of the entries that were created or modified in a given date range: a day, a
week, a month, a year, or any range at all.

Look for:

Newly created entries - Entries that were first created within the date range.

Edited/updated entries - Entries that were edited or otherwise updated within the date range.

Show body of entry in report - If checked, the body of the entries is included in the report. If it is not
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checked (the default), only the entry headers are displayed. You can click on the entry headers in the
report to see the full entry.

Show entries created/updated from:

There are 6 pre-set date ranges you can use: Today, Yesterday, This Week, Last Week, This Month,
and Last Month.

If you need a specific date range, click on This Date Range and set the From and To dates
appropriately.

Look In:

You can have the report created from the Active Category or All Calendar Categories. Or you can
choose These Categories and select the specific categories to look in.

5.5.10 Entry Report Results

When the Daily/Weekly Entry Report or the New/Updated Entry Report collects all of the appropriate
entries, it uses this form to display the results.

The entries are sorted by category, and then by entry date (for calendar entries) or by sort order (for
loose-leaf entries). The category name is displayed before the first entry from that category, and the
entry name is displayed before each entry.

New Report

Discards the current report and brings up the report form again, so you can create another report.

Print/Print Preview

Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.

Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.

Save to File



The Journal100

© 1996-2011 by David Michael

Click on this command to save the report to a file on your computer.

See also:
Daily/Weekly Entry Report
New/Updated Entry Report

5.5.11 Delete Entries

Entries can be deleted either one at a time from the category's "entry tree", or in batches using the 
Delete Entries... command on the Entry menu.

Once an entry has been deleted, it cannot be recovered (except by restoring from a backup).

5.6 Export/Import

The Journal supports the export and import of entries via several formats.

Supported Export Formats
Text Files (.TXT)
Rich Text Files (.RTF)
HTML Files (.HTM)
XML Files (.XML)
Journal Export Files (.JNX)

Text files are simply text, such as files made with Windows Notepad. The only formatting in text files is
marking end of lines with carriage returns.

Rich Text files, also called RTF files, contain full text formatting information. Font, paragraph alignment,
colors, and so on, are all preserved. RTF files can be read by most Windows word processors.

HTML files are text files with "hypertext markup language" tags embedded. These tags control
formatting of the file when it displayed with a web browser, such as Internet Explorer. HTML files are only
supported when exporting.

XML is also a text format, so you can edit it in every ANSI text editors (for example Notepad). The
Journal has its own set of XML tags, but you can browse XML documents exported from The Journal in
every XML-compatibile Web Browser.

Journal Export (JNX) files provide a way to transfer categories and entries, with all formatting in the
entries, as well as other category and entry information, between different installations of The Journal.

Export/Import FAQ
How can I import my entries from another diary or journal program?

5.6.1 Export Entries

The Journal supports a number of exporting options. You can export a single entry, an entire category,
or a collection of entries from multiple categories.

Click on the File menu, Export sub-menu, and choose "Export Entries..."
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Select Categories/Entries to Export

Active Entry

Only the active entry will be exported.

Current Day (in all Calendar Categories)

The entry for the current date in all calendar categories will be exported. No loose-leaf entries will be
exported with this option.

These Categories/Entries

Whichever categories or entries you select will be exported. Entire categories can be selected for
exporting, or groups of entries spanning several categories.

Select Export Format

Rich Text (.RTF) - Rich Text, or RTF, files include all text formatting and embedded images/objects.
RTF files can be read by nearly all Windows word processors.

Plain Text (.TXT) - Entries exported to plain text files are stripped of all formatting except line-breaks.
TXT files can be read by any text editor and all word processors.

HTML (.HTM) - HTML is the standard format of the World Wide Web. They can be edited by any text
editor, most Windows word processors, and, or course, they can be displayed with any Web browser.
Most text formatting is preserved, though not all. Embedded images are extracted to JPG files and
linked from the exported .HTM file.

XML (.XML) - XML is also a text format, so you can edit it in every ANSI text editors (for example
Notepad). The Journal has its own set of XML tags, but you can browse XML documents exported from
The Journal in every XML-compatibile Web Browser.

Journal Export Format (.JNX) - The Journal Export Format is a proprietary format used only by The
Journal. It preserves not only all text formatting, but it also preserves all category and entry settings. JNX
files are used primarily to transfer entries from one copy of The Journal to another.

NOTE: JNX export files created by The Journal 5 cannot be imported into earlier versions of The Journal.
JNX files created by earlier versions of The Journal can be imported into The Journal 5, however.

See User Preferences: Export for more information.

5.6.2 Importing

Click on the File menu, Import sub-menu, and choose "Import Entries..."

Text files (.TXT), rich text files (.RTF), HTML files (.HTM;.HTML;.SHTML), and Journal Export files (.JNX)
can be imported into The Journal.
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Text files, rich text files, and HTML files are imported into the currently selected entry. The imported file
is always appended to the existing entry. Only a single file can be imported at a time.

XML files can only be imported if they were originally exported by The Journal.

JNX files offer many more importing options. Entire categories can be imported, with all entries, or single
entries can be selected and imported into any existing category (of the same type).

NOTE: JNX export files created by The Journal 5 cannot be imported into earlier versions of The Journal.
JNX files created by earlier versions of The Journal can be imported into The Journal 5, however.

When importing entries, it is possible to only import those entries that are newer. This provides a simple
mechanism for synchronizing entries between installs of The Journal.

To import multiple files at once, see Batch Entry Import.

See User Preferences: Import for more information.

5.6.3 Import Entries

Click on the File menu, Import sub-menu, and choose "Import Entries..."

Browse to select a JNX (Journal Export) file to import.

Select Categories/Entries to Import

Check a category to import that category and all of its entries, including any sub-categories.

You can also select one or more specific entries to import.

Import Selected

When clicked, all selected (checked) categories and/or entries will be imported.

Import All

When clicked, all categories and entries will be imported.

Import New

When clicked, all categories and entries will be imported, but only if the entries in the JNX file are newer
(modified more recently) than the entries currently in the Journal Volume.

Options...

When clicked, this allows you to view or edit your current import options.
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5.6.4 Importing Entries from Other Journal Software

Many people, myself included, have kept their personal journals using other software.

There are a couple of ways of importing these previously existing entries. Which method to use depends
on your circumstances: which software was used, how the entries are saved, etc.

Batch Export/Batch Import

The most convenient method is to use the other software's export capability and The Journal's import
features.

1. Create a temporary folder on your hard drive.

2. Export your entries from the other software into individual text (.txt), rich text (.rtf), or HTML (.htm;.
html) files. Export to the temporary folder you created in #1. If the entries are for a particular day, make
sure the date is used in the name of the exported file. The best date format will use a 4-digit year, a 2-
digit month, and a 2-digit day.

Example:
1993-10-05.rtf (entry for 5 October, 1993)

3. Once you have the entries exported, start The Journal. On the File menu, Import sub-menu, choose
"Batch Entry Import..." to import the entries into The Journal.

4. Choose the category you want to import the entries into (like "Daily Journal").

5. Browse to the temporary folder where your exported entries are.

6. Set the "Specify Date Format" to match how the export named your entries.

Example:
yyyy-mm-dd.rtf

Then do the import.

See Batch Entry Import for more information.

Copy-and-Paste Method

If the software you were using does not support exporting files, but was a Windows program, then this
method will work. It's not the most efficient method, but it's the same way yours truly (the author)
"imported" 3 years of entries made in Microsoft Word documents (one document per month).

1. Launch both the original software and The Journal.

2. In The Journal, select the Category to receive the imported text. Then use the calendar and choose
the appropriate entry date, or create the new entry.

3. Use the Windows Taskbar (or Alt-Tab) to bring up the original software.
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4. Select the text in the original software that you wish to import into The Journal, and then copy the text
to the Windows clipboard (Edit | Copy).

5. Use the Windows Taskbar (or Alt-Tab) to bring up The Journal and paste the text in the active entry
(Edit | Paste or Ctrl-V).

6. Repeat until all of the desired entries from the old software have been entered into The Journal.

5.6.5 Batch Entry Import

Many journal software products support exporting your entries in that software to a collection of text (*.
TXT), rich text (*.RTF), or HTML (*.HTML) files. With the Batch Entry Import form (on the File menu,
Import sub-menu), you can import those files directly into The Journal.

Importing into a Calendar Category

To be imported into a calendar category, the entry files must all use a standard naming convention. The
date of the entry must be included in the file name. The best date format will use a 4-digit year, a 2-digit
month, and a 2-digit day.

If the entries you are importing have a timestamp, that should be specified, as well. Use the 24-hour
clock for the time stamp, 2-digit hour (00-23), a 2-digit minute (00-59), and (optionally) a 2-digit seconds
(00-59).

Example:
2001-05-01.RTF (entry for 1 May, 2001)

This would need a format of: YYYY-MM-DD

Example with a timestamp:
2007-08-16 16-24-00.RTF

This would need a format of: YYYY-MM-DD HH-NN-SS

NOTE: Dashes (-) were used instead of colons (:) in the timestamp, because colons aren't valid in file
names.

You can also import files with long (December) and short (Dec) month names in the name.

Example with long month names:
2006 October 26.RTF

To import those files, you would need to set the date format to: YYYY MMMM DD

MMMM = long month name
MMM = short month name

Importing into a Loose-Leaf Category

When importing into a loose-leaf category, no special naming convention is required. The name of the
imported entry file will be used as the name of the entry.
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Remove file extension from imported files - Check this option to remove the file extension when
naming the entries.

5.6.6 Synchronizing Journal Volumes

It is possible to keep entries across multiple Journal Volumes "in sync" using the export and import
features of The Journal.

Synchronizing a Category

The easiest way to handle synchronization is at the category level.

1. Using The Journal's export feature, create a JNX file containing the entire category (all entries).

1.a. On the Entry menu, choose "Export Entries..."

1.b. Click on "These Categories/Entries" in the entry tree displayed.

1.c. Click on the category to export. This automatically selects all entries in that category.

1.d. In the Select Export Format, choose "Journal Export Format (.JNX)".

1.e. Click on "Export" to create the export file.

2. To synchronize a category with the JNX file, make sure your import options are set to only import if
newer.

2.a. Click on the User menu and choose "User Preferences..."

2.b. Bring up the "Import" tab.

2.c. Check "Only Import if Newer".

2.d. Click on "Done".

3. Import all newer entries in the category.

3.a. Click on the Entry menu, choosing "Import Entries..."

3.b. Select the .JNX file to import.

3.c. Check the category to import.

3.d. Click on "Import New".

3.e. You may be prompted to choose the category to import into. If the category already exists, choose
that one. Otherwise, click on "Auto-Create".

4. To update the JNX file, export the category, overwriting the JNX file. Repeat the steps of #1 above.
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In a future version of The Journal, this will be an automated process.

Synchronizing a User

Use the "Synchronizing a Category" process outlined above for all categories.

A single JNX file can be used, but then you have to be careful not to overwrite the JNX file until after all
categories have been updated.

5.7 Images & Media

The Journal lets you include images of all sorts in your entries: digital photos, animated graphics, and
icons (like Calendar Charms). You can also set images as backgrounds for your entries, much like you
can with a Web page.

Beyond images, The Journal also lets you include audio and video files in your entries. Audio and video
files are called "media files".

Read more about using images in The Journal:

Using Images in Entries
Entry Background Images
Creating Your Own Borders
Calendar Charms
Creating Your Own Calendar Charms
Loading Images

Read more about using media files in The Journal:

Inserting Media Files into Entries
Playing Media Files

Inserting Objects into Entries

5.7.1 Using Images in Entries

Inserting Images

To insert images in your entries:

Click on this icon on the toolbar:

 
Or click on the Insert menu, and choose "Insert Image..."

You can also drag images from Windows Explorer and drop them into your entry.

Resizing Images
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When you first insert an image into your entry, the image is resized to fit the entry editor. Click and drag
on the edges of the image to resize it.

If you would prefer to view the image at full size, right-click the image and choose Toggle Image Full/
Fit Window.

You can also double-click the image to toggle full size and back.

Image Descriptions

Images can be given descriptions. These descriptions are displayed when you hover the mouse over the
image. Also, you can do searches of image descriptions.

To give an image a description, or to edit an image's description:

1. Click on the image to select it.

2. Click on the Edit menu, and choose Edit Image/Object Description (hot-key: Ctrl+Shift+D).

Searching Image Descriptions

To search through the descriptions of all images in The Journal:

1. Click on the Search menu, and choose Search Entries... (hot-key: Ctrl+Shift+F)

2. Enter the word or words you want to search for in Text to Search for.

3. Un-check: Search entry text, Search entry names and Search reminder names and notes (this
will force the search to look only in image descriptions).

4. Click on Search.

5.7.2 Entry Background Images

There are two primary types of entry background image: borders and backgrounds.

Borders are graphics that run along the borders (left, top, right, and/or bottom) of the entry editor.
Example:
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Backgrounds are visible behind the whole entry, not just along the borders. Example:

Setting the Entry Background Image

To set the background of the current entry: Click on the Format menu, find the Background Image
sub-menu, and choose the background you want to use.

You can also set the entry background image to:
Default - use the background image specified by the category (in Category Properties on the Entry
Text Style tab), or the global setting (in User Preferences on the Editor tab).
No Background Image - forces the entry to have no background image. This overrides the category
and global settings.

The Journal includes a number of entry background images, but you are not limited to those. You can
create your own.

Creating Your Own Borders

5.7.3 Creating Your Own Borders

Borders are simple to create, especially if you limit your borders to the left hand side of the entry.

1. Select or create a small pattern that repeats itself vertically (like the daisy on green pattern above).

2. Extend the image to the right with solid white (or other color) to a width of at least 1500 pixels. If you
have a high-resolution display, you might want to extend to 2000 pixels or more.

3. Save the image to a JPEG (.JPG) or a PNG (.PNG) file. Both JPEG and PNG images are
compressed, so they take up a lot less space in The Journal's database.
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Loading Your Border Image

1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Background Image

4. Set the "Position" to: Tile

5. To make sure that the entry text doesn't overlap the border pattern, click on Margin Offsets...

6. Un-check: Equal Values

7. In Left enter the number of pixels wide the pattern is (the daisy pattern above sets the left margin to
30).

And that's all there is to it!

Once you have added the image, you can make it a default background in your categories (in Category
Properties on the Entry Text Style tab), or apply it to specific entries (Format menu, Background
Image sub-menu).

5.7.4 Creating Your Own Backgrounds

Creating your own backgrounds is at once simpler than borders and more complicated. Simpler because
if you use a digital photo then you don't have to worry about the image tiling (though you could still do
that), and more complicated because you have to make sure you can read text against the background.

Here are some hints for creating your own background images:

Open Space is Good - If you are using a digital photo, pick one that has a lot of open space in the
middle of the image. Pictures of the sky and ocean or simple textures like wood are good examples.
You can have palm trees or other objects along the left side and/or bottom to set the location and the
mood, but try to keep the middle clear.

Keep it Simple - Expanses of sky and water are very simple backgrounds, making it easy to read
text against them. If you really must have that brook bubbling over many-colored rocks, then:

Experiment with Masking - Most image handling software (free example: Paint.NET) will allow you

http://www.getpaint.net
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to mask or "washout" images making them seem dreamier or more cloud-like. This can make it much
easier to read text over those images. Or: 

Experiment with Font Colors - Maybe if you switch away from dark/black fonts to lighter/white fonts
you will be able to read text shown over the image.

Use JPEG Images - You can use either Windows Bitmap file (*.BMP), PNG images (*.PNG), or
JPEG compressed files (*.JPG) for your backgrounds. JPEG files are usually much more compact
(especially if you are using a digital photo), so you should choose that format when you can.
Fortunately, most digital cameras create JPEG files automatically.

Also, check out the many free stock image sources on the Web, including:
http://www.sxc.hu
http://www.photoxpress.com

Loading Your Background Image

1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Background Image

4. Set the "Position" to: Center

5. If you want to adjust the text margins, click on Margin Offsets...

6. Check: Equal Values

7. Set the offset you want from the edges of the entry editor (most of the time, you will use values from
10-50).

And that's all there is to it!

Once you have added the image, you can make it a default background in your categories (in Category
Properties on the Entry Text Style tab), or apply it to specific entries (Format menu, Background
Image sub-menu).

5.7.5 Calendar Charms

Calendar Charms are small icons that you can use to mark special entries. Mark good days, mark bad
days, mark appointments, mark holidays, and more.

Calendar Charms are displayed on the calendar, as well as in the "entry tree". Every entry can be
marked with a Calendar Charm, in calendar categories and even in loose-leaf categories.

Calendar Charms can also be inserted into your entries as you type much like emoticons (or very small
clip art).

Setting (or Changing) an Entry's Calendar Charm

http://www.sxc.hu
http://www.photoxpress.com
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Menu: Entry | Entry Calendar Charm
Hot-key: Ctrl+F2

Removing an Entry's Calendar Charm

To remove the Calendar Charm from an entry, do this:

1. Bring up the Set Entry Calendar Charm form (Ctrl+F2).
2. Click on Clear.

Inserting a Calendar Charm in an Entry

Menu: Insert | Insert Calendar Charm
Hot-key: Shift+F2

5.7.6 Creating Your Own Calendar Charms

Calendar Charms can be single images, but are most often collections of small icons arranged in a grid.

Here are some tips for creating your own Calendar Charms:

Grid layout - Arrange the icons in a simple grid (don't actually include grid lines), with every icon the
same size.

Think small - If you want to use the icons on the calendar (instead of just inserting them into your
entries), it's best if you limit your icons to 16x16 pixels or 24x24 pixels. Larger icons will be reduced
to fit the calendar, and they may not look as good.

Transparency - Calendar Charms are assumed to be transparent. If you use the PNG image format,
you can use the alpha channel to create transparency (and other special effects like anti-aliasing). If
you use BMP or JPEG images (or PNG images with no alpha channel), the color at pixel position
(0,0) will be made transparent when the icon is inserted or used on the calendar. The best
transparency colors are very bright and obviously not part of the image (like fuchsia in the example
above).

Use PNG Images or BMP images - When you create your Calendar Charms, save them as PNG
images (*.PNG)  or Windows Bitmap files (*.BMP). This way your images (and your transparency)
remain crisp.

Loading Your Calendar Charms
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1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Calendar Charms

4. Set the "# of Charms Across (X)" to: (the number of icons across)

5. Set the "# of Charms Down (Y)" to: (the number of icons down)

And that's all there is to it!

When you go to set an entry's calendar charm (hot-key: Ctrl+F2) or insert a calendar charm in an entry
(hot-key: Shift+F2), drop down the list of Calendar Charm Collection and choose your new charms
from the list.

5.7.7 Inserting Media Files into Entries

You can insert most types of audio and video files into your entries:
audio - wma, wav, mp3, mid, midi, ra, ram
video - wmv, mpg, mpeg, avi, mov, rm

Inserting Media Files

Click on this icon on the toolbar:

Or click on the Insert menu, and choose "Insert Media File (Audio/Video)..."

You can also drag images from Windows Explorer and drop them into your entry.

An attached audio file shows this icon:

An attached video file shows this icon:

NOTE: Some media files are very large. Media files larger than 10 MB will cause your entries to load and
save slower. Media files larger than 50 MB may not perform well when stored in The Journal.

Also note: The Journal relies on Windows for media file playback. If you are using Windows XP, it's
possible that not all types of media file listed above will play.
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Playing Media Files

To play a media file, doubleclick on its icon. This will start The Journal's built-in media player.

5.7.8 Inserting Objects into Entries

Beyond images and media files, almost any kind of Windows file (like word processor documents,
spreadsheets, and more) can be inserted into an entry.

Click on the Insert menu and choose "Insert Object..."

Objects can be inserted as links to the files on your hard drive or network, or copied (embedded) into the
entry.

5.8 Journal Volumes

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Journal Volumes can be placed on any available hard drive, internal or external or network attached, or
even removable thumb drives. Each Journal Volume must have a unique name.

The Journal supports multiple Journal Volumes, each in a unique folder. However, most users of The
Journal will only need a single Journal Volume.

By default, The Journal places all Journal Volumes in:
My Documents\The Journal Volumes\5\

If you are installing The Journal on a USB/external hard drive, the default path is relative to the installed
path:
.\The Journal Volumes\5\

5.8.1 Journal Volume Properties

You can view or edit the properties of your Journal Volumes by clicking on the File menu, finding the
Journal Volume sub-menu, and choosing "Journal Volume Properties..."

General

Name - This is the name of the Journal Volume. This name is also the name of the folder where the
Journal Volume resides.

Auto-load when The Journal starts - If checked (the default), the Journal Volume is opened and
loaded when The Journal starts up. If this option is not checked, you can still open the Journal Volume
by clicking on the File menu, finding the Journal Volume sub-menu, and choosing "Open Journal
Volume..."

The path to the Journal Volume is displayed, as is the date of the last backup (if any).

Security



The Journal114

© 1996-2011 by David Michael

No new users can be created in Journal Volume - While this option is checked, no new users can
be created in this Journal Volume.

Journal Volume is Read Only - Check this option to make the entire Journal Volume "read only". This
prevents the creation of new users, new categories, and new entries.

5.8.2 Delete Users

To remove a user from the current Journal Volume, you must be able to provide the user's password. The
user and all of her categories and all of her entries in those categories will be deleted.

Deleting a User

1. Click on the File menu, find the Journal Volume sub-menu, and choose "Delete User(s)..."

2. Choose the user login name to delete.

3. Enter the user's password.

4. Click on Delete. You will be asked to confirm the delete one more time before it actually happens.

NOTE: Once deleted, a user CAN NOT be recovered (except by restoring from a backup).

5.8.3 The System Database

The Journal's System Database is separate from any Journal Volume.

The Journal's System Database stores the names and locations of all Journal Volumes, as well as
certain global options. The Journal recreates the system database when it needs to.

5.9 Links

The Journal supports hypertext-style links in document entries.

The easiest way to use links in The Journal is to click on this toolbar icon:

Or click on the Insert menu and choose Insert Link...

There are three types of link: entry links, file links, and Internet links. Entry links are links to another
entry in The Journal. File links are links to files on your PC, or on your local network. Internet links are
links to web pages or email addresses.

Similar to a web browser, The Journal allows links to have a "tag" that is displayed for the link. For
example, instead of displaying the entry link this way: entry:Daily Journal\\2008\12\07, the link could
have a tag such as "My Birthday Last Year".

The Journal supports both tagged and un-tagged links. Un-tagged links are usually typed in by hand. The
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Journal detects these and highlights them as you type. You can click on the link and it behaves
normally.

Bookmarks are supported for linking to a particular location in an entry.

5.9.1 Entry Links

Entry Links are special "hyperlinks" in The Journal to allow "jumping" to another entry.

Entry links can be "tagged" to hide the link information behind more descriptive text. Entry links can also
point to bookmarks within the entry.

Linking to an Entry

The easiest way to link to an entry is to click on this toolbar icon:

Or click on the Insert and choose Insert Link...

This will bring up the Insert Link form:

Then click on the "Select Entry" button: 

And select the entry you want to link to:

If an entry has bookmarks, those will be displayed beneath the entry in the tree.
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5.9.1.1 Typing Out Entry Links

You can also type out entry links by hand (instead of using Insert Link on the Insert menu).

Typing out Links to Calendar Entries

To do that requires using the following format:

entry:Category Name\\Entry\Date
or:
entry:Category Name\\*

Category Name - the name of the category where the entry is located. If Category Name is omitted,
then the entry is assumed to be in the current category.

Sub-categories should be clarified by listing their parent categories first, separated by a backslash ("\").
If no path is given, then the first category with the given name is used.

Entry\Date - the date of the entry. The default format for entry dates in links is: YYYY\MM\DD (note the
use of backslashes instead of slashes).

Example:
entry:Daily Journal\\2009\07\18

Alternate Entry Date Formats

If you do not use the above format, then the date must be in a system-recognizable format. For users in
the US, the standard MM/DD/YY (or YYYY) format works (note the use of the forward slash in this
case). For users in the Europe, however, the format would (usually) be DD/MM/YY (or YYYY).

The date must consist of two or three numbers, separated by the character defined as the "date
separator" in your Windows Locale (in the US that's the slash / [forward slash] by default). The order for
month, day, and year is determined by the by your Locale as well (US default is m/d/y).

If the date contains only two numbers, it is interpreted as a date (m/d or d/m) in the current year.

NOTE: These are Windows Locale settings, and not related to the date format used in The Journal for
inserting dates.

Example:
entry:Daily Journal\\4/9/2001

Current Entry Date - If an asterisk ( * ) is used in place of the entry date, then the entry link will jump to
the current entry date in the category.

Example:
entry:Daily Journal\\*

Typing out Links to Loose-leaf Entries

In a similar way, you can type in links to loose-leaf entries:
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entry:Category Name\\Entry Name
or
entry:Category Name\\Entry\Path

Category Name - same as above.

Entry Name - the name of the entry. The entry name is not case sensitive. If a loose-leaf category has
multiple entries with the same name, then the first matching entry is used.

Entry Path - the name of the entry, including the names of any "parents" of the entry, separated by a
backslash ( \ ). For example:

entry:Notebook\\Recipes\English Muffins

"Notebook" is a loose-leaf category. "Recipes" is an entry with a sub-entry named "English Muffins".

Default Entry Link - If an asterisk ( * ) is used in place of the entry name or path, then the entry link will
jump to the current default entry in the category.

Typing out Links to Loose-leaf Attachments of Calendar Entries

The format for entry links to loose-leaf attachments (sub-entries) of calendar entries is a bit more
involved:

entry:Category Name\\Entry Date\\Attachment Name
or even:
entry:Category Name\\Entry Date\\Attachment\Path

Seriously: Just use Insert Link... 

5.9.2 Bookmarks

Bookmarks in entries mark specific locations you can "jump" to, using the Go to Bookmark in Entry
command (on the Go menu) or with a link from another entry.

To insert a bookmark in an entry, click on the Insert menu and choose "Insert Bookmark..." You will

be prompted to give the bookmark a name. A gold star ( ) will mark the location of the bookmark in
your entry.

To remove a bookmark, right-click on the bookmark icon and choose Remove Bookmark (bookmark
name). Or set the cursor to the beginning of the line with the bookmark, then click on the Insert menu
and choose "Remove Bookmark".

Bookmarks can make it easier to work with long document entries. Insert bookmarks at frequently
accessed locations, then use Go to Bookmark in Entry (on the Go menu) to jump from bookmark to
bookmark.

Bookmarks can also be used as link destinations. Entry links default to the top of the entry. By
specifying a bookmark, though, you can link to any line within the entry itself.
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When WYSIWYG formatting is active, bookmarks are displayed as a dotted line across the page.

5.9.3 File Links

File links are links to files that on your PC or your local area network (LAN). When you click on a file
link, that file is opened.

The file link format is:
file://drive:\path\filename.ext

Examples:
file://C:\My Documents\Resume.DOC

If the file name or the path contains spaces, then you must use the Create/Edit Link form.

File links can be "tagged" to hide the link information behind more descriptive text.

5.9.4 Internet Links

Internet links are web page addresses, email addresses, and so on.

Supported Internet link formats are:
Web Pages (http://www.webpage.com, https://www.webpage.com, or www.webpage.com)
Email Addresses (mailto:davidrm@davidrm.com or davidrm@davidrm.com)

Also supported are FTP (ftp://), Gopher (gopher://), telnet (telnet://) and news (news://).

Internet links can be "tagged" to hide the link information behind more descriptive text.

5.9.5 Insert/Edit Link

The Insert/Edit Link form can be used for either entry links, file links, or Internet links.

The easiest way to create a link is to click on this toolbar icon:

Or click on the Insert and choose Insert Link...

This will bring up the Insert Link form:

Link

http://www.webpage.com
https://www.webpage.com
http://www.webpage.com
mailto:davidrm@davidrm.com
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This is the actual link information. For example:
entry:Daily Journal\\2009\07\18

Or:
http://www.davidrm.com

Link Tag

The link's "tag" is descriptive text that can be used to "hide" the actual link information. Only the tag is
visible, and clicking on the tag activates the link.

Using the examples above, valid tags would be:

Saturday, July 18, 2009

Or:

DavidRM Software Home Page

If no tag is specified, the link is inserted into the entry just as if it had been typed.

5.9.6 Typing out Links with Tags

You can type links that have a descriptive tag with this format:

[[link|tag]]

"link" can be either an entry link or an internet link. "tag" can be any single line of text (no ENTER).

After you type the closing ]], the typed out link will be converted to a tagged link.

Example:
[[http://www.davidrm.com/|DavidRM Software]]

5.10 Printing

The Journal supports a powerful collection of printing options. You can print a single entry, an entire
category, or a collection of entries from multiple categories.

NOTE: Only document entries and images can be printed by The Journal. External object entries cannot
be printed. You will need to use the native application of the external object to print it.

Select Categories/Entries to Print

Active Entry

Only the active entry will be printed.

Current Day (in all Calendar Categories)
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The entry for the current date in all calendar categories will be printed. No loose-leaf entries will be
printed with this.

Date Range (in all Calendar Categories)

Entries will be printed for the specified date range in all calendar categories. Entries will be printed in
category order, by date.

These Categories/Entries

Whichever categories or entries you select will be printed. Entire categories can be selected for printing,
or groups of entries spanning several categories.

See Printing Options and User Preferences: Printing for more information.

5.10.1 Printing Options

Page Breaks

Between Categories

If checked, a page break will be inserted after every category.

NOTE: If no pages breaks are to be inserted between categories, and there are multiple categories being
printed, then the page setups, headers, and footers for those categories will not be used. Instead the
page setup, header, and footer defined in User Preferences: Printing (if any) will be used.

Between Entries

If checked, a page break will be inserted after every entry.

NOTE: This option can result in a lot of paper being used. Use with caution.

Starting Page Number

By default, all printouts by The Journal begin with page number 1 (one). If you would like the printout to
begin with a different page number, you can specify that here.

Print Page Header

If checked, all pages will include the header for either the category or user (if one is specified).

Print Page Footer

If checked, all pages will include the footer for either the category or user (if one is specified).

Print Entry Header

If checked, all printed entries will be preceded by their entry name.
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The page header and footer and the entry header are specified in User Preferences: Printing, or Category
Properties: Entry Text Style.

Print Entry Index

If checked, then only the name of each entry is printed.

Force Text to Black & White

If checked, all text is converted to black and white.

Print Date Range

This option is only used when printing "Date Range (in all Calendar categories)". For each date in
the given from/to range, each category will have its entry for that date (if any) printed.

5.10.2 Printing Headers and Footers

Headers and footers can be specified at the user level (see User Preferences: Printing) or at the
category level. If no header or footer is assigned to a category, then it uses the corresponding setting of
the user.

Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom of
the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font you
have on your PC, you can use bold, italic, etc., and you can specify that the text be aligned to the left,
right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

Default Header

<CATEGORYNAME/>

[Bolded category name print macro, default font, left aligned]

Default Footer

Page <PAGENO/>
Printed on <PRINTDATE/>

[Bolded page number print macro above the date printed, default font, both centered]
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5.10.3 Print Macros

Print macros are used in the headers and footers. They are used as "place holders" for values that
replace them when the header or footer is actually printed.

Text formatting (font, bold, italic, etc.) that is consistent across the print macro within the header or
footer is applied to the result of the macro.

The print macros are only processed when used in a header or footer. Any macros included in an entry
are not processed, only printed.

Print Macros

<USERNAME/> - the "User Name" specified in User Preferences: Printing

<USERLOGIN/> - the user's login name

<CATEGORYNAME/> - the name of the category currently being printed

<ENTRYNAME/> - the name (or date) of the entry currently being printed

<PRINTDATE/> - the current date

<PRINTTIME/> - the current time

<PAGENO/> - the page number of the page being printed

NOTE: The <ENTRYNAME/> macro uses the name of the entry that is being printed whenever the new
page is started. If there are multiple entries printing on a single page, the name of the first entry printed
on the page will be used. This applies to both header and footer.

5.11 Reminders & Tasks

With The Journal's reminders and tasks you can stay on top of your busy schedule.

You can create new reminders with a right-click on the date in the calendar above your entry tree (if
you’ve set it to be active in the category you’re viewing), or right-click the date in the day planner (if
you’ve set it to be active in the category you’re viewing) or go to the Tools menu and open the  New
Reminder sub-menu.

There are four types of reminder: appointments, events, tasks and special days.

Appointments

Appointments have both a date and a time, and you can choose to have The Journal popup a visual and
auditory prompt when it's time for the appointment, or up to 6 hours before hand so you can get an early
start.

Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.
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Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month, or every other
Friday).

Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks also have a status: active, done, skipped, canceled, or missed.

5.11.1 Appointments

Appointments have both a date and a time, and you can choose to have The Journal popup a visual and
auditory prompt when it's time for the appointment, or up to 6 hours before hand so you can get an early
start.

You can create new appointment with a right-click on the date in the calendar above your entry tree (if
you’ve set it to be active in the category you’re viewing), or right-click the date in the Day Planner (if
you’ve set it to be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-
menu, and choose New Appointment...

Date

You can click on the calendar to set the date of the appointment, select it from the dropdown calendar,
or type the date in by hand.

Time

You will need to type in the time of the appointment by hand. You can also optionally include an end
time for the appointment.

If you want an appointment without a specific time, use an Event instead.

Popup Reminder

By default, the reminder will popup at the correct time on the date of the appointment. If you would like a
popup reminder before hand, you can set that as well, up to 6 hours in advance.

You can also assign a particular sound file (*.WAV) to be played when the reminder pops up.

By default, appointments are one-time events. To create an appointment that repeats daily, weekly,
monthly, or even annually, create an event, or look in Advanced Reminder Options.

5.11.2 Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
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assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month).

You can create new event with a right-click on the date in the calendar above your entry tree (if you’ve
set it to be active in the category you’re viewing), or right-click the date in the Day Planner (if you’ve set
it to be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-menu, and
choose New Event...

This Date

You can click on the calendar to set the date of the event, select it from the dropdown calendar, or type
the date in by hand.

Events can also be set to happen every week on a particular weekday (Sunday-Saturday), every
weekday (Monday-Friday), on the weekend (Saturday & Sunday), or even every day. It's also possible to
alternate, setting the reminder to be every other week or every other day.

More complex dates can also be set, including:
Any day (or two days) of the week.
Any weekday (or two weekdays) of the month.
Any day (or two days) of the month.
Any day (or two days) of the year.

Events set to a specific date are assumed to occur only once. Otherwise, events are assumed to repeat.
You can override both assumptions in Advanced Reminder Options.

Time

If you want to set a time for the event, you can type one in, as well as an end time for when the event will
conclude.

5.11.3 Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks have a status: active, done, skipped, canceled, or missed.

You can create new task with a right-click on the date in the calendar above your entry tree (if you’ve set
it to be active in the category you’re viewing), or right-click the date in the Day Planner (if you’ve set it to
be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-menu, and
choose New Task...

Priority

You can give the task a priority, which is used when listing the tasks above the entry editor. The higher
priority tasks are listed first.

Task Status

You can set the task to be active, done, skipped, canceled, or suspended. The "missed" status is set
automatically. When you first create a task, it's set to "active".
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Active - The task is considered in progress.

Done - The task is complete. If this is a recurring task, it will switch back to active automatically.

Skipped - The task is incomplete and has been skipped for the current period (day, week, month, year).
If this is a recurring task, it will switch back to active automatically.

Missed - The task was incomplete at the time of its due date and marked automatically as missed. If
this is a recurring task, it will switch back to active automatically.

Suspended - The task has been put on hold. If this task had been a recurring, it will not automatically
occur again.

Canceled - The task has been canceled. If this task had been a recurring, it will not automatically occur
again.

The task keeps a history of its status (go to Advanced tab, then Status in the New Task or Edit Task).
This allows you to bring up a date and see those tasks for that date which were marked as done,
skipped, or canceled, as well as any tasks which were missed.

5.11.4 Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.

You can create new special day with a right-click on the date in the calendar above your entry tree (if
you’ve set it to be active in the category you’re viewing), or right-click the date in the Day Planner (if
you’ve set it to be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-
menu, and choose New Special Day...

Birthday

For birthdays you can enter both the date of birth, and even the time of birth, if you so desire (and know
it).

If you know the year of birth, then the reminder for that birthday will be shown even when you're reviewing
past entries. If you don't know the year of birth, just use the current year, and the birthday will show from
this year forward.

Anniversary

Like birthdays, you can use the current year to be reminded from this year forward, or you can set the
actual year of the anniversary and see the reminder even in the past.

The default Calendar Charm for an anniversary is a bouquet of roses, but you can set that to any other
charm you wish, to remember anniversaries of all sorts.

Holiday
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Holidays have a month and a day, and it's assumed you want to see the holiday every year, past or
future. If you want to set an effective date for a holiday, so that it doesn't show up before that date, check
out Advanced Reminder Options.

The drop down list of months includes information about some of the more common holidays, like New
Years, St. Valentine's Day, and Christmas. This information includes the month, day, and even a pre-set
Calendar Charm for that day.

5.11.5 Advanced Reminder Options

These advanced options are available for all types of reminders: special days, appointments, events and
tasks.

Name/Description

Every reminder needs a name. The name doesn't have to be unique, but it should convey the intent of
the reminder, since this is what you'll see most often.

Date/Time

Date - The date of the reminder can be a specific day, a repeating weekday or collection of days, or
some pattern of days within a week, month, or year.

Time - The time of the reminder can be a specific time ("Eye Exam @ 7:00pm"), a start and end time
("Interview @ 9:00am-10:00am") or any time during the day ("Our Anniversary"). If you want to have a
reminder popup at you, you have to specify a time for the reminder.

This Happens - A reminder can be a one-time occurrence, or it can occur every day, week, month, or
year.

Effective Date - The effective date determines when the reminder becomes active. For example, if you
create a reminder for your wedding anniversary, you can set the effective date to the date of your actual
wedding. Every year after that, your anniversary will show on the calendar. You can also set an end
date, after which the reminder will no longer occur.

Display

Calendar Charm - Every reminder can be assigned a Calendar Charm. Default charms are chosen for
the different types of reminders, but you can change them to be whatever you like.

Show Reminder on small Calendar - If checked, the reminder's Calendar Charm will be shown on the
category calendar. If the same date has multiple reminders, only the top 3 will be shown, overlapping, on
the calendar. Since the calendar can get cluttered very quickly, you might want to limit the number of
reminders that show on the calendar.

Show Reminder

NOTE: The "Show Reminder" options listed here only apply when the day planner option is turned Off (in
Category Properties...).
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Show Reminder above Entry - If checked, the reminder will be listed above the entry editor. You can
double-click the reminder when it's listed above the entry like this, and edit it.

That Day Only - If checked, the reminder will show above the entry only on the actual due date.

N Days Before - If checked, then the reminder will show above the entry for the specified number of
days before the due date. Use this option to get advance warning of a reminder coming due.

Until Completed/Canceled - If checked, the reminder will always show above the entry, until you
cancel (or delete) the reminder, or mark it as done.

Popup

Popup Reminder when Due - If checked, and if the reminder has a specific time it's due, a reminder
will popup in The Journal.

Popup Reminder N Minutes Before - If checked, a popup reminder will happen the specified number
of minutes before the due time. The popup will include an option for you to be reminded again.

Play Sound on Popup - The default sound is the Windows "beep". You can specify any sound file (*.
WAV) you want to be played when the reminder pops up.

Status

Priority - A reminder can be given a priority from 1 (highest) to 100 (lowest). This priority determines
how the reminder is sorted when listed above the entry editor.

"Done" Charm - You can specify a different Calendar Charm to display when the reminder is marked as
done. The default is to use the same charm all the time.

"Skipped/Missed" Charm - You can specify a different Calendar Charm to display when the reminder is
marked skipped, or is missed.

Status History - This is a listing of the reminder's status history. Most non-task reminders will show the
date they went active, and the date (if any) that they were completed. Task reminders, though,
especially recurring tasks, will accumulate a sequence of active, done, skipped, and missed statuses.
You cannot edit this information.

Categories

All Categories - If checked (the default), then the reminder is displayed, on the calendar, above the
entry, or both, in all categories.

Active Category Only - If checked, the reminder will be displayed only in the category active at the
time you created the reminder.

These Categories - If checked, you can specify which categories to display the reminder in. Note that
in loose-leaf categories, like "Notebook", you can see reminders on the calendar for other days, but you
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will only be able to see above the entry reminders for the current date.

Notes

You can enter text of any length in the reminder notes, just like a normal entry.

5.11.6 Day Planner

The day planner is your always there reference for all your reminders and can be set to display in any of
your categories above the entry editor (see "Show day planner with active reminders" option in Category
Properties). You can display your reminders just for today or for up to a week in advance. 

All your reminders in this period can be editing, deleted or new ones created in the day planner, by right-
clicking the reminders themselves.

The day planner can be scrolled or vertically expanded or reduced to give you a view of the reminders set
at particular times, if necessary.

5.11.7 View All Reminders

The "View All Reminders" form provides a list of all of your reminders, active, done, canceled, etc. The
reminders are categorized by their type: Appointment, Event, Task, or Special Day. The "All" tab can be
used to view all of your reminders of all types.

From this form you can edit, copy or delete reminders. Click on the reminder, then click on the button to
"Edit", "Copy" or "Delete" the reminder.

5.11.8 Daily/Weekly Reminder Report

Use the Daily/Weekly Reminder Report to view all of the reminders completed, canceled, skipped or
missed in a given date range: a day, a week, a month, a year, or any range at all.

Example:
You have various tasks that you want to perform daily. Each week you want to print out a report of how
you did the previous week. So you:
1. Click on the Tools menu, choosing "Daily/Weekly Reminder Report..."
2. Select Last Week.
3. Click on See Report.

All of the reminders that were completed, canceled, skipped or missed over the past week are listed.
You can review them and then print a report, if you want.

Show all Reminders from:

There are 6 pre-set date ranges you can use: Today, Yesterday, This Week, Last Week, This Month,
and Last Month.

If you need a specific date range, click on This Date Range and set the From and To dates
appropriately.

Look In:
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You can have the report created from the Active Category or All Calendar Categories. Or you can
choose These Categories and select the specific categories to look in. Only reminders that are tied to
those categories (or are global reminders) will be reported.

5.11.9 Exporting Reminders

The Journal supports exporting your reminders and tasks into a simple CSV (comma-separated values)
format that can be imported by other scheduling software, such as Outlook, Sunbird, Mozilla, etc.

Reminders are exported as discreet events. That is, properties such as weekly and monthly recurrence
are not exported. Instead, the reminder will be exported once for each time the reminder would occur
within the specified date range.

Start Date & End Date

These dates provide the range of reminders and task to export.

Which Reminders

Special Days - If checked, special days will be included in the export file. Un-check this option to
prevent special days from being exported.

Appointments/Dates - If checked, appointments/dates will be included in the export file. Un-check this
option to prevent appointments/dates from being exported.

Events - If checked, events will be included in the export file. Un-check this option to prevent events from
being exported.

Tasks - If checked, tasks will be included in the export file. Un-check this option to prevent tasks from
being exported.

5.11.10 Importing Reminders

Reminders can be imported from any software that supports the simple CSV file format used by The
Journal. This format was created some time back by other software manufacturers, and has become
something of a universal format.

Reminders are imported as single events with a specific due date and time.

Some information exported from scheduler/planner software, such as required attendees, meeting
location, and so on, has no corresponding type of information in The Journal. However, in order to be
provide some degree of available of that information, they are imported and added to the "Notes" of the
reminder.

5.11.11 Export/Import CSV Format

The first line of the CSV file includes all field names in quotes. The data, one record per line, is all string
data.

Fields
[<<]   "Subject"      [>>]
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[<<]   "Start Date"      [>>]
[<<]   "Start Time"      [>>]
[<<]   "End Date"      [>>]
[<<]   "End Time"      [>>]
[<<]   "All day event"      [>>]
[<<]   "Reminder on/off"   [>>]
[<<]   "Reminder Date"   [>>]
[<<]   "Reminder Time"   [>>]
   "Meeting Organizer"   [>>] (into Notes)
   "Required Attendees"   [>>] (into Notes)
   "Optional Attendees"   [>>] (into Notes)
   "Meeting Resources"   [>>] (into Notes)
   "Billing Information"
   "Categories"
   "Description"      [>>] (into Notes)
   "Location"      [>>] (into Notes)
   "Mileage"
   "Priority"      [>>] (into Notes)
   "Private"
   "Sensitivity"
   "Show time as"

[<<] Exported by The Journal.
[>>] Imported by The Journal.s

5.11.12 Missed Reminders

The Missed Reminders report is run automatically when you log into The Journal. This report displays
reminders that were missed or had their due dates/times pass since the last time you logged in.

5.12 Security

The Journal's security is designed to be as complete as possible while still offering a high level of
convenience. Also, The Journal's security is scalable, so you only have to use as much as you need.

Security Features and Options:
Password protection
Entry encryption
Hide hot-key
Lock on minimize/hide
Auto-hide on idle

The Journal also offers Extended Security, which must be purchased separately. Extended Security
provides more control over the login process, as well as makes The Journal's entry database that much
more difficult to "hack".

5.12.1 Levels of Security

Not everyone wants or needs the same level of security. The Journal's standard settings provide a
medium-to-high level of security, but if you want more security, or if you want the security features to
stay out of your way, The Journal can support you.

The level of security you will want to set is based on the level of threat you perceive and/or wish to
protect against. See the explanations for the different levels of threat that face an electronic journal in
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the Levels of Threat help topic.

No Security

The Journal can support a near-lack of security if you want it to. With the Auto-Login option you can
have The Journal automatically log you in when it starts. See Auto-Login for more information.

The Journal also allows you to have a "blank" password.

Normal Security

By default, a user must be created with a password. This password has to be entered before that user's
categories and entries can be accessed.

All entries in The Journal are compressed and encrypted before they are saved.

The Journal can be quickly "hid" (minimized) with this hot-key: Ctrl+J

The Journal also has a "global" hot-key that you can use from any application under Windows: 
Ctrl+Alt+J

Additional Security

The Journal can be "locked" when minimized or hidden.

The Journal can automatically hide itself, locking itself if that option is also set, after a specified period of
"idleness". So if you get up and walk away from your PC, forgetting to hide and lock The Journal, it will
automatically do this for you.

See User Preferences: Security for more information.

Extended Security

For the Truly Paranoid, The Journal's Extended Security features provide a logical "next step" for The
Journal's built-in security. See Extended Security for more information.

5.12.2 Choosing a Good Password

Having a password is hardly useful if you don't pick a good one. Here are some guidelines for choosing a
good password (submitted by Bernard Beam):

6-10 characters in length (don't always pick the same length).
Use mixed-case alphanumeric (a B c D ... 1 2 3 ...).
Try not to have more than 2 alpha characters in a row.
Try not to have more than 3 numeric characters in a row.
Don't use the correct spelling of a word.
When using numbers, use them for more than just substitutes for letters (1 for 'l', 3 for 'e', etc.).
Don't use the same password for multiple applications or purposes.
Change your password every 30-60 days.
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In other words, "password1" is a particularly poor choice for a password. ;-)

A helpful mnemonic device is to select a phrase you will remember and use it as an acronym, for
example the phrase "I never forget to brush my gums" can create the password (In42bmg).

See Change User Password for more information.

5.12.3 Levels of Threat

All journaling software, including The Journal, faces the same kinds of "threats" to their security. These
threats range from "casual" access by novices to focused attacks by malicious hackers.

Casual or low level threats account for probably 90%-95% of the security issues faced by journaling
software. Fortunately, thwarting these requires very little effort from the developer. Medium level threats,
however, are a significant step up from low level threats, both in the training and technical knowledge
required to present these threats, and in the effort required to thwart them.

If a the journaling software can stop low level threats and medium level threats, then it has protected its
users from about 99% of potential "hackers".

High level threats represent dedicated hackers. They have the know-how and the tools necessary to
analyze the data and the program, finding weaknesses in one or the other to exploit.

Very high level threats are (mostly) limited to large corporations and governments. Unfortunately, there's
very little that can be done to thwart threats of this level.

Low Level Threats

Casual access to journal entries via the software.

This threat is simply someone starting up the software either by double-clicking its icon on the Windows
desktop or by selecting it from the Start menu, and then perusing your entries.

This is an easy threat to thwart: Simply require a password.

"Over the shoulder" reading of entries.

If you are working in your journal, and someone walks up behind you, they will often look at your
computer screen. This is more out of habit than deliberate attempt to see what you're doing, but it's still
a threat.

Most Windows programs have a minimize button on their main title bar, so you can minimize the
program quickly. Or you can click on the Windows taskbar and overlay another application's form.
Another option is to provide a "hot-key" combination that quickly "hides" the journal program (like The
Journal's Ctrl+J hot-key).

Medium Level Threats

Intentional access of journal database files.
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This threat requires a bit more understanding of computer software. Simply put, the hacker opens up
Windows Explorer and takes a look at the files used by the journal software. If he recognizes the
database software that is being used, it's a simple matter of downloading the necessary system utilities
and opening up the database.

To thwart this, the journal software can either use a non-standard or proprietary database format, or
encrypt all revealing information, storing nothing "in the clear".

Password "hacking" from personal information.

The hacker acquires a few pertinent personal details about you and attempts to guess your password
based on that. Most people choose very poor passwords, using the names or birthdays of loved ones--or
even their own name and birthday.

Thwarting this threat is more the responsibility of the user than the software. Choose passwords that are
not simple words, and that have little or no personal significance. If possible, incorporate one or two non-
alphanumeric characters into your password. See Choosing a Good Password for more tips about
passwords.

High Level Threats

Analysis of data stored in database.

In addition to using the standard database software to examine the user and entry information, the
hacker goes one step further and looks at the raw data that is stored using either a "hex viewer" or
another piece of specialized software. This type of analysis completely eliminates any advantage that
the developer might have gained by using a proprietary database format. In addition, simple encryption
schemes will be obvious and, therefore, quickly cracked.

Analysis of program code.

With sophisticated "debugging" and "tracing" software, the hacker examines the inner workings of the
software, looking for a way to bypass the entire security system of the software.

"Security by obscurity", which works well for low and medium level threats, is useless to combat high
level threats. The software developer has to anticipate this kind of analysis of both data and code.

The nature of journaling software, where you have to be able to get out what you put in, exposes certain
points of attack. An analysis of these points of attack is beyond the scope of this article, however.
Suffice it to say that it is vitally important for the software developer to be aware these inherent
weaknesses and do everything possible to make it difficult to exploit those weaknesses.

Very-High Level Threats

Advanced analysis of program code and data.

At this level, you are now dealing with hackers who have lots of time, top-of-the-line tools, and probably a
good amount of funding. The software can be pulled apart and all of its "parts" identified by function. And
every bit of data can be extracted and run through state-of-the-art cryptography software.

At this level of threat, there's nothing anyone can really do for you. Any claims to the contrary should be
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treated with extreme skepticism.

How Does The Journal Stack Up?

So how does The Journal stack up against these different threats?

Against low level and medium level threats, The Journal is more than adequate. The Journal offers
password protection and quick-hide hot-keys, as well as automatic hiding after periods of idleness. Also,
The Journal compresses and encrypts all entry information, and no potentially sensitive information is
stored "in the clear" in the database.

The Journal would give a high level threat a good run for his money, I believe, though it would eventually
succumb. The Journal's Extended Security, however, raises the bar significantly higher, possibly beyond
the resources most high level threats could bring to bear on the problem.

If you are facing a very-high level threat, then neither The Journal nor any other journaling software
currently available will be able to help you. In fact, at this level of threat, it's probably a bad idea to
commit anything to electronic form, as nearly all electronic data can be retrieved.

Fortunately, the individuals with the skill and resources sufficient to pose high and very-high threat levels
have other things to do than hack someone's journal, unless of course you are an international diplomat,
William "Bill" Gates, or have stored National Secrets on your computer. In these cases, your best bet is
to contact the CIA and inquire (politely) about top-of-the-line electronic systems security items.

All in all, The Journal represents an amazingly secure environment. And if you require an additional level
of security, The Journal's Extended Security can give you that.

5.12.4 Security Details

Here are the high-level details of The Journal's security algorithms.

Passwords

Passwords in The Journal are never stored in the database without being "hashed".

Passwords are hashed with the MD5 algorithm produced by RSA Data Security, Inc. This is a one-way
hashing algorithm, making it nearly impossible to guess the password from the hashed value.

Encryption

By default, entries stored in The Journal are compressed before they are encrypted. The compression
removes redundant information from the entry, making the encryption somewhat more secure.

Compression of entries uses the LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm)
programmed by South Pacific Information Services Ltd. This is very similar to the compression used by
the LHarc utility.

Encryption of entries uses the Twofish block cipher designed by Bruce Schneier.

Encryption keys are created using the intervals between certain keyboard and mouse events. The event
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intervals are measured in 1/1,000,000ths of a second over a period of time and provide a reasonable
amount of "entropy" to keep them from being predictable.

5.12.5 Extended Security

If you need a higher level of security than The Journal normally provides, then the Extended Security
option may be what you're looking for. The Journal's Extended Security must be purchased separately.

User Extended Security

A login name that uses Extended Security is significantly more secure than normal. See the Levels of
Threat topic for more information.

NOTE: A login with Extended Security active cannot have its password reset. If you lose your password,
there is absolutely nothing that can be done to recover it.

Extended Security: Global Options

5.12.6 Extended Security: Global Options

These options are only available if The Journal's Extended Security has been purchased.

Use Extended Security for User Name

When checked, this option adds an additional layer of security to that user's categories and entries.

NOTE: A login with Extended Security active cannot have its password reset. If you lose your password,
there is absolutely nothing that can be done to recover it.

Automatic Login Failure

With Extended Security, you can specify that all login attempts fail after a certain number of consecutive
failures.

For example, if someone is attempting to guess a user's password, then after the specified number of
failures, The Journal automatically fails all other attempts. The Journal doesn't even check the password
entered. The failure message is displayed, and The Journal prompts for the password once again.

This option functions regardless of whether Extended Security is turned on for a particular user. Setting
any non-zero (0) number of tries activates this option.

In addition, when this option is set to any value besides zero (0), the user will be shown the number of
unsuccessful login attempts when he logs in.

Minimum Wait Time (in minutes)

Once the automatic failure option has activated, the user will have to wait the specified minimum of
minutes before The Journal stops automatically failing attempts.
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5.13 Styles

The Journal styles allow you to assign pre-defined font and paragraph settings to a block of text.

The Journal automatically creates the following styles for you:

Heading 1, Arial 14pt bold, 12pt before-spacing, 3pt after-spacing

Heading 2, Arial 12pt bold-italic, 12pt before-spacing, 3pt after-spacing

Heading 3, Arial 12pt italic, 12pt before-spacing, 3pt after-spacing

These styles can be edited or even deleted. They are provided primarily as an example of what styles
are capable of.

You can create as many styles as you like.

If you change a style that is already in use, the change will be visible in any existing entries.

See Style Options for more information.

Apply Default Style

You can quickly apply the default style to a block of text by using the hot-key: Ctrl+<spacebar>

Or you can click on the Format menu and choose "Apply Default Style".

Apply Default Style (retain formatting)

Select a block of text, then click on the Format menu and choose "Apply Default Style (retain
formatting)".

This command sets the block of text to the default style, like Apply Default Style. But any text
formatting, like bold, italic, and so on is retained.

5.13.1 Creating New Styles

To create new text styles, click on the Format menu and choose "Styles..."

This brings up the User Preferences form on the "Styles" tab.

You can see your existing styles listed (with details) under "User Styles".

Click on "New" to create a new style.

You can also select a style in the list and click on "Copy". That creates a copy of the style that you
can then "Edit".

The many options available for styles are described here.
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5.13.2 Edit Styles

To edit your text styles, click on the Format menu and choose "Styles..."

This brings up the User Preferences form on the "Styles" tab.

You can see your existing styles listed (with details) under "User Styles".

Click on the style you want to edit, and then click on the "Edit" button.

The many options available for styles are described here.

Editing Standard Styles

You can also edit The Journal's built-in "standard" styles. The standard styles are:
Bullet style - the style for bullets.
Date style - the style used with the Insert Date command.
Entry Link Style - how entry links are displayed.
Internet/Email Link Style - how internet/email links are displayed.
Numbered list style - the style for numbered lists.
Outline style - the style for outline mode.
Time style - the style used with the Insert Time command.

You can see these styles in the list by checking the "Show Standard Styles" option (below the "User
Styles" list).

Changes to these styles will be reflected throughout your categories and entries.

It is recommended that you copy a standard style and then edit the copy.

5.13.3 Style Options

Style Name

Every style must have a unique name. You cannot change the name of the standard styles.

Style Hot-Key

Up to 10 styles can be assigned a hot-key. The available hot-keys are Ctrl+1, Ctrl+2, up to Ctrl+0.

Character: Font

The font setting determines which font is used for the style. This setting also determines the font's point
size, color, and any special effects (like bold, italic, etc) that are applied to the font.

Character: Highlight Color

The highlight color of the style determines the color that will be behind the text.
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Style Options: Paragraph
Style Options: Override Options

5.13.4 Style Options: Paragraph

These style options affect the paragraph settings.

Apply Style to Paragraph Settings

This option must be checked for the style to affect the paragraph settings.

Edit Right-to-Left

If checked, the paragraph style is for right-to-left editing.

Background Color

The color to be displayed "behind" the entire paragraph (not just the text).

Style Options: Paragraph: Alignment & Indents
Style Options: Paragraph: Spacing
Style Options: Paragraph: Numbering/Bullets

5.13.5 Style Options: Paragraph: Alignment & Indents

Alignment

This setting determines whether the text affected by the style is aligned to the left, center, right, or
"block". The "default" alignment does not affect the alignment of the text when applied.

Apply Style to Indentation

This option must be checked for the style to affect the paragraph indentation.

Left and Right

These settings affect the indentation from the left and right margins of the entry.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the standard form (inches for US, centimeters for Metric).

Special

This indentation can be applied to the first line of the paragraph (First Line) or the following lines
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(Hanging).

NOTE: If this setting is used on a style that also sets bullets or numbering (see below), this value
overrides the "numbering indent" for lines after the first line of the paragraph.

5.13.6 Style Options: Paragraph: Spacing

Line Spacing

Line spacing for a paragraph can be single, 1.5, or double. This affects how the text is displayed, as well
as how it is printed.

Apply Style to Paragraph Spacing

This option must be checked for the style to affect the before and after spacing of a paragraph.

Before and After

These settings affect the line spacing before and after the paragraph.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the points.

5.13.7 Style Options: Paragraph: Numbering/Bullets

Apply Style

This option must be checked for the style to use numbering or bullets.

Bullet/Numbering Type

None: No numbering or bullets on the paragraph.
Bullet: Standard bullet list.
Numbers: Numbered list (1, 2, 3, ...)
Letters: Lower-case letters (a, b, c, ...)
Letters: Upper-case letters (A, B, C, ...)
Roman: Lower-case Roman numerals (i, ii, iii, ...)
Roman: Upper-case Roman numerals (I, II, III, ...)

Numbering Style

Partial Parenthesis: 1) 2) 3) ...
Period: 1. 2. 3. ...
Full Parenthesis: (1), (2), (3) ...
None: 1 2 3 ...

Indent
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This setting affects the indentation of the first line, after the bullet or number, and the rest of the
paragraph.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the standard form (inches for US, centimeters for Metric).

5.13.8 Style Options: Override Options

Use Default Font, Size, & Color

These settings forces the style to use the current category's default font, font size, and font color,
regardless of the style's font settings or font currently active in the entry.

Use Active Font, Size, & Color

These settings forces the style to use the current entry's active font, font size, and font color, regardless
of the style's font settings.

Blend with Active Font Effects (Bold, Italic, etc.)

This setting "blends" the style's font settings for bold, italic, underline, and strikeout with those of the
currently active font.

Apply No Font Formatting

This setting forces the style to always use the currently active font. This setting is useful for only
applying paragraph and numbering changes.

HTML Style

If checked, text with this style applied will export (to HTML only) '&', '<', '>', and multiple spaces as they
are.

This option is most often used when posting to blogs. Some blogs support special HTML-like tags. To
have those tags "passed through" to the blog as they are, apply a style with this option.

5.14 Tables

The Journal entries can include tables with a variable number of rows and columns. More than simple
grids, each table cell can contain formatted text with any number of paragraphs, including images and
even other tables. Tables can be nested to any depth. Further, table cells can be merged together to
create larger cells, both horizontally and vertically.
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Tables in The Journal follow the HTML model. In this model, every cell in a table has its own distinct
border on all four sides. In addition, the table as a whole has a border, distinct from the cells in the table.
You can change this default look, however, and make the tables appear to have a single line border
between cells.

Tables and cells can also have background images, and these background images can be centered,
tiled, stretched.

The contents of table cells can be aligned vertically (to the top, bottom or middle of the cell), as well as
horizontally (left, right, and centered).

Another advantage of the HTML table model is that widths of columns are calculated based on the
widths of individual cells. Widths of cells (and the table as a whole) can be defined as percentage of the
visible editor, or a specific number of pixels. The height of cells can be set to match the content of the
cells, or can be set to a specific number of pixels.

And, of course, you can change the width and height of the table and cells with the mouse.

5.14.1 Using Tables

There are many uses for tables! One of those is demonstrated in the sample template: "Food Log".

Uses for tables:
Arranging information in an easy-to-reference grid.
Controlling text and image layout.

Adding a Row to a Table

To add a row to a table (like the Food Log):
1. Click on a cell in the last row of the table.
2. Click on the Table menu, Insert sub-menu, and choose Insert Row Below.
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Merging Table Cells

To merge table cells together:
1. Select the table cells you want to merge.
2. Click on the Table menu and choose Merge Cells.

Using Tables for Text Layout

You can use tables to control the layout of text and pictures. For example, you can use a table to put
text beside a picture.

1. Click on the Table menu, Insert sub-menu, and choose Insert Table...
2. Number of Columns: 2
3. Number of Rows: 1
4. Size Table Manually: 100 percent
5. Click on the left table cell.
6. Insert the image.
7. Use the mouse to resize the left table cell to fit the image.
8. Click on the right table cell.
9. Enter the text to be beside the image.

Hiding a Table's Borders

1. Click on the table.
2. Click on the Table menu and choose Table Properties...
3. Click on Table Border...
4. Border Type: None
5. Click on Cell Borders...
6. Border Type: None

5.14.2 Insert Table

Number of Columns

The number of cells across the table (left-to-right).

Number of Rows

The number of cells down the table (top-to-bottom).
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Table Layout

Autosize - The table is created as wide as the entry editor, with all columns the same size.
Size Table to Fit Window - The table is created as if you had entered "Size Table Manually" as "100%
percent".
Size Table Manually - You can set the table width to be a set number of "Pixels" or a "Percent" of the
entry editor window.

Table Properties...

Click here to adjust the properties the table will be created with: fill color, cell padding, borders, and so
on.

Remember Table Size & Properties for New Tables?

If checked, the current settings are remembered for the next time you insert a table.

5.14.3 Table Properties

To set or change a table's properties:
1. Click on any cell of the table.
2. Click on the Table menu, bring up the Select sub-menu, and choose Select Table.
3. Click on the Table menu and choose Table Properties...

Width

A table's width can be set one of 3 ways:
As a percentage of the width of the document entry editor ("Percent").
As a specific number of screen pixels ("Pixels").
Using the mouse to click-and-drag the table wider or narrower ("Manual").

Fill Color

Tables can be either "Transparent" (showing the color of the entry), or any color of your choice. The
table's fill color is the default fill color of all of the table's cells (though each cell can have its own color;
see Table Cell Properties).

Cell Padding

Cell padding is the amount of space (in screen pixels) between the border of the table cell, and the
contents of the cell.

Cell Spacing
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Cell spacing is the amount of space (in screen pixels) between the border of the table and the border of
the cells. It is also the amount of space between the individual cells.

Cell spacing can be broken down into vertical spacing between the table border and the cells, horizontal
spacing between the table border and the cells; and vertical and horizontal spacing between individual
cells. You can adjust these values by clicking on More... on the Table Properties form.

Image...

A table can have a background image that is shown "behind" the table cells. The image can be tiled,
centered, or stretched.

Table Border...

You can set the color and highlight color of the table's border. You can turn off the border completely, or
have it displayed as sunken, raised, or flat.

Cell Borders...

You can set the color and highlight color of the table's cell borders. You can turn off the cell borders
completely, or have them displayed as sunken, raised, or flat.

Keep Table on a Single Page

The table will not be printed on multiple pages.

Count of Heading Rows

If the table is printed on two or more pages, these first rows of the table will be repeated as a header on
all pages.

See also:
How do I make my tables look like those in MS Word/WordPerfect/Etc?

Table Row Properties
Table Cell Properties

5.14.4 Table Row Properties

To set or change the properties of a row of a table:
1. Click on a cell in the row you want to change.
2. Click on the Table menu, bring up the Select sub-menu, and choose Select Row.
3. Click on the Table menu and choose Table Properties...
4. Bring up the Row tab.
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Vertical Alignment

The vertical alignment of a table row can be set to either top (the default), center, or bottom.

This setting can be overridden at the cell level.

See also:
Table Properties
Table Cell Properties

5.14.5 Table Cell Properties

To set or change the properties of a row of a table:
1. Click on a cell in the row you want to change.
2. Click on the Table menu, bring up the Select sub-menu, and choose Select Cell.
3. Click on the Table menu and choose Table Properties...
4. Bring up the Cells tab.

Preferred Width

This is the preferred width for the cell(s), in pixels or percents of table width. Cells can be wider than this
value, if required to display its contents without overlapping.

Height at Least

This is the minimum height for the cell(s), in pixels. Cells can be taller than this value, if required to show
all its contents.

Fill Color

This is the background color of the cell(s). This overrides the fill color of the table.

Image...

A table cell can have a background image that is shown "behind" the cell. The image can be tiled,
centered, or stretched to fit the cell.

Vertical Alignment

The vertical alignment of a table cell can be set to either top (the default), center, bottom, or default. If
set to default, the cell uses its row's vertical alignment.

See also:
Table Properties
Table Row Properties
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5.15 Templates

Templates allow you to use standard forms or blocks of text in your entries. Writing and journaling
prompts, worksheets and forms, and "boilerplate" text are all possible with templates.

A template is either "simple" or "enhanced". Simple templates are inserted without any processing,
exactly as they were created. Any loose-leaf entry can be a simple template. Template entries are

displayed in the entry tree with a red "T" ( ) beside their name.

See Simple Templates and Creating Simple Templates for more information.

Enhanced templates provide many more options. Enhanced templates can be used to "create" entry
text that is then inserted into the current entry. An enhanced template can have one or more "sections"
that can be selected (at random or in sequence). An enhanced template can use other templates
(simple or enhanced) or even files external to The Journal.

See Enhanced Templates and Creating Enhanced Templates for more information.

Inserting a Template

Inserting a template is the same, whether it is simple or enhanced. You choose Insert Template from
the Insert menu (or from the right-click context menu) and then select the template you want. The
selected template is then added to the current entry.

5.15.1 Simple Templates

Any loose-leaf entry can be a simple template.

When a simple template is inserted with Insert Template, the entire template entry is copied. All text
formatting is preserved.

To have an entry appear as a template in the Insert Template list, first select the entry. Then click on
the Entry menu, and choose Template Entry.

See Creating Simple Templates for more information.

5.15.2 Enhanced Templates

Enhanced templates are much more than just a text entry.

An enhanced template can have multiple "sections". When the template is inserted, only a single
section is selected and inserted into the entry. Which section is selected depends on how the template
is setup. It could be a random section, or the next section in the sequence.

With an enhanced templates ability to pull in other templates, simple or enhanced, they significantly
extend the "boilerplate" features of templates.

In addition, enhanced templates can use "scripting", such as VBScript or JavaScript, to provide even
more power. Scripting can prompt the user for information, or control the text that is ultimately returned.

Example uses of enhanced templates:
Writing exercises, either in sequence or random
Journaling exercises
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Inspirational quotes
Auto-generated notes and letters
Role-playing game (RPG) charts and tables

See also:
Creating Enhanced Templates
Enhanced Template Tags
Enhanced Template Script Variables

5.15.3 Enhanced Template Tags

<TEMPLATE {{METHOD="method"} {SCOPE="scope"}} {USE="useLanguage"}
{UNFORMATTED} {GLOBALVARSPACE="spaceName"}></TEMPLATE>

This tag must be the first non-whitespace of an extended template.

A single entry can include only one template.

Text in the document that is external to (follows) any defined templates is ignored.

METHOD specifies the default access method of the template. If unspecified, the default access method
is "sequence". Valid default access methods are "sequence" and "random".

SCOPE specifies how the "sequence" default access method stores the current point in the sequence.
Valid default scopes are "global" and "category". If no scope is specified, then "global" is used.

USE specifies the default "scripting language" used by <DECLARE> and
<EXECUTE> tags. If not specified, the default scripting language is "VBScript". Other supported
scripting languages are "JavaScript", "PerlScript", and "PythonScript". VBScript and JavaScript are
usually available so long as you have Internet Explorer 4 or higher installed on your PC. The availability
of PerlScript and PythonScript is beyond the scope of this document. Generally, you will need to
download and install special software to use those.

If UNFORMATTED is specified, the selected section of the template is forced to be unformatted. This
overrides any formatting specified in the section.

GLOBALVARSPACE creates a "named" set of global variables. This named set of global variables is
then available to any other template that uses it, as well. That is, global variables can then be used to
store data between templates.

<INCLUDE {ENTRY="entryName" {CATEGORY="entryCategoryName"}
{UNFORMATTED}}/>

<INCLUDE {FILE="fileName" {UNFORMATTED}}/>

<INCLUDE {URL="urlText" {UNFORMATTED}}/>

An included entry is specified external to any sections. By convention, included entries are generally
listed after any <DECLARE>'s with defined functions.
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CATEGORY is used to include entries in other categories. If not specified, the entry must be within the
current category.

Any <DECLARE>'s in the included entry are treated as though they were declared in the including
template.

<SECTION>'s in included entries are added to the template according to their order in the included
entry. Included entries can be specified before, after, between, and so on, sections that are in the "top
level" template.

If an included entry includes other templates (and so on), the sub-includes will be handled recursively.

Duplicate entry includes, at the top level and within a <SECTION>, will be ignored.

<INCLUDE FILE...> is used to pull text (with or without formatting) into a template or <SECTION>. The
file is assumed to be text or text-with-markup. If no path is specified, the file will be looked for in the
active folder and then the default Windows path.

If the file has a .TXT extension, it is assumed that it will be unformatted text.

If the file has a .RTF extension, it is assumed to be rich text. If UNFORMATTED is specified, the file will
be included without formatting.

<INCLUDE URL...> is used to pull the contents of a URL into a template or <SECTION>. The URL can
specify a Web page, or an image.

<INCLUDE> can be used externally to <SECTION>'s, as well as within <SECTION>'s. The inserted text
will replace the entire <INCLUDE ... /> tag.

<INCLUDE>'s external to a <SECTION> will be processed every time the template is accessed.
<INCLUDE>'s internal to a <SECTION> will only be processed if that <SECTION> is selected.

If the included file causes incorrect formatting, or otherwise causes an error, accessing the template will
cause an error.

<DECLARE {USE="useLanguage"}></DECLARE>

The <DECLARE> tag is used to define functions, procedures, and "global" variables that can be called
or accessed in other parts of the template.

<DECLARE>'s must be external to any <SECTION>'s. Thus, it is convention to place all <DECLARE>'s
at the beginning of the template.

An error in a DECLARE, for instance a syntax error in declaring a function or variable, will halt the
template.

Standard functions and procedures can be declared in a template with no sections. This template can
then be included in other templates. This allows a certain amount of "code re-use".

Variables declared in a <DECLARE> can be accessed by any <EXECUTE> in the template. However,
the value of the variable is not maintained from one <EXECUTE> to another.
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If a template includes different <DECLARE>'s with different USE attributes, then each different scripting
language will have its own "run state". Elements declared for one scripting language will not be available
for use in other scripting language <DECLARE>'s or <EXECUTE>'s.

<EXECUTE {USE="useLanguage"}></EXECUTE>

The <EXECUTE> tag allows the template to perform some processing as part of processing.

<EXECUTE>'s external to a section will all be executed prior to accessing any section of the template.
Template-level <EXECUTE>'s can return a block of text that is embedded in the template. Thus, these
<EXECUTE>'s can selectively add <INCLUDE>'s, <DECLARE>'s, and so on to the template.

<EXECUTE>'s can also be used inside sections. In that case, the <EXECUTE> is considered to have a
string-type result value (called "Result") that will be inserted into the section when the script is finished.
The text formatting of the initial <EXECUTE> tag will be applied to the inserted text. The inserted text
will replace everything between and including the <EXECUTE> and </EXECUTE>. Processing of the
template will begin again at the first position replaced. Thus, a <EXECUTE> could create further tagging
to be processed.

There are global variables that can be accessed from any <EXECUTE>, and any changes to those
variables are kept. These globals can hold just any kind of data. "Global[nn]", where nn specifies an
index into the global array.

An error in an EXECUTE, for instance a syntax error, will halt the template.

<SECTION {ID="id"}></SECTION>

The section's ID can be a single integer, or a range of integers. A range is specified as "nn-mm", and
includes the values nn and mm. mm must be greater than or equal to nn. By convention, sections are
arranged in ID order, least to greatest.

If no ID is specified for a section, then it is given an automatic ID relative to its position in the list of
sections in the template, based on the last ID specified. So if the first section ID was given as 100, the
next would automatically be 101, and so on.

It is possible for "blank" spots to occur in a template, where there is no section tied to a particular ID. If
one of these blank sections is accessed by ID, nothing is returned.

Specifying a section which duplicates an earlier ID, or overlaps with a range specified for an earlier
section, will cause an error when accessing the template.

<SELECT ENTRY="entryName" {CATEGORY="entryCategoryName"}
{{METHOD="method"} {SCOPE="scope"} {DATA="data"}} {UNFORMATTED}/>

The SELECT tag can only be used within a section.

CATEGORY is used to select templates in other categories. If not specified, the template must be within
the current template's category.
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METHOD specifies the how the template picks a section to return. If unspecified, the default access
method is "sequence". Valid access methods are "sequence", "id", and "random".

"random" access uses each sections ID range to determine that sections chance of being selected. So
a section with a wide ID range has a better chance of being selected than a section with a single ID.

SCOPE specifies how the "sequence" access method stores the current point in the sequence. Valid
scopes are "global", "template", and "category". Default scope is "template".

"global" scope means that current sequence value is stored for the template being called. "template"
scope means that the sequence value is stored for the calling template and the template being called.
"category" means that the sequence value is stored for the calling category and the template being
called.

The DATA attribute is used by the "id" access method.

If UNFORMATTED is specified, then any formatting in the returned section is ignored.

<DATE {FORMAT="dd/mm/yy"}/>
<ENTRYDATE {FORMAT="dd/mm/yy"}/>
<TIME {FORMAT="hh:nn:ss"}/>

The text formatting of the date or time tag will be used on the inserted text.

DATE inserts the current system date. ENTRYDATE uses the date of the entry where the template is
being inserted into. In loose-leaf categories, ENTRYDATE functions the same as DATE.

If no FORMAT is specified, the Windows default setting for the date or time will be used.

The FORMAT's available include:

d, dd   Day of the month, example: 3, 03
ddd   Short day name, example: Tue
dddd   Long day name, example: Tuesday
m, mm   Month number, example: 6, 06
mmm   Short month name, example: Jun
mmmm   Long month name, example: June
yy   Short year, example: 03
yyyy   Long year, example: 2003
h, hh   Hour of the day, example: 7, 07
nn   Minutes of the time
ss   Seconds of the time

&lt; - replaced with '<' during section access.

&gt; - replaced with '>' during section access.

&quot; - replaced with '"' (double quote) during section access.
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<LITERAL VALUE="string"/>
The literal quoted string is embedded in the template section replacing the LITERAL tag.

5.15.4 Enhanced Template Script Variables

The Journal provides some variables that can be used within the <DECLARE> and <EXECUTE> tags.

Result

If an <EXECUTE> is used inside a section the <EXECUTE> is considered to have a string-type result
value (called "Result") that will be inserted into the section when the script is finished. The text
formatting of the initial <EXECUTE> tag will be applied to the inserted text. The inserted text will replace
everything between and including the <EXECUTE> and </EXECUTE>. Processing of the template will
begin again at the first position replaced. Thus, a <EXECUTE> could create further tagging to be
processed.

Globalnn

"Globalnn", where nn specifies an index 1-1000 into the global array. Example variable names are:
Global1, Global23, Global456, etc.

There are global variables that can be accessed from any <DECLARE> or <EXECUTE>, and any
changes to those variables are kept. These globals can hold just about any kind of data.

Normally, global variables are cleared after each use of a template. Specifying a GLOBALVARSPACE,
though, in the <TEMPLATE> tag, creates a set of global variables that are available from one use of a
template to the next, and even available to other templates. The variables in a GLOBALVARSPACE are
available until the user logs out of The Journal.

RandomValue

The "RandomValue" variable is read-only. RandomValue is a random floating-point value where:
0 < RandomValue < 1

This variable is provided because the random functions of some scripting languages are inadequate.

5.15.5 Creating Simple Templates

Any loose-leaf entry can be a simple template.

Creating a Simple Template

Here are the steps to create a simple template:

1. Create a loose-leaf entry to be the template (press F9, or Entry menu, Create New Entry sub-menu,
Document). The "Templates" category can be used for this, or any other loose-leaf/notebook category
you choose. Name the entry "My Template".

2. Enter the text to use for the template. Here is some example template text (between the "- - - - -"):
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- - - - -
Today I accomplished:

This made me happy today:

This made me angry today:

- - - - -

3. Now, to mark the entry as a template, click on the Entry menu, and choose Template Entry. The

entry's icon in the entry tree will now show a red "T" ( ).

Using "My Template"

1. Bring up the current date in your "Daily Journal" category, and scroll to the end of the entry, if
necessary.

2. Click on the Insert menu, and bring up the Insert Template sub-menu. Choose "My Template".

This will insert the text of "My Template" into the active entry.

5.15.6 Creating Enhanced Templates

This section will provide a short tutorial in creating enhanced templates.

Like a simple template, an enhanced template must be a loose-leaf/notebook entry. However, while a
simple template consists of whatever text is in its entry, an enhanced template must be properly
structured using the enhanced template tags.

An enhanced template can have one or more "sections", any one of which can be chosen when the
template is inserted. A specific section can be chosen, or one can be chosen at random, or in
sequence, depending on how the enhanced template is used.

Enhanced templates can "include" sections from other templates or even other entries in other
categories. Combined with the ability to execute ActiveScript scripting commands, enhanced templates
are a powerful feature of The Journal.

In the "Templates" category that is created for you automatically, there are a small number of enhanced
templates. Those provide some examples of what can be done. Feel free to refer to those as you read
on, to see how they work and how they are structured.

Next: Enhanced Template Basics

5.15.6.1 Enhanced Template Basics

Enhanced templates use HTML- and XML-style "tags". These tags define the template itself, the
sections within the template, and handle scripting. The following example shows the simplest form of an
enhanced template:

<TEMPLATE>
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<SECTION>Template text is here, as a section.</SECTION>
</TEMPLATE>

The <TEMPLATE> and <SECTION> Tags

As you can see in the example above, an enhanced template begins with a <TEMPLATE> tag, and
ends with a </TEMPLATE>. The <TEMPLATE> must be the first text in the entry. Any text that follows
the </TEMPLATE tag is ignored.

The <SECTION> and </SECTION> tags mark the actual text to provide when the template is inserted. If
you were to create an enhanced template from the above example, when you inserted the template, you
would get:

Template text is here, as a section.

This may seem like a long way around to get to something that can be easily handled with simple
templates--and it is. So now we will talk about a couple useful things you can do with enhanced
templates.

Some Useful Tags: <DATE/> and <TIME/>

Suppose you want a way to quickly log when you eat, and what you eat. You don't want to create a
whole new category for this, preferring to just enter the information in your normal "Daily Journal" entries.
Here's a template that you can insert when you need it:

<TEMPLATE>
<SECTION>
Food Log for <DATE FORMAT="mm/dd/yy"/> @ <TIME FORMAT="hh:nn">
Food/Description      Servings   Calories
</SECTION>
</TEMPLATE>

When you insert this template, the <DATE/> tag will be replaced with the current date, using the format
specified, and the <TIME/> tag will be replaced with the current time, again using the format specified.
Here's an example:

Food Log for 06/03/03 @ 07:47pm
Food/Description      Servings   Calories

Then you could type in the name of the food you ate, and then tab over to fill in the number of servings
and the calories.

The "FORMAT=..." part of the tags is called an attribute. Attributes usually take the form of:

ATTRIBUTENAME="Attribute Value"

That is, the name of the attribute is specified in all caps, followed by an equal sign (=), and then the
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value of the attribute, enclosed in double quotes.

To see all of the available FORMAT options for <DATE/> and <TIME/>, click here.

NOTE: Typically, tags and attributes are entered in ALL CAPS, but this is only a convention. Enhanced
template tabs and attributes can be either lowercase, UPPERCASE, or MixedCase.

Next: Enhanced Template Sections Part 1

5.15.6.2 Enhanced Template Sections

You have been shown the basic structure of an enhanced template, using <TEMPLATE></TEMPLATE>
and <SECTION></SECTION pairs, and even how to use attributes to modify a tag like <DATE/>. We will
now talk about enhanced template sections in more detail.

Multiple Sections

As we have already covered, the <SECTION> and </SECTION> tags mark the actual text to provide
when the template is inserted. Unlike a simple template, however, where the entire entry is used every
time, an enhanced template can have more than one section, and which one is used can be determined
a couple of different ways. For example:

<TEMPLATE METHOD="random">
<SECTION>How are you today?</SECTION>
<SECTION>What's up?</SECTION>
<SECTION>How are you feeling today?</SECTION>
<SECTION>Have you won the lottery yet?</SECTION>
<SECTION>Do you know where your towel is?</SECTION>
<SECTION>What's the weather like?</SECTION>
<SECTION>How is work?</SECTION>
</TEMPLATE>

This enhanced template, when inserted, will randomly choose from one of the above questions. Only one
of them will be used each time the template is inserted.

Note the METHOD attribute of the <TEMPLATE> tag. This attribute specifies how the template will
choose from the available sections. There are two possible METHOD's:

random      Choose a random section
sequence   Choose the next section in sequence

If the METHOD attribute had been set to "sequence" instead of "random", then the first time you inserted
the template, you would get:

How are you today?

The second time you would get:

What's up?
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And so on. The sequence will repeat once it reaches the last available section.

While the example given is somewhat contrived, it's not too different from the various Writing Prompt
templates in the "Templates" category.

Section Formatting

A section will pull the text, with whatever font or formatting it may have, from the end of the <SECTION>

tag to the beginning of the </SECTION> tag. So if the section text has bold, or italic, or even different
fonts, this will be inserted, as well. This includes paragraph formatting, like indentation and hard returns.

The example above, with the different greetings, for instance, will insert the greeting at the current cursor
position in the active entry. Afterward, the cursor will be position immediately after the last character in
the greeting. If, instead, you wanted a blank line after the greeting, you would need to add that to the
section, like this:

<SECTION>How are you today?
</SECTION>

If you wanted two blank lines after the greeting, you would do this:

<SECTION>How are you today?

</SECTION>

And, maybe you want a blank line before the greeting, to separate it from the preceding text. In which
case, you would do this:

<SECTION>
How are you today?

</SECTION>

You can override the formatting of all sections by using the UNFORMATTED attribute of the
<TEMPLATE> tag. This will force the text of the sections to be treated as simple text, with no formatting
such bold, italic, or whatever. Paragraph formatting will also be stripped off, though not hard returns/line
breaks used to separate paragraphs. This is how the above example would be changed:

<TEMPLATE METHOD="random" UNFORMATTED>
...

Next: Enhanced Template Scripting
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5.15.6.3 Enhanced Template Scripting

With an understanding of enhanced template sections, we now turn our attention to one of the more
powerful aspects of enhanced templates: scripting. With scripting, you can create sophisticated
functions and use them when processing the enhanced template.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows how
scripting can be used in The Journal.

Enhanced templates can use ActiveScript languages such as VBScript, JavaScript, and so on. Any
ActiveScript language that is installed on your computer can be used.

Within a Section or Outside of a Section

Scripts in enhanced templates can be either inside of a section (between the <SECTION></SECTION>
tags) or outside of any section. The biggest difference between those two cases is:

1. Script within a section is only executed when that section is selected. The results of the script, if any,
may be added to the text of the section when it is inserted into the active entry.

2. Script that is external to any section is executed every time the enhanced template is processed,
before any section is selected.

The <EXECUTE> Tag

Script commands are always bracketed by the <EXECUTE> tag, and it's trailing </EXECUTE>.
Everything between those tags is considered to be part of the script.

The default scripting language is VBScript. You can override this with the USE attribute. For example:

<EXECUTE USE="JavaScript">
// JavaScript commands here...
</EXECUTE>

If you specifiy a language with the USE attribute, that language must be available. Otherwise, the script
will not run. For simplicity, VBScript will be used in the examples given in the rest of this tutorial.

Global Script Variables

For script that is executed outside of a section, the only way to hold onto any results is with the global
variables provided.

There 1000 global variables available, and they can contain just about any type of value you choose
(number, string, etc.). You access them within your script commands like so:

<EXECUTE>
...
Globalnn='This String'
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...
</EXECUTE>

Or:

<EXECUTE>
...
if Globalnn >= 18 then
...
</EXECUTE>

Where "nn" is some number from 1-1000. Thus, you could have "Global1" or "Global23" or "Global456"
and so on.

The Result Variable

The Result variable is a local variable available only to <EXECUTE>'s that are inside of a section. The
Result variable can be assigned a value, either a string value or any value that can be easily converted to
a string (like a number). The value of Result is then inserted into the section's text, replacing the entire
<EXECUTE> </EXECUTE> script.

For example, this section:

<SECTION>
Hello, my name is <EXECUTE>Result="David"</EXECUTE>!
</SECTION>

Would look like this when inserted:

Hello, my name is David!

An Example with Scripting

Let's say you want a simple writing exercise that uses a random letter. You could do it like this:

<TEMPLATE>

<EXECUTE>
if Int(RandomValue * 2) > 0 then
  Global1="begins"
else
  Global1="ends"
end if
</EXECUTE>

<EXECUTE>
Global2=Chr(65+Int(RandomValue*26))
</EXECUTE>
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<SECTION>
Write about a word that <EXECUTE>Result=Global1</EXECUTE> with the letter:
<EXECUTE>Result=Global2</EXECUTE>

</SECTION>

</TEMPLATE>

This template randomly selects either "begins" or "ends", and then randomly selects a letter from A-Z.
These values are stored in the global variables Global1 and Global2, respectively. The section then
combines those variables with some text to create the writing exercise. Examples of the templates
output are:

Write about a word that ends with the letter: X

Write about a word that begins with the letter: E

The "RandomValue" variable used in the above scripts is a global variable available in enhanced
templates. It returns a random value (x) where: 0 < x < 1

Next: Enhanced Template Scripting Part 2

5.15.6.4 Enhanced Template Scripting Part 2

Even with only what we've shown you so far, scripting is obviously a powerful feature. There is more,
however. In this topic, we discuss two more tags that take scripting to the next level.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows how
scripting can be used in The Journal.

The <DECLARE> Tag

The <DECLARE> tag is much like the <EXECUTE> tag, in that it contains script code. Unlike the script
in <EXECUTE>'s, however, script in <DECLARE>'s is not run. Instead, the procedures and functions
declared are available to be called from within a <EXECUTE>.

You can have more than one <DECLARE></DECLARE> in an enhanced template. If you do have more
than one, they are consolidated and treated as a single collection.

One example of using <DECLARE> comes from role-playing games (RPG's). In RPG's many things are
based on the roll of a die. The die can have 4 sides (a d4), 6 sides (a d6), 8 sides (a d8), and so on. If
you wanted to create a template that would generate RPG items, you would be calculating random
numbers frequently. Rather than duplicate that script every time you need it, it is more useful to create it
once:

<TEMPLATE>
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<DECLARE>  
function RollDie(typeDie)  
  RollDie=Int(RandomValue*typeDie)+1  
end function  

function RollDice(typeDie,count)  
  total=0  
  for dd=1 to count  
    total=total+RollDie(typeDie)  
  next  
  RollDice=total  
end function  
</DECLARE>  

<SECTION>You find <EXECUTE>Result=RollDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RollDice(6,3)</EXECUTE> silver coins.</SECTION>

</TEMPLATE>  

So now you can create a collection of common function and procedures with your enhanced template.
But what if you want to use the same functions and procedures in other enhanced templates?

The <INCLUDE> Tag

The <INCLUDE> tag allows you to access entries within The Journal, or even files outside of The
Journal, and "include" them as part of the enhanced template.

Thus, you could create a loose-leaf entry called "Dice Functions" that contains this:

<DECLARE>  
function RollDie(typeDie)  
  RollDie=Int(RandomValue*typeDie)+1  
end function  

function RollDice(typeDie,count)  
  total=0  
  for dd=1 to count  
    total=total+RollDie(typeDie)  
  next  
  RollDice=total  
end function  
</DECLARE>  

Then you could simply "include" that entry in those enhanced templates where you need those
functions:

<TEMPLATE>

<INCLUDE ENTRY="Dice Functions">
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<SECTION>You find <EXECUTE>Result=RollDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RollDice(6,3)</EXECUTE> silver coins.</SECTION>

</TEMPLATE>

Much more compact, and much easier to maintain.

Next: Enhanced Templates Wrapup

5.15.6.5 Enhanced Templates Wrapup

Hopefully this short tutorial has shown you some of what is possible with The Journal's enhanced
templates.

With multiple sections to provide some variability, and scripting to add power, enhanced templates can
be amazingly versatile and useful.

Again, check out the enhanced templates that are provided in the "Templates" category. See how they
do what they do, and feel free to tinker with them.

Learn more here:

Enhanced Template Tags
Enhanced Template Script Variables

5.16 Topics

Topics provide another powerful way to organize your thoughts in The Journal. You can set a topic to the
text of entry, either as you type it or afterward. You can set as many topics within an entry as you wish,
or even tag an entry with as many topics as you want. You can then search entries with a topic or topics
and review them. Searching by topic can be a lot faster than searching for a word, phrase, or collection
of words.

The Journal creates a list of more than 60 topics and sub-topics for you, including:
Business
Dream
Family
Feelings
Finances
Friends
Health
Hobbies
And more!

Of course, you can add topics of your own and delete the ones you don't need.

Each topic can be given its own highlight color, to make it easier to see, and you can assign hot-keys to
up to 10 topics for ease of use.

When reviewing your entries, topics can be displayed (either one at a time or all at once) or hidden
entirely.
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Using Topics
Apply Topic
Editing Topics
Searching Topics

5.16.1 Using Topics

You can use topics either as you type in your entries, or apply them afterward as you review your entry.

Tagging an Entry with a Topic

Click on the Topic menu and choose "Tag Entry with Topic..." (hot-key: Ctrl+Shift+G). This applies
the topic or topics that you check to the entire entry.

Using Topics while Making Your Entry

You can also apply topics as you make your entry.

Select the topic you want from the drop-down list on the toolbar.

Once you do that, the name of the topic is inserted (as "[Topic Name]" on a line of its own), the topic's
highlight color is made visible, and then whatever you type will be automatically assigned that topic.
(NOTE: The topic highlight color isn't printed.)



The Journal162

© 1996-2011 by David Michael

You can switch to a new topic (or no topic) at any time by selecting the appropriate choice from the
topic list. The hot-key for "Apply <No Topic>" is: Shift+Ctrl+<spacebar> Also, if you triple-space after
a paragraph (hit ENTER three times), then you turn off the active topic.

Applying Topics to Your Entry

To apply topics to text after you have entered it, first select the text you want to tie to the topic, then
choose the topic from the list.

A given block of text can have any number of topics assigned to it. The marked text will show up in
searches for any of the applied topics.

Viewing Topics

Topics that have already been tagged to the entry or applied to the entered text are displayed in the
status bar below the entry:

Topics applied to entered text are listed first, and shown with [brackets]. Topics that are tagged to the
entry are listed next.

By default, blocks of text that have a topic are displayed with their hightlight color. This highlight isn't
printed. It only serves to show the text with topics. You can change this so that text with topics applied
does *not* show the highlight color. Click on the Topic menu and choose "Edit Topics..." Un-check the
option "Default to 'Show all Topics' in Editor".

5.16.2 Apply Topic

Click on the Topic menu and choose "Apply Topic..."

Or, to apply a topic to the entire entry:

Click on the Topic menu and choose "Tag Entry with Topic..."

Topics that have already been applied to the entry will show as checked.

Check or un-check the topics you want to apply.

"Clear all Topics" will un-check all topics in the list.
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5.16.3 Editing Topics

The Journal creates a list of more than 60 topics and sub-topics for you, but you can change the topics,
delete topics you don't need, and add topics of your own.

To edit your topics, click on the Topic menu and choose "Edit Topics..."

Any topic that you have used is shown as bold in the list of topics.

For explanation of all the available topic options, check out User Preferences: Topics.

5.16.4 Searching Topics

Searching by topic can be a lot faster than searching for a particular word or phrase. Because an entry
knows which topics have been used, it does not have to examine the entire entry.

To search by topic:

1. Click on the Topic menu and choose "Search Entries by Topic..."

2. Check the topic(s) you want to search for. NOTE: The topics you have used at least once in an entry
are listed first, in alphabetical order. All other topics are listed in alphabetical order following the ones
you have used.

3.Click on "Search".

5.17 User Interface

User Interface FAQ
How can I customize the look of The Journal (change the skin)?
How do I customize the toolbars?
What is the hot-key (keyboard shortcut) for...?
How do I make The Journal 5 look like The Journal 4?

5.17.1 Customizing the User Interface with Skins

The Journal supports full customization with 170+ pre-installed skins.

The quickest way to change the skin is to click on the View menu and choose "Change Skin/
Theme..."

You can also change the skin--or turn off skinning--of The Journal in "User Preferences..." (on the User
menu), on the "Global" tab. Note that if you turn skinning off (or back on), that you will need to close
and restart The Journal.

In User Preferences you can test a skin without losing your present settings. On the "Global" tab,
browse for a skin (…), and select Open. Then click on Test. If you’re happy with your selection, click
OK, then Apply at the bottom of the Global tab.

5.17.2 Customizing the User Interface Font

You can select the font, font style (regular, italic, bold or bold italic) and size of font you would like to
use in the user interface. This can be useful for those with difficulties seeing small fonts or to change the



The Journal164

© 1996-2011 by David Michael

style of the The Journal.

Click on the User menu and choose "User Preferences...", and bring up the "Global" tab. Click on the
button Edit User Interface Font.

This font will be used in all areas of the user interface, but it is not the font selected for your Journal
entries.

5.17.3 Customizing the Menus & Toolbars

The Journal supports full customization of the main menu and all toolbars.

Right-click on the menu or toolbar that you want to customize, and choose Customize.

Click on the Commands tab to see the list of available commands.

Under "Categories:" are groups of commands that roughly correspond to the menus of the same name.
For example, the commands available under "Format" are those on the "Format" menu.

Once you select a category, you can click on the menu or toolbar command under "Commands:" and
drag it where you want it to appear on the menu or toolbar.

5.17.4 Keyboard Shortcuts (Hot-Keys)

Ctrl+Tab Move to next category tab  
Ctrl+Shift+Tab Move to previous category tab  

F1 Context-sensitive help  
F2 Rename selected entry  
Ctrl+F2 Add a Calendar Charm to selected entry  
F3 Repeat last find  
F4 Editing toggle for Read Only entries  
F5 Go to today's entry in category (Calendar Categories only)  
Ctrl+F5 Go to date (Calendar Categories only)  
Ctrl+Shift+F5 Go to a random entry in the current category (Calendar Categories only)  
F6 Set date for all active categories (Calendar Categories only)  
F7 Go to previous entry in category  
Shift+F7 Go back 1 month (Calendar Categories only)  
Ctrl+F7 Go back 1 year (Calendar Categories only)  
F8 Go to next entry in category  
Shift+F8 Go forward 1 month (Calendar Categories only)  
Ctrl+F8 Go forward 1 year (Calendar Categories only)  
F9 Create new entry  
Shift+F9 Create new root entry
F10 Create new sub-entry
F12 Save Entry as...  
Ctrl+F12 Export Entries...  
 
Ctrl+F Find text in entry  
Ctrl+Shift+F Search entries  
Ctrl+G Replace text in entry  
 
Ctrl+<spacebar> Apply default text style to selected text  
Ctrl+Delete Delete word  
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Ctrl+B Toggle Bold On/Off  
Ctrl+U Toggle Underline On/Off  
Ctrl+I Toggle Italics On/Off  
Ctrl+<dash> Toggle Strikeout On/Off  
Ctrl+[ -1 font size  
Ctrl+] +1 font size  
Ctrl+M Indent paragraph  
Ctrl+Shift+M Unindent paragraph  
Ctrl+H Hanging indent  
Ctrl+Shift+L Toggle bulleting  
Ctrl+Shift+N Toggle numbering  
Shift+F10 Bring up entry context menu  
Ctrl+Shift+D Add/edit description of selected image  
Ctrl+L Align paragraph left  
Ctrl+R Align paragraph right  
Ctrl+E Center paragraph  
Ctrl+K Block justify paragraph  
Ctrl+= Subscript  
Ctrl+Shift+= Superscript  
 
Ctrl+Shift+H Edit the current paragraph as right-to-left (for Middle Eastern users)  
 
Ctrl+D Insert Current Date at cursor  
Ctrl+T Insert Current Time at cursor  
Ctrl+Shift+A Insert Entry Date (date of the active entry) at cursor  
Ctrl+Shift+I Insert Current Timer at cursor  
Ctrl+Shift+<dash> Insert line at cursor  
Ctrl+Shift+K Insert Link

Ctrl+Shift+B Backup The Journal  
Ctrl+Shift+S Spell checker  
Ctrl+Shift+R Thesaurus  

Ctrl+J Hide (and optionally Lock) Journal  
Ctrl+Alt+J Activate The Journal (if running)  
 
Ctrl+Shift+J Open Journal Volume  
Ctrl+Shift+U Switch user (login in as a different user)  
 
Ctrl+Shift+T Shift focus to date tree  
Ctrl+Shift+E Shift focus to entry  
Ctrl+Alt+C Toggle calendar On/Off  
Ctrl+Alt+T Toggle date tree On/Off  
Ctrl+Alt+I Toggle countdown timer and stopwatch On/Off  
 
Alt+Up Move Entry Up  
Alt+Down Move Entry Down  
Alt+Shift+Up Promote Entry  
 
Ctrl+Z Undo changes  
Ctrl+Y Redo changes  

Ctrl+Shift+P Apply topic
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Ctrl+Shift+G Tag entry with topic
Ctrl+Shift+<spacebar>Set selected text to "<No Topic>"  

International Characters  
 
Acute accent: Á, É, Í, Ó, Ú, Ý, á, é, í, ó, ú, ý  
Ctrl+Shift+<apostrophe> <letter>  
 
Circumflex: Â, Ê, Î, Ô, Û, â, ê, î, ô, û  
Ctrl+Shift+  ̂<letter>  
 
Grave accent: À, È, Ì, Ò, Ù, à, è, ì, ò, ù  
Ctrl+` <letter>  
 
Tilde accent: Ã, Ñ, Õ, ã, ñ, õ  
Ctrl+Shift+~ <letter>  
 
Umlaut accent: Ä, Ë, Ï, Ö, Ü, Ÿ, ä, ë, ï, ö, ü, ÿ  
Ctrl+Shift+<colon> <letter>  
 
Slashed characters: Ø, ø  
Ctrl+/ <letter>  
 
Cedilla: Ç, ç  
Ctrl+<comma> <letter>  

5.17.5 Keyboard Shortcuts (Hot-Keys) Alphabetically

Ctrl+A Select All (entire entry)  
Ctrl+Shift+A Insert Entry Date (date of the active entry) at cursor
Ctrl+B Toggle Bold On/Off  
Ctrl+Shift+B Backup The Journal
Ctrl+C Copy selection to clipboard  
Ctrl+Alt+C Toggle calendar On/Off  
Ctrl+D Insert Current Date at cursor  
Ctrl+Shift+D Add/edit description of selected image  
Ctrl+E Center paragraph  
Ctrl+Shift+E Shift focus to entry  
Ctrl+F Find text in entry  
Ctrl+Shift+F Search entries  
Ctrl+G Replace text in entry  
Ctrl+Shift+G Tag entry with topic
Ctrl+H Hanging indent  
Ctrl+Shift+H Edit the current paragraph as right-to-left (for Middle Eastern users)  
Ctrl+I Toggle Italics On/Off  
Ctrl+Shift+I Insert Current Timer at cursor  
Ctrl+Alt+I Toggle countdown timer and stopwatch On/Off  
Ctrl+J Hide Journal
Ctrl+Shift+J Open Journal Volume  
Ctrl+Alt+J Activate The Journal (if running)  
Ctrl+K Block justify paragraph  
Ctrl+Shift+K Insert Link
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Ctrl+L Align paragraph left  
Ctrl+Shift+L Toggle bulleting  
Ctrl+M Indent paragraph  
Ctrl+Shift+M Unindent paragraph  
Ctrl+Shift+N Toggle numbering  
Ctrl+Shift+O Toggle outline  
Ctrl+P Print
Ctrl+Shift+P Apply topic
Ctrl+R Align paragraph right  
Ctrl+Shift+R Thesaurus  
Ctrl+S Save all changes  
Ctrl+Shift+S Spell checker  
Ctrl+T Insert Current Time at cursor  
Ctrl+Shift+T Shift focus to date tree  
Ctrl+Alt+T Toggle date tree On/Off  
Ctrl+U Toggle Underline On/Off  
Ctrl+Shift+U Switch user (login in as a different user)  
Ctrl+V Paste from clipboard  
Ctrl+Shift+V Paste Special from clipboard  
Ctrl+W Count words in entry or selected text
Ctrl+Y Redo changes  
Ctrl+Z Undo changes  

Ctrl+Tab Move to next category tab  
Ctrl+Shift+Tab Move to previous category tab  

Ctrl+<spacebar> Apply default text style to selected text  
Ctrl+Shift+<spacebar>Set selected text to "<No Topic>"  
Ctrl+Delete Delete word  
Ctrl+Shift+Insert Paste from clipboard as text 

Ctrl+<dash> Toggle Strikeout On/Off  
Ctrl+Shift+<dash> Insert line at cursor  
Ctrl+[ -1 font size  
Ctrl+] +1 font size  

Ctrl+= Subscript  
Ctrl+Shift+= Superscript  
 
Alt+Up Move Entry Up  
Alt+Down Move Entry Down  
Alt+Shift+Up Promote Entry  
Alt+Left Back  
Alt+Right Forward  

F1 Context-sensitive help  
F2 Rename selected entry  
Ctrl+F2 Add a Calendar Charm to selected entry  
F3 Repeat last find  
F4 Editing toggle for Read Only entries  
F5 Go to today's entry in category (Calendar Categories only)  
Ctrl+F5 Go to date (Calendar Categories only)  
Ctrl+Shift+F5 Go to a random entry in the current category (Calendar Categories only)  
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F6 Set date for all active categories (Calendar Categories only)  
F7 Go to previous entry in category  
Shift+F7 Go back 1 month (Calendar Categories only)  
Ctrl+F7 Go back 1 year (Calendar Categories only)  
F8 Go to next entry in category  
Shift+F8 Go forward 1 month (Calendar Categories only)  
Ctrl+F8 Go forward 1 year (Calendar Categories only)  
F9 Create new entry  
Shift+F9 Create new root entry
F10 Create new sub-entry
Shift+F10 Bring up entry context menu  
F12 Save Entry as...  
Ctrl+F12 Export Entries...  

International Characters  

Acute accent: Á, É, Í, Ó, Ú, Ý, á, é, í, ó, ú, ý  
Ctrl+Shift+<apostrophe> <letter>  
 
Circumflex: Â, Ê, Î, Ô, Û, â, ê, î, ô, û  
Ctrl+Shift+  ̂<letter>  
 
Grave accent: À, È, Ì, Ò, Ù, à, è, ì, ò, ù  
Ctrl+` <letter>  
 
Tilde accent: Ã, Ñ, Õ, ã, ñ, õ  
Ctrl+Shift+~ <letter>  
 
Umlaut accent: Ä, Ë, Ï, Ö, Ü, Ÿ, ä, ë, ï, ö, ü, ÿ  
Ctrl+Shift+<colon> <letter>  
 
Slashed characters: Ø, ø  
Ctrl+/ <letter>  
 
Cedilla: Ç, ç  
Ctrl+<comma> <letter>  

5.17.6 Language

To change the user interface language, click on the View menu, Language sub-menu, and choose the
language.

Currently available languages:
English (United States) (default)
English (United Kingdom)
Chinese (People's Republic of China) [*]

[*] This language shouldn't be used except on Asian-language versions of Windows.

NOTE: The Journal uses Windows Regional settings for many things, like month names, days of the
week, and so on. Thus, those types of text are *not* affected by choosing a different language.
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5.17.7 Journal.INI

Under Windows Vista, the user-editable Journal.INI file can be found here:
C:\Users\WinUser\AppData\Roaming\The Journal 5\

Under Windows XP, this is the path:
C:\Documents and Settings\WinUser\Application Data\The Journal 5\

[GlobalOption]

The [GlobalOption] section provides access to the following settings:

GOShowSplashScreen

If true (=1), show the "splash screen" when starting The Journal. If false (=0), do not show the "splash
screen" when starting The Journal.

GOForceRepair

If true (=1), force The Journal to repair both the System Database and all Journal Volumes. This option is
automatically reset to false (=0) after the forced repair is completed.

GOInterfaceFontSize

If set to any positive value, that value is used as the font point size used in the entry date tree and
category tabs.

The default font point size is 8. If you would like to increase the font size used, try:

GOInterfaceFontSize=10

GONoCtrlAltHotKeys

If true (=1), this option turns off the keyboard shortcuts in The Journal that use Ctrl+Alt key
combinations. Currently, this only affects the Toggle Calendar (Ctrl+Alt+C) and Toggle Tree (Ctrl+Alt+T)
hot-keys.

Some international users (e.g., from Poland) were having problems with the Ctrl+Alt+C hot-key. It
prevented them from using a particular accented character.

GOAlwaysChooseRunAnotherTJSet

If true (=1), then the user has chosen to always either run another instance of The Journal, or to always
*not* run another instance, bringing up the active instance.

GOAlwaysChooseRunAnotherTJ

If true (=1), then the user can run The Journal as many times as he wants, each time opening a new
instance of The Journal.

If false (=0), then The Journal will be limited to a single running instance.
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5.17.8 Command Line Options

-v Specify Journal Volume

You can specify a Journal Volume to open when you start The Journal. The format is:

journal5.exe -v VolumeName

Example: journal5.exe -v Home

If the Journal Volume name includes spaces, then the name must be in quotes.

Example: journal5.exe -v "My Journal"

NOTE: When this command line parameter is present, only the specified Journal Volume is opened.
Other Journal Volumes, even those specified as auto-load, will not be opened. You can open those
Journal Volumes manually with File menu, Journal Volume sub-menu, "Open Journal Volume..."

-repair Force Database Repair

If this command line option is present, The Journal will repair all Journal Volumes when starting. The
format is:

journal5.exe -repair

5.17.9 Miscellaneous Forms

This section describes the options and commands available on The Journal's forms.

5.17.9.1 Calendar Charms

Click on the Entry menu and choose "Entry Calendar Charm..." (hot-key: Ctrl+F2)

Or click on the Insert menu and choose "Insert Calendar Charm..." (hot-key: Shift+F2)

To choose a Calendar Charm:

1. Select the Calendar Charm Collection.

2. Click on the Charm you want, by clicking on it or using the arrow keys.

3. Click on Select.

To Remove a Calendar Charm:

1. Click on Clear.

2. Click on Done.

See also: Calendar Charms
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5.17.9.2 Category Statistics

Click on the Category menu and choose "Category Statistics..."

This form shows the following information for the active category:
# of Entries - the total number of entries in this category
Security Level - whether the category requires a password or not
Shared? - whether the category is shared; if so, whether it's shared read only or full access
Read Only? - whether the category is read only (no new entries, no editing of entries)
Parent Category - if the category is a sub-category, this is the name of its parent category

5.17.9.3 Change User Password

Click on the User menu and select "Change User Password..."

You will need to enter your current password (unless you have a blank password) to create a new
password. When your current password has been verified, you will be asked to confirm your new
password.

The Journal allows passwords of any length.

See Choosing a Good Password for tips on how to make your password as secure as possible.

Using a Blank Password

The Journal allows you to have a "blank" password if you want. If you do not want a password, but still
want The Journal to "prompt" you to login, a blank password will do that.

When you set your password, just leave the new password blank. Do not type anything.

See also: How do I reset my lost password?

5.17.9.4 Choose an Action

You will be presented with the "Choose an Action" form in a variety of situations. The most frequent
cases are:

You cancel out of a user login prompt and there is no other user logged in.
The Journal is unable to find or open an expected Journal Volume.

The currently active Journal Volume, if any, is displayed.

You must choose one of these actions to proceed:

Open Another Journal Volume

You will be presented with a list of available Journal Volumes. Choose the Journal Volume you want to
open.

Log in to the Current Journal Volume
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This choice will take you back to the user login. There you can choose a user name and enter the
password to log in.

Create a New Journal Volume

This choice will lead you through the steps necessary to create a new Journal Volume, which you can
then open and log into.

Restore from a Backup

If you need to restore from a backup, click on this button.

Close The Journal

The Journal will close.

5.17.9.5 Choose Category to Import Into

When importing entries from a JNX export file, if you have specified Confirm All Import Categories in
User Preferences: Import, then you will be prompted to choose the correct category to use for the
import.

You can only choose a category that is the same type (calendar or loose-leaf) as the category that is
being imported.

You can also create a new category to receive the import, or you can tell The Journal to auto-create the
category. The automatic creation creates the new category based on the import category (same type,
name, and so on).

5.17.9.6 Clipboard Viewer

Click on the Edit menu and choose "Clipboard Viewer..."

The Journal's Clipboard Viewer provides a powerful tool for managing and using the Windows clipboard.
You can edit the clipboard contents, or paste them into the currently active entry.

With the "Auto-Paste to Active Entry" option, you can have anything that is copied to the Windows
clipboard automatically pasted into the active entry. This means you can rapidly collect information from
various applications and web pages without having to switch back and forth between The Journal and the
source of the information. Just select what you want, and copy it to the clipboard.

5.17.9.7 Countdown Timer

Click on the View menu and choose "Timer" (hot-key: Ctrl+Alt+I).

The Journal's countdown timer can be used in a variety of ways:
Many writing and journaling exercises want you to "just write" for a set period of time, like 10 minutes.
For your current writing project, you want to write for an hour every day.
For any project where you want to work for a period of time, the countdown timer can be set for a
matter of seconds, or even hours.
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NOTE: When you use the countdown timer, the stopwatch is disabled. And vice versa. You cannot use
both the countdown timer and the stopwatch at the same time.

Time Remaining

You can set the countdown timer to any time from just 1 second to many hours. You type in the
duration you want, and hit ENTER.

Setting durations:

mm   Will set the timer for mm minutes.
:ss   Will set the timer for ss seconds.
mm:ss   Will set the timer for mm minutes and ss seconds.
hh:mm:ss   Will set the timer for hh hours and mm minutes and ss seconds.

While the timer is counting down, you can insert the current timer value into your entry by clicking on
the Insert menu and choosing Insert Timer Count.

When the timer reaches 00:00:00, a sound is played to alert you. You can set the sound in User
Preferences.

 Start

Will start the countdown timer. If you have paused the timer, it will resume from its last count.

 Pause

Will pause the countdown timer.

 Reset

Reset stops the countdown timer, resetting it to 00:00:00.

5.17.9.8 Delete Users

Click on the File menu, Journal Volume sub-menu, and choose "Delete User(s)..."

You can only delete users within the active Journal Volume.

You will need to enter the password of any users you want to delete.

NOTE: Deleting a user also deletes all categories and entries for that user. Once deleted, a user cannot
be recovered. You would need to restore from a backup.
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5.17.9.9 Edit Auto Replace Strings

Click on the User menu and choose "User Preferences..." Bring up the "Editor" tab.

You can use the auto-replace feature to simplify your typing. You can create simple strings that are
automatically replaced with more complex text as you type them.

Auto-Replace Strings

This is the list of all auto-replace strings you have created. To edit an auto-replace string, click on it in
the list. To create a new auto-replace string, click on New Auto-Replace.

Replace

This is the sequence of characters that is to be replaced with the text in With. Each replacement string
must be unique.

With

This is the text that is automatically inserted when you type the string in Replace within an entry. This
text can be one or more lines long, and can be either formatted or unformatted.

Use Formatting

Check this option to apply formatting to the With text.

5.17.9.10 Edit Header/Footer

This form is used to edit both headers and footers for users and categories.

Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom of
the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font you
have on your PC, you can use bold, italic, etc., and you can specify that the text be aligned to the left,
right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

See User Preferences: Printing and Printing Headers and Footers for more information.

5.17.9.11 Edit Symbol Replace Strings

Click on the User menu and choose "User Preferences..." Bring up the "Editor" tab.

Some symbols are awkward, if not impossible, to type using normal keyboards. The Journal's Symbol
Replace feature can help work around this limitation by associating simple sequences with special
characters.
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Examples:
(c) : ©
(tm) : ™
'e : é
:-) : J

To create a new Symbol Replace sequence, simply click on New. Then type in the sequence of
characters, choose the font, and choose the symbol.

Replace

This is the sequence of characters that is to be replaced with the symbol. Each replacement string must
be unique.

Symbol Font

This is the Windows TrueType font that contains the desired symbol.

Symbol and WingDings fonts contain many command symbols, such as © and J

Special Roman characters, such as é and ä, are genearlly supported by any normal Windows TrueType
font (such as Arial). For these characters, it is recommended that you use the "<Default>" font option.

Symbol

Once you have selected the desired Symbol Font (or <Default>), simply choose the character you want.

5.17.9.12 Enter Registration Keys

Click on the Help menu and choose "Enter Registration Keys..."

Use this form to enter the Registration Keys you received when you bought The Journal.

The Registration Keys are in the form:

Key 1: YOUR NAME
Key 2: XXODDSTUFFHEREXX

Entering Your Registration Keys

Your Registration Keys are case-sensitive, so they must be entered exactly as sent to you. The easiest
way to do this is:

1. Select both Registration Keys from the email you were sent and copy them to the Windows clipboard
(hot-key: Ctrl+C).

2. In The Journal, click on the Help menu and choose "Enter Registration Keys..."
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5.17.9.13 Entry Statistics

Click on the Entry menu and choose "Entry Information & Statistics..."

Entry Statistics

This form shows the following information for all entries:
Date Created - the date this entry was originally created
Date Last Modified - the date of the last modification to the entry
Date Last Printed - when the entry was last printed
Total Editing Time - the number of minutes spent editing the entry (this is measured as the time
from beginning an addition/modification to the time the entry was saved) *
Revision Number - the number of times the entry has been modified (all changes on a single date
count as 1 revision)

* For some entries imported from The Journal 3, the total editing time reported may be incorrect.

Word Count

For document entries, it also displays:
Words - how many words are in the entry
Characters (no spaces) - how many non-whitespace characters are in the entry
Characters (with spaces) - how many total characters are in the entry
Paragraphs - the number of individual paragraphs in the entry (empty paragraphs are not counted)
Lines - the number lines displayed (this number varies as you resize The Journal)

Entry Changes Log

This tab displays a summary of every time the entry was edited or otherwise changed. The name of the
user who made the change is included in the log.

NOTE: Changes/edits that happen within 10 minutes of each other are consolidated into a single
change.

5.17.9.14 Find Text...

Click on the Search menu and choose Find Text... (hot-key: Ctrl+F)

Search for text in the current entry.

NOTE: To search in multiple entries across categories, use Search Entries instead.

Text to Find

Enter the word or phrase you want to search for here.

Options
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Search entire entry - search for the text in the whole entry. If this option is un-checked, the search will
start from the current cursor position in the text, and continue down to the bottom of the entry.

Case-sensitive - the case (uppercase or lowercase) of the text to find must match exactly.

Whole words only - no partial-word matches.

5.17.9.15 Get Web Page

Click on the Tools menu and choose "Get Web Page..."

Use this form to GET a page from the Web, with all images, and archive it in the active entry.

While most HTML formatting is supported, some formatting options are not supported (example: CSS
style sheets are not pulled). Also, characters from some languages may not be imported properly (this
will be fixed in a future update).

NOTE: The HTTP GET operation may take a few minutes, as it tries to download all of the images on the
page.

5.17.9.16 Go to Date

Click on the Go menu and choose "Go to Date..." (hot-key: Ctrl+F5)

Choose the date you want The Journal's calendar set to.

Type in the date by hand, or use the "drop-down" calendar.

When interpreting typed-in dates, The Journal uses the Windows setting for date format.

5.17.9.17 Handle Dropped File

This form pops up when you drag and drop a Windows file onto an entry.

Insert this file into Current Entry

The dropped file will be inserted into the current entry, if possible.

Replace Current Entry with this file

The dropped file will replace the current entry.

Add this file under Current Entry

The dropped file will be added as a sub-entry under the current entry.

Add this file as an Entry

The dropped file is added as an entry at the same level as the current entry.
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5.17.9.18 History...

Click on the Go menu and choose "History..."

This form contains a list of all the entries you have opened during this journaling session.

You can select any of those entries listed and then click on "Go to Entry". Or you can double-click a
listed entry to open that entry.

5.17.9.19 Login

This is the primary login form of The Journal. Before you can do anything in The Journal, you have to
login.

If you need to login to another Journal Volume, press Cancel and then choose Open Another Journal
Volume.

If you want to create a new user, click on Create New User.

User Name

Select your user name from the list of users.

Password

Enter your password.

See also: How do I reset my lost password?

5.17.9.20 Paragraph

Click on the Format menu and choose "Paragraph..."

Use this form to edit the settings of the current paragraph (or selected paragraphs).

Alignment

Left - The text of the paragraph is lined up on the left margin.
Center - The text of the paragraph is centered on each line.
Right - The text of the paragraph is lined up on the right margin.
Block - The text of the paragraph is lined up on both the left and right margins.

Indentation

Indentation is specified in inches or centimeters, depending on whether you use the US or metric
systems. Values can be entered in inches (in), centimeters (cm), or points (pt).

Left - Indentation from the left margin.
Right - Indentation from the right margin.
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First Line - Indentation of the first line of the paragraph.
Hanging - Indentation of the lines in the paragraph after the first.

Spacing

Before and After spacing are measured in points (pt), but can also be entered as inches (in) or
centimeters (cm).

Line Spacing - Line spacing is either single (default), 1.5, or double.
Before - Spacing before the paragraph.
After - Spacing after the paragraph.

5.17.9.21 Paragraph Borders & Shading

Click on the Format menu and choose "Paragraph Borders & Background..."

Use this form to add (or remove) borders and shading to the current paragraph (or all selected
paragraphs).

Color

This is the color of the border drawn around the paragraph.

Width

The width, in screen pixels, of the border lines.

Internal Width

This is the spacing between lines (centers of lines) in the border (for double and triple borders).

Offsets...

You can control the spacing between paragraph contents and border. Larger positive values increase the
spacing. Negative values force border to be inside of paragraph contents.

Border Type

You can set the border to be: no border, a single line border, a double line border, a triple line border, a
double line border with the inner line thicker, or a double line border the outer line thicker.

Fill Color

This is the color of paragraph background.
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Padding...

You can control the display of the background colored area relative to paragraph contents (the distance
between limits of paragraph contents and limits of colored area). Larger positive values increase the
hanging. Negative values force the color to be inside of paragraph contents.

5.17.9.22 Replace Text...

Click on the Search menu and choose Relace Text... (hot-key: Ctrl+G)

Search and replace text in the current entry.

Text to Find

Enter the word or phrase you want to search for here.

Replace With

Enter the word or phrase that the found text will be replaced with.

Options

Case-sensitive - the case (uppercase or lowercase) of the text to find must match exactly.

Whole words only - no partial-word matches.

Prompt on replace - you will be prompted before each replacement so you can choose whether this
text should be replaced.

5.17.9.23 Reset Login Password

Lost passwords cannot be recovered. But they can be reset.

When you are prompted for your password for your login name or category, type:
//resetpassword

That will bring up this form.

NOTE: Users who have activated Extended Security cannot have their passwords reset. That's one of
the features of Extended Security.

Password Reset Code

Enter the password reset code you received here.

Request Reset Code
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Clicking here will start your email program to request a password reset code from DavidRM Software.

Email DavidRM Software and request a password reset code.

5.17.9.24 Select Entry

This form is used by Insert/Edit Link to select the entry to link to.

Select the entry you want from the list of active categories and their entries.

5.17.9.25 Stopwatch Timer

Click on the View menu and choose "Timer" (hot-key: Ctrl+Alt+I), then click on "Stopwatch".

The Journal's stopwatch timer can be used to track how long you have been working on a particular
project.

NOTE: When you use the stopwatch, the countdown timer is disabled. And vice versa. You cannot use
both the stopwatch and the countdown timer at the same time.

Time Elapsed

Time Elapsed displays the time since you started the stopwatch, in hours, minutes, and seconds (hh:
mm:ss).

While the stopwatch is running, you can insert the current elapsed time into your entry by clicking on
the Insert menu and choosing "Insert Timer Count".

 Start

Will start the stopwatch. If you have paused the timer, it will resume from its last count.

 Pause

Will pause the stopwatch.

 Reset

Reset stops the stopwatch, resetting it to the starting time (00:00:00).

5.17.9.26 Unlock Form

When The Journal is "locked", either by minimizing or by using the "Hide Journal" hot-key (Ctrl+J),
you must enter your password to regain access.

mailto:support@davidrm?subject=I need a Password Reset Code for The Journal
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5.17.9.27 User Images

Click on the User menu and choose "User Images..."

The Journal allows you to load images for use as backgrounds to document entries or as Calendar
Charms.

Images

This is the list of all images currently loaded by the user. Each user login in The Journal has its own list
of images.

Load Image...

Click this button to load a new image.

NOTE: Every image must have a unique file name.

Delete Image

Delete the currently selected image.

Description

You can add a description to the image. This description is shown, along with the filename, whenever
you need to choose a background image for an entry or a Calendar Charm collection.

Image Type

An image is either a background image or a Calendar Charm collection.

Background Image Options

Position

A background image can be either tiled across the entry, centered in the middle of the entry, or
stretched to fit the entry editor.

Margin Offsets

Click on this button to adjust the margins used with background image, for example to prevent text from
displaying on the border of the image.

Calendar Charm Options
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Calendar Charm images are often collections of same-sized images arranged in a grid (but without
visible grid lines).

# of Charms Across (X)

The number of charm images across the image.

# of Charms Down (Y)

The number of charm images down the image.

5.17.9.28 User Statistics

Click on the User menu and choose "User Statistics..."

NOTE: If you have a lot of categories and/or a lot of entries, it make take a few seconds for the totals to
be tallied.

This form shows the following information for the current user:
# of Categories (Active) - how many active categories this user has (includes active sub-categories)
# of Categories (Total) - the total number of categories this user has, active or inactive
# of Entries (Active) - the number of entries in all active categories
# of Entries (Total) - the number of entries in all categories, active or inactive

5.17.9.29 Word Count

Click on the Tools menu and choose "Word Count..." (hot-key: Ctrl+W).

This form displays the following statistics for the entry or the selected text:
Words - how many words are in the entry or selected text
Characters (no spaces) - how many non-whitespace characters there are
Characters (with spaces) - how many total characters are in the entry or selected text
Paragraphs - the number of individual paragraphs (empty paragraphs are not counted)
Lines - the number lines displayed (this number varies as you resize The Journal)

5.18 User Preferences

Each user of The Journal can customize The Journal to fit her own tastes and preferences.

General
Global
Editor
Topics
Styles
Reminders
Date/Time
Links
Spell Checker
Printing
Export
Import
Backup/Restore
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Security

5.18.1 User Preferences: General

Measurement System

The Journal supports either the US system (inches, etc.) or the Metric system (centimeters, etc.). The
Journal automatically uses the measurement system settings active in Windows. If you wish to change
it, use this option.

Display Start of Week on

Your calendar can be set to start on any day of the week. Your Tasks, Events, Appointments etc will
also use this day of the first day of the week.

Start New Entry Date After

This is the time after which The Journal considers a new entry date to have begun in daily entry calendar
categories. The default is midnight (12:00 am or 00:00).

Arrange Category Tabs on the Right

If checked, all your category tabs will appear vertically on the right-hand side of the entry editor. This is
useful if you need more vertical space on your screen (useful for small screen netbooks for example).

Show Category Type on Tab

If checked, the tab for each category will include a picture (icon) representing the type of category.

Show Entry Date/Name above Entry Editor

If checked, the date or title of the entry will be shown below the category tabs.

If you are using a lower-resolution setting and need more screen "real estate", un-check this option.

Keep All Active Calendar Categories on the Same Date

If checked, this option keeps all calendar categories on the same entry date. That is, if the date is
changed in the current calendar category, the same date is set for all other active calendar categories.

Show Journal Volume tabs (global option)

If checked, open Journal Volumes will have tabs down the left side of The Journal's window. You can use
these tabs to quickly switch between Journal Volumes.
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Note: This is a global option and affects all users.

Show User Name tabs (global option)

If checked, all users you have opened in the Journal Volume will have tabs with their name along the
bottom edge of The Journal's window. You can use these tabs to quickly switch between open users.

Note: This is a global option and affects all users.

5.18.2 User Preferences: Global

These options affect all users in all Journal Volumes on this computer.

Show "splash screen" on Startup

Un-check this option if you do not wish to see The Journal's opening screen when starting The Journal.

Show icon in the Windows system tray

If this option is checked, The Journal will minimize to the Windows "system tray" (in the lower-left
corner, by the time display) instead of the taskbar. When The Journal is not minimized, The Journal will
still have a button on the Windows taskbar.

Minimize on Close

If this option is checked, The Journal will not close when you click on the "x" (Close Window) button in
the upper right corner of The Journal window. Instead, The Journal will minimize.

To force The Journal to close, click on the Journal menu and choose "Exit The Journal".

Minimize when The Journal loses focus

If this option is checked, any window that is placed in front of The Journal will prompt The Journal to
minimize.

Auto-Save Every nn Minutes

When checked and the number of minutes is selected, this option specifies when The Journal will
automatically save all changes.

Auto-Minimize if idle for nn Minutes

When checked and the number of minutes is selected, this option specifies when The Journal will
automatically minimize if it has received no input from the user.
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Keep The Journal "on top"

If set, this option keeps The Journal as the top-most Windows application. The Journal will be "on top of"
any other programs also running.

The Journal Hide/Unhide Global Windows Hot-Key Active

If this option is checked, The Journal can be activated (as long as it is running) regardless of where you
are in Windows, and what other applications may be running.

To set the global hot-key for The Journal, click on the hot-key entry. Then hold down the keys you want
to use for the hot-key.

The Journal's default hot-key is: Ctrl+Alt+J

If you change the hot-key, you will want to test to make sure that none of your other Windows
applications are using the same one.

Turn on Skinning

When checked, this option will give you the option of choosing from 170+ pre-installed skins. These can
be selected by clicking Browse (…), and tested without losing your previous skin settings.

Note that if you turn skinning off (or back on), that you will need to close and restart The Journal.

Use TJ4 icons for the toolbars, menus and entry tree

If checked, The Journal will use the icons that came with The Journal 4 instead of new icons that came
with The Journal 5.

Edit User Interface Font

Use this option to control the font, font type (regular, italic, bold, bold italic) and font size used in all
areas of The Journal’s main user interface. For example, if you want to use a larger font size, to make
the tabs and tree easier to read, you can do that here.

Countdown Timer Completed Sound

This is the sound played when the countdown timer reaches 00:00:00. This can be any sound (.WAV)
file on your computer.

Force Bidirectional Editing

This option forces The Journal to use bidirectional editing even when the Windows default is left-to-right.
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You will need to close and restart The Journal after changing this setting.

NOTE: Activating this option disables "block justify" formatting display. Block justified text will still print
correctly, but it will not be displayed with block justification in the entry editor.

Disable Ctrl+Alt Hot-keys

If checked, this option turns off the keyboard shortcuts in The Journal that use Ctrl+Alt key
combinations. Currently, this only affects the Toggle Calendar (Ctrl+Alt+C), Toggle Tree (Ctrl+Alt+T), and
Toggle Timer (Ctrl+Alt+I) hot-keys.

5.18.3 User Preferences: Editor

Editor Options
Image Options

Editor Options

Default Tab Width

The default tab width is either 0.50 inches (US) or 1 cm (Metric). If you want it to be some other value,
you can specify that here.

When selecting, auto-select entire word

When using the mouse to select text in an entry, this option causes the selection to always pick up full
words.

Do not automatically paste HTML (Paste HTML as Rich Text)

By default, The Journal pastes HTML that has been copied to the Windows clipboard. If you would prefer
that the copied HTML be pasted as Rich Text Format, check this option.

Insert URL when pasting from Web pages

When you copy and paste text and images from a Web page, the URL is inserted immediately following
the pasted text/images.

Auto-Replace while Typing

If active, this option causes specified sequences to be replaced by text. The replacement text can be
either formatted or unformatted.

Edit Auto-Replace Strings
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This button brings up the Edit Auto-Replace Strings form so you can edit, add, or delete auto-replace
strings.

Auto Symbol Replace while Typing

If active, this option causes specified sequences to be replaced by a symbol. For example, '(c)' would be
replaced by '©'.

Edit Symbol Replace Strings

This brings up the Edit Symbol Replace Strings form where you can edit, add, or delete symbol
replacement strings.

Symbol replacements are designated by:
string to replace (Example: :-) )
font to pull the symbol from (Example: WingDings)
symbol to replace with (Example: J)

Show special characters in editor

When checked, this option causes spaces, paragraph and soft-hyphens to be displayed.

Use alternative editor formatting

When checked, this option causes the editor to use a slightly slower but sometimes more accurate
method of formatting text on screen.

Use this option if you see improperly line breaks or other formatting issues.

Grammar Checking Options

Replace i with I - When checked, all instances of a singularly typed ‘i' will be replaced with ‘I’.' This
option is  On by default for English-language versions of Windows, and Off for non-English-language
versions of Windows.

Capitalize the first word of a sentence - When checked, the first letter of a word that begins a
sentence will be capitalized. 

Edit Custom Colors

Use this option to set up to 16 custom colors that will be available wherever The Journal allows a color to
be set or selected.
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Image Options

Default Editor Background Image

This is the image that is used as the background for all entries. This setting can be overridden at both
the category level (see Category Options: Entry Text Style) and at the entry level. Images must be
loaded using the User Images form (on the User menu).

Automatic Image Resizing

For most journaling and scrapbooking purposes, images, especially digital photos, don't need to be
stored at their full size. However, having to reduce the images before putting them in The Journal can be
inconvenient. This feature makes it possible to have your images automatically resized when you insert
them.

Resizing can be fully automatic, you can have The Journal prompt you, or you can select to have no
image resizing.

The images are resized according to their largest dimension. If the image's width is greater than its
height, then the Resize if Width > (greater than) setting is used to scale the image. If the height is
greater than the wide, then the Resize if Height > (greater than) setting is used.

The image is resampled during the resize, so that the quality of the image remains high. The resampling
uses the Lanczos resampling algorithm with a 6x6 cell size.

Default Image Type

To improve save/load times of entries with images, The Journal automatically converts inserted and
pasted images to either JPEG or PNG formats. The JPEG format allows for the best compression, but at
the cost of some information. For most photos, JPEG is the best choice.

The PNG (portable network graphic) format doesn't compress most images as small as JPEG, but PNG
has the advantage of losing no pixels and doesn't cause the subtle color shifts sometimes seen in
JPEG.

This setting only affects images when they are first inserted or pasted. After that, the images aren't
changed, regardless of this setting.

5.18.4 User Preferences: Topics

Default Topic Highlight Color

Topics are displayed with a highlight color that distinguishes them. This is the default highlight color
used by all topics. This color can be overriden by each topic, so that special topics get more a
distinctive color.

Default to "Show all topics" in Editor

If checked (the default), then any text in an entry that has one more topics applied to it will display with
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that topic's highlight color. If not checked, topic highlight colors aren't displayed. However, the topics in
the entry are still listed below the editor:

Insert Topic Name

If checked (the default), then the topic name is inserted any time a new topic is selected. How the topic
is inserted is controlled by the Topic Name Format option.

NOTE: This option has no effect when you select a block of text and then apply the topic.

Topic Name Format

The default topic name format is: [%topic]

The "%topic" variable is replaced by the name of the topic.

Topics

This is the list of all the topics you have defined. The Journal automatically creates nearly 100 topics for
you. You can add new topics, delete topics you don't want, and edit topics that need changing.

Topics that you have used in an entry are indicated in bold text.

You can make a topic a sub-topic by clicking and dragging it to the topic you want it to be under, then
dropping it.

Topic Name

Every topic, including sub-topics, must have a unique name.

Highlight

To make it easier to distinguish topics used in an entry, you can set the highlight color. If you do not set
a color, then the default topic highlight color is used.

Hot-Key
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Up to 10 topics can be assigned a hot-key. Giving a topic a hot-key makes it even easier to apply that
topic. The available hot-keys are Shift+Ctrl+1, Shift+Ctrl+2, up to Shift+Ctrl+0. (NOTE: Shift+Ctrl+6 is
not available as a topic hot-key.)

New Sub-Topic

This button creates a new sub-topic of the currently selected topic.

Delete Topic

Deletes the selected topic.

5.18.5 User Preferences: Styles

Edit Default User Text Style...

The default user text style defines the font and background color used in newly created categories, as
well as those categories still tied to the default settings.

User Styles

The Journal allows you to create as many pre-defined styles as you want. These styles can be used in
entries in any category.

Some styles are automatically created for you when you first start using The Journal. These can be
changed or even deleted, if you like.

Show Standard Styles

The Journal uses certain "standard" styles. Such styles are the default user text style, the bullet style,
and the numbered list style. Check this option if you would like to see those styles.

These styles can be edited and copied, but they cannot be deleted.

See Styles for more information.

5.18.6 User Preferences: Reminders

Click here for more information about reminders.

Report Missed Reminders

If checked (the default), then every time you log in, The Journal will see if you missed any reminders
since the last time you logged out.
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Include Reminders When Printing/Exporting Entries

NOTE: This option only applies to entries in calendar categories, like "Daily Journal".

If this option is checked, then when you print or export entries from calendar categories, any reminders
that were active, completed, missed, skipped or canceled on that date will also be printed or exported.

Display reminders/events from MS Outlook in The Journal

If checked, The Journal will display your reminders/events from your default MS Outlook calendar.

5.18.7 User Preferences: Date/Time

"Insert Date" Format

This is the format that is used for dates inserted with the Insert | Date (Ctrl+D) command.

Use the following codes for the date format:
yyyy - 4 digit year (1996)
yy - 2 digit year (96)
mmmm - full month name (August)
mmm - three-letter abbreviation of month (Aug)
mm - 2 digit month (08)
m - 1-2 digit month (8)
dddd - full day name (Friday)
ddd - three-letter abbreviation of day (Fri)
dd - 2 digit day (09)
d - 1-2 digit day (9)

Edit "Insert Date" Style

The formatting of the inserted date text can be specified with this option.

See Styles for more information.

Entry Date Header Format

This format is used to display the date above calendar entries.

See "Insert Date" Format above for formatting codes. Commas or any punctuation, or spaces can be
added or deleted to suit the format of date you would like to display

Force month and day names to English (global option)

When this option is checked names of months and days will be converted to English. This applies to the
calendars and planners as well as the Insert Date and Insert Time commands.

Note: This is a global option and affects all users.



The Journal Reference 193

© 1996-2011 by David Michael

"Insert Time" Format

This is the format that is used for dates inserted with the Insert | Time (Ctrl+T) command.

Use the following codes for the time format:
hh - 2 digit hour (02:00)
h - 1 digit hour (2:00)
nn - 2 digit minute (2:03)
n - 1 digit minute (2:3)
ampm - 12-hour clock, AM/PM (2:00 PM)
am/pm - 12-hour clock, am/pm (2:00 pm)
a/p - 12-hour clock, a/p (2:00 p)

Edit "Insert Time" Style

The formatting of the inserted time text can be specified with this option.

See Styles for more information.

5.18.8 User Preferences: Links

Auto-Highlight Links

If checked, then Internet links/URLs (web page addresses, email addresses, etc) and entry links will be
highlighted as they are typed in.

Clicking links opens a New Browser

If checked, a new browser window is opened when Internet links are clicked on. If not checked, then the
most recently opened browser window is used. In either case, if no browser window is open, one is
opened.

Edit Internet/Email Links Style

The formatting used to display Internet links/URLs can be specified with this option.

See Styles for more information.

Edit Entry Link Style

The formatting used to display entry links can be specified with this option.

See Styles for more information.
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5.18.9 User Preferences: Spell Checker

Check spelling as you type

This option performs "live" spell checking if activated. Misspelled words will be marked with a distinctive
underline (see Spelling errors underline color below). Marked words can be right-clicked on to bring up a
list of suggestions to correct the misspelling.

Spelling errors underline color

This option specifies the color used when marking misspelled words when performing "live" spell
checking.

Correct spelling errors as you type

This option performs "auto-correction" of designated misspellings. For example, "teh" is automatically
corrected to "the".

The Journal includes a list of commonly misspelled words and their automatic corrections. Plus, you can
add new auto-corrected words to your custom spell check dictionary.

5.18.10 User Preferences: Printing

User Name

This option defaults to your login name for The Journal. If you would like your full name to appear on
entry printouts (using the <USERNAME/> macro), enter that here.

Edit Default Page Setup

The default page setup is used when printing entries from any category that does not specify its own
page setup. You can specify the default page orientation (portrait or landscape), as well as the margins
to be used.

Edit Default Page Header and Footer

The header and footer specified here are used when printing any category that does not specify its own
header and footer.

Edit Default Entry Header

The entry header specified here is used when printing entries from a category that does not specify its
own entry header.

See Printing for more information.
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Print Loose-leaf Entry Index Indented

If checked, then printing an entry index (just the entry names) of loose-leaf entries uses tabs to show the
"tree-structure" of the entries.

For example:

My MemoryGrabber
About Me
   Background Information
   My Life's Timeline
   My Childhood Years
      Early Childhood
      Eary School Years
      ...

If un-checked, then loose-leaf entries are printed with their full path and entry name.

For example:

My MemoryGrabber
About Me
About Me\Background Information
About Me\My Life's Timeline
About Me\My Childhood Years
About Me\My Childhood Years\Early Childhood
About Me\My Childhood Years\Eary School Years
...

5.18.11 User Preferences: Export

Export Format
File Names

Export Format

Default Export Format

Rich Text (.RTF) - Rich Text, or RTF, files include all text formatting and embedded images/objects.
RTF files can be read by nearly all Windows word processors.

Plain Text (.TXT) - Plain text files are stripped of all formatting except line-breaks. TXT files can be read
by any text editor.

HTML (.HTM) - HTML is the standard format of the World Wide Web. They can be edited by any text
editor, most Windows word processors, and, or course, they can be displayed with any Web browser.
Most text formatting is preserved, though not all. Embedded images are extracted to JPG files and
linked from the exported .HTM file.

Journal Export Format (.JNX) - The Journal Export Format is a proprietary format used only by The
Journal. It preserves not only all text formatting, but it also preserves all category and entry settings. JNX
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files are used primarily to transfer entries from one copy of The Journal to another.

NOTE: JNX export files created by The Journal 5 cannot be imported into earlier versions of The Journal.
JNX files created by earlier versions of The Journal can be imported into The Journal 5, however.

RTF/TXT/HTM File Options

Create a Single File for all Exported Entries - This option creates a single file for all exported entries.
Categories are given "headers" to separate their entries.

Create a File for each Exported Category - This option creates a file for each exported category.
Only entries exported from that category are included in its file.

Create a File for each Exported Entry - This option creates a file for each exported entry. Depending
on the number of entries exported, this option could result in a lot of files being created.

 Use .HTML Extension

If you would prefer that entries exported as HTML use the .HTML file extension instead of the .HTM file
extension, check this option.

Save HTML with CSS information in .htm(l) file

By default, The Journal saves CSS (cascaded style sheets) information in your HTML files. If you would
prefer to export your HTML with the older, inline tags, un-check this option.

Include Category Name Header in export

By default, exports to RTF/TXT/HTM include the category name as a header before the first exported
entry for that category. Un-check this option to prevent this.

Include Entry Date/Name Header in export

By default, exports to RTF/TXT/HTM include the entry date/name as a header for each exported entry.
Un-check this option to prevent this.

File Names

Category File Name

If the Create a File for each Exported Category option is used, this setting controls the name of the
export file.

To include the name of the category in the file name, use the "%c" flag.
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Entry File Name

If the Create a File for each Exported Entry option is used, this setting controls the name of the export
file.

To include the name of the category in the file name, use the "%c" flag. To include the name (or date) of
the entry, use the "%e" flag.

Include "Full Path" in Loose-Leaf Entry Names

If checked, loose-leaf entry names include their full "path" of parent entries.

Export Path Separator

If exported loose-leaf entries will include their full path, it is necessary to specify a replacement for the
backslash ( \ ) character in the path. The backslash ( \ ) is not allowed in Windows file names.

This option is also used with the File | Save Entry As... command.

Date Format

For categories with entries tied to a date, such as standard categories, this setting controls how the
date is formatted in the export file name.

See Export/Import for more information.

5.18.12 User Preferences: Import

Category Import Options

Confirm All Import Categories - If checked, this option prompts the user before importing any
category, allowing the user to choose which category to import into. If this option is not checked, the
import process will attempt to automatically pick a category to import into based on the name and type
of the import category.

Auto-Create New Categories - If checked, the import process will automatically create any categories
that are in the import file but not already in the user's collection of categories.

Entry Import Options

Only Import if Newer - If checked, this option only imports entries if they are newer than the same
entry (based on date or entry name-and-path) already in The Journal.

Always Import - If checked, any existing entry in The Journal is overwritten by the entry being imported.

See Export/Import for more information.
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5.18.13 User Preferences: Backup/Restore

Backup Path

This is the folder or drive path where the backup will be located. You can select your own destination to
removable media or any folder on your hard drive by selecting Browse (…)

Prompt for backup when closing The Journal

When checked, The Journal will prompt you for a backup when you close the software.

This option overrides the "Prompt for backup every nn days" option.

Prompt for backup every nn day(s)

When this option is checked and the number of days is selected, you will be prompted to backup when
The Journal is closing. The default is 3 days.

Append date & time to backup archive

If checked, the backup file name will be automatically appended with the current date and time.

Keep only the nn most recent backups per Journal Volume

Once the number of backups for a Journal Volume reaches this number, then the oldest backup is
deleted to make room for the new one.

This applies to the backup path you set above, and to all paths you have The Journal copy your backups
to (but not to FTP servers).

Copy backup archive to these locations

This feature allows you to automatically create identical backup copies in additional locations by
selecting Browse (….), selecting a location, and then clicking "Add".

You can also have The Journal automatically FTP your backup file to an offsite location. To do that, you
have to input the FTP information in this format:

ftp://userLogin:userPassword@ftp.host.com/remote/path/

Or, if you use anonymous login to the FTP server (not recommended):

ftp://ftp.host.com/remote/path/

Finally, it's also possible to upload with FTPS, assuming your server supports FTPS:

ftps://userLogin:userPassword@ftp.host.com/remote/path/
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5.18.14 User Preferences: Security

Automatically log in this user (bypass password)

If you would like to automatically log you in when you launch The Journal, set this option. You can also
set (or clear) this option by clicking on the User menu and choosing Auto-Login.

You must confirm your password to activate this option. If you have a blank password, just hit
ENTER.

NOTE: This feature effectively bypasses The Journal's built-in security features, so only activate this
feature if you are the only person using your computer.

In past versions of The Journal, Auto-Login was called "Single User Mode".

Lock on Minimize/Hide (prompt for password on restore/un-
hide)

This setting, if active, "locks" The Journal when minimized or it is hidden, whether with the auto-hide
option or the "Hide The Journal" hot-key (Ctrl+J).

Compress Entries

If checked (the default), all entries are compressed as they are saved. This keeps the Journal Volume as
small as possible, and adds a bit more security.

NOTE: The Journal overrides this setting for entries that have media attachments or a large (or a large
number of) JPG or PNG images. This is because most media files and JPG and PNG images are
already compressed, and trying to compress them further slows down loading and saving without gaining
any significant benefit.

Encrypt Entries

If checked (the default), all entries are encrypted as they are saved. If compression is also turned on,
that happens prior to encryption.

Why you might turn off compression and/or encryption: If you are not worried about the security of
your entries, then you might turn off these options to speed up loading and saving of entries.

NOTE: Turning off either does not affect entries that already exist. Only entries that are added or
modified will use the new settings.

See Extended Security: Global Options for more information.
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